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1. Introduction

The Moxa MXview One network management software consists of four parts: The Main Module, Power Add-
on Module, the Wireless Add-on Module, and the Security Add-on Module. The Moxa MXview One network
management software gives you a convenient graphical representation of your Ethernet network, and allows
you to configure, monitor, and diagnose Moxa networking devices. MXview One provides an integrated
management platform that can manage Moxa networking devices, such as Ethernet switches, wireless APs,
SNMP-enabled, and ICMP-enabled devices installed on subnets. The MXview Power Add-on Module provides
additional advanced functions for power substation applications. The MXview Wireless Add-on Module
provides additional advanced functions for wireless applications to monitor and troubleshoot your network,
and help you minimize downtime. The Security Add-on Module provides additional advanced functions to
enhance field security, including centralized management and deployment of firewall policies, and updating
cybersecurity packages.

Key Features

Web-based Operation

You will need to install the MXview One on a Windows computer connected to the network(s) that are to be
managed. After installing MXview One, the network can be managed using Chrome, Firefox, or Microsoft
Edge (version 79+), without installing additional software.

Auto Discovery and Topology Visualization

Within the Device Discovery, MXview One locates networking devices with SNMP or ICMP services enabled.
MXview One can collect topology information from devices with LLDP capability and draw the topology of the
network, which shows wired and wireless connections. For ICMP devices without LLDP, MXview One can
verify the connection relationship through ARP algorithms, and help you create an accurate drawing of the
network topology. If any managed PoE switches are in your network, the PoE power output information will
also be visualized automatically.

Event Management

For troubleshooting purposes, MXview One logs events that match predefined conditions, such as link
up/down, device unreachable, or traffic overloading. The most recent events will be displayed to inform
users of the networking status. Devices and links that generate events will be highlighted with different
colors. When an event occurs, users can be notified by email, Microsoft Teams, or message box.

Configuration and Firmware Management

MXview One provides an interface for managing Moxa networking devices from a central location. Users can
remotely backup or update configuration files, and upgrade firmware via MXview One.

Traffic Monitoring

MXview One can log the network traffic of network devices that have been discovered.
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System Requirements
The computer that MXview One is installed on must satisfy the following system requirements:

System Requirements

CPU Quad-core CPU or better
RAM 16 GB or higher
Hard Disk Space SSD 1 TB or higher

e Windows 10, Windows 11 (64-bit)
Windows Server 2016, Window Server 2019, Windows Server 2022
(64- bit)
e Linux - Ubuntu 18.04, Ubuntu 20.04, Ubuntu 22.04
05 For the latest supported OS versions, please visit the MXview One
website: https://www.moxa.com/en/products/industrial-network-
infrastructure/network-management-software/mxview-one-
series#resources
Browser:
Chrome: Version 76 or later
Firefox: Version 69 or later
Microsoft Edge: Version 79 or later

Client Browser Requirements

Supported Devices

MXview One supports a full range of functions, such as network status, traffic log, and
configuration/firmware file management.

e For other SNMP-enabled devices, MXview One supports standard management functions, such as link
up, link down, and SNMP MIBII information.

e MXview One can only monitor the connectivity of devices that support ICMP.

Please check the MXview One datasheet on moxa.com for a list of Moxa devices that are supported.
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2. Installation and Uninstallation

Installation Procedure

For Windows

Execute the installation program.

2. During the installation, you can check the EULA (End-User License Agreement) and choose the directory
in which MXview One will be installed and the default language, or leave the settings as the default
values.

3. After the installation is complete, shortcuts for launching the MXview One server will be created on the
desktop and in the start menu.

/7  NOTE

If your computer already has MXview installed, please uninstall it and then start the MXview One program
installation process.

For Ubuntu

For Ubuntu installation instructions, please refer to the MXview One Linux Installation Guide, which can
be downloaded from the Moxa website.

There are two ways to install MXview One on Linux Ubuntu: offline and online installation. We recommend
installing MXview One using the offline method first to avoid any compatibility issues.

If you are unable to activate MXview One using the online installation method, install the software using the
offline method.
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Uninstallation

For Windows

Locate the Control Panel in Windows.
2. Under Programs, click Uninstall a program.
The Uninstall or change a program screen appears.
3. Select MXview One
Click Uninstall or Uninstall/Change at the top of the program list.

For Ubuntu

Execute the command line:

#sudo apt remove mxview
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3. Getting Started

MXview One Control Panel

Server Control

For Ubuntu users:

Execute the following command to activate MXview One Control Panel:
#sudo /usr/mxview/mxview-control-panel/MXControlPanel

Open a web browser and navigate to https://[host IP address]:7100. The host IP address is the IP of the
computer running MXview One. The default IP address is: 127.0.0.1

To stop MXview One in Linux, press CTRL + C.
For Windows users:

Start the MXview One server on the computer before launching the MXview One web console. On the server
computer, double-click the MXview One desktop shortcut in the Windows operating system.

The MXview One Control Panel log in screen appears first and after logging in will direct to the Control
Panel.

[@ MXview One Control Panel

Username

Provide the following login credentials

e Username: The default username is admin.
e Password: The default password is moxa.
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@ MXview One Control Panel @cnglsh 2 aominv
‘ Server Control

Configuration @

DB Backup & Restore Service stopped

Pl M =
lug-in Manager Click Start to begin monitoring your network

Certificate

HTTP port is disabled
HTTPS Port: 500

Database Port: 443

Internal Service Port 1: 8883
Internal Service Port 2: 8882

After logging in with the default credentials, the system will display a message asking you to change the
default password to enhance security.

Login Notification

We strongly recommend that you change the default password to enhance security.
After clicking the Change button, the Change Password window will appear.

Change Password

Old Password pidP o

New Password e o

Confirn New Password ew P o
Configuration

Configure the following port numbers in the Configuration Page:
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MXview One Control Panel

Server Control

| Configuration
DB Backup & Restore
Plug-in Manager

Certificates

MXview One Central Manager Server Settings

Enable * Yes =

Manage Licenses Through MXview One Yes
Central Manager *

P/Domain Name Port

Server Address *

Authentication * Pa ©

Site ID *

MXview One Central Manager Server Settings

o Enable

» Yes: This MXview One site will be managed through MXview One Central Manager. This requires the
below MXview One Central Manager settings to be configured.

» No: The MXview One site operates independently and cannot be managed through MXview One
Central Manager.

¢ Manage Licenses through MXview One Central Manager

» Yes: All the licenses of this MXview One site will be managed through MXview One Central Manager.

» No: The licenses for this site are managed locally at the MXview One site.

e Server Address

> IP/Domain Name: The IP address of MXview One Central Manager.

» Port: The service port used to connect to MXview One Central Manager. The default port number is

8883.

e Authentication

» Password: The password used to connect to MXview One Central Manager.

e SiteID

> Site ID: This value represents the site ID as shown on the Site Management page in MXview One
Central Manager.
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Interface Settings

MEview One Central Manager Server Seltings

No i

Wab Interface

403

Dizablad = B0
Databaze Interface
5402
o
Microservices Interface )
ERa3 Frrmamenrrae Q
g8z R — Q
Enabiled o

e Web Interface
» HTTPS: Specify the HTTPS port of the MXview One Central Manager server. The default port is 443.

» HTTP: Enable or disable HTTP. If enabled, specify the listening port of the server. The default port is
80.

o Database Interface

» Port: Specify the service port of the MXview One Central Manager database server. The default port
is 5432.

» Password: The password used to connect to MXview One Central Manager. While the default
password is randomized, we strongly recommend you to change the password to enhance security.

e Microservices Interface
> Internal Service Port 1/2:

i Port: Specify the communication ports between MXview One and its internal system. The
default ports are 8883 and 8882.

ii. Password: The password used for the microservices interface. While the default password is
randomized, we strongly recommend you changing the password to enhance security.

» Security Add-on Service Port:

i Auto Binding: Enable or disable the auto-binding feature. When enabled, MXview One will
automatically select a random port number for the Security add-on module if the default port
number is already in use.

ii. Port: Specify the service port of the Security add-on module.

When finished, click Save.
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DB Backup & Restore

1. Navigate to DB Backup & Restore on the MXview One Control Panel.

The Database Backup & Restore screen will appear and includes Backup and Restore functions.

MXview One Control Panel

Server Control

Configuration Backup Restore
DB Backup & Restore
Plug-in Manager Name *

Certificate

In the Name field, specify the backup file name.
Click Save.

s W

displayed.

The database has been backed up to

C:\Users\ \AppData\Roaming\moxa\mxview
one\db_backup\20230709_120518

6. When the database has been backed up successfully it will appear in the Historical backups list.

MXview One Control Panel

Server Control

Configuration Backup Restore

| DB Backup & Restore
Plug-in Manager Name * Backup test

Certificate

Historical backups

Version Name Date
[ Backup test 20221215
| R Backup test2 20221215
i 1 KXX-20221223 20221223

The system backup file includes the following items:

¢ Topology

e Traffic

e Availability

e Event

e Threshold settings

e Maintenance scheduler settings
e OID items

e Trap items

e System settings

e System Restore

Choose the Backup tab to start the process of backing up the database.

The message that the file of the backup database has been stored in the specified directory will be

Time

13:23:37

13:42:02

14:09:09
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The MXview One system will restore the system configurations from a backup file.
1. Click the Restore Tab.

1@ MXview One Control Panel
Server Control
Configuraton

| D8 Backup & Restore
o All database backups are stored on the MXview One server at CZ\Um:\_AppBlla\ﬂolming\mula\mmﬂ one\db_backup rG

Plugin Masager
You can copy a database to a specific path and then press the refresh button to get the latest information.

Certificate

c

Version  Name Gate Time

@ Backup test

Q Backup test? 134202

O 0020221223 20221223 140908

O 120 Baciup test 20230709 120518

2. Choose the backups you want to restore in the table. You can also copy a database to a specific path
and then press the refresh button to get the latest result.

3. Click Restore.
A confirmation screen will appear.

Restore Backup
Are you sure you want to restore this backup?

Cancel Restore

4. Displaying the restoration process.

Restore Backup
° MXview service has stopped ° Restore Successfully ° MXview service has started

Close

5. Click Close.
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Plug-in Manager

Navigate to Plug-in Manager on the Control Panel. The Plug-in Manager is a tool that can be used to

manage the plug-in files. The Plug-in Manager screen features two tabs: Moxa Devices and SNMP
Devices.

Moxa Devices

When you discover a new Moxa product that has not been integrated in to the latest MXview One version,
you may not be able to retrieve the product information from MXview One. To solve this, you can download
the plug-in file from Moxa’s website, and then upload the file in the Plug-in Manager. After uploading the
plug-in files, these new models can be supported by MXview One.

The Plug-in Manager screen includes the following information:

e  Plug-in file version
e Upload a Plug-in file
e  Supported device model

@ MXview One Control Panel (
Server Control
- Plug-in Manager

DB Backup & Restore Moxa Devices SNMP Devices

Plug-in Manager P —

Plug-in Version v1.3.231226

Certificates

@ You can get the latest plug-in file from the Moxa website. &
If you already have the plug-in file, please verify that the checksum of the plug-in file is the same as the checksum on the Moxa website.

Upload a plug-in file

Select a plug-in file (=)

Supported Device Model(300)

Search Q
Madel
AWK1131A AWK-3131A AWK-4131A
AWK1137C AWK-32524 AWK 42524
AWK-1151C AWK-11614 AWK-1161C
AWK-11654 AWK-1165C WAC-1001
WAG-2004 TAP-213 TAP-323
TAP-6226 EDS-G512E-8P0E EDS-528E

Steps to Upload a Plug-in File:
1. Stop MXview One.

MXview One Control Panel @engish 2 admin ¥
Server Control
Configuration @
DB Backup & Restore Service stopped.

Plug-in Manager Click Start to begin monitoring your network.

Certificates B

HTTP port is disabled
HTTPS Port: 550

Database Port: 5432
Intemal Service Port 1: 8883
Intemal Service Port 2: 8882

2. Download the latest plug-in file from the Moxa website. https://www.moxa.com/en/products/industrial-
network-infrastructure/network-management-software/mxview-one-series#resources
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3. Navigate to the Plug-in Manager on the Control Panel.

MXview One Control Panel
Server Control
otz Plug-in Manager

DB Backup & Restore Moxa Devices SNMP Devices

Plug-in Manager Pr—

Plug-in Version v1.3.231226

Certificates

@ You can get the latest plug-in file from the Moxa website. &
If you already have the plug-in file, please verify that the checksum of the plug-in file is the same as the checksum on the Moxa website.

Upload a plug-in file

Select a plug-in file =)

Supported Device Model(300)

Search Q
Model
AWK-1131A AWK-3131A AWK-413TA
AWIK1137C AWK-3252A AWK-A4252A
AWKT151C AWKT161A AWK1161C
AWK-1165A AWK-1165C WAC-1001
WAC-2004 TAP-213 TAP-323
TAP-6226 EDS-G512E-8PoE EDS-528E

4. Click the folder (I:I) icon in Select a Plug-in File to upload the file (.zip) from your local machine.

5. Click Upload and if successful, the message below will be displayed.
MXview One will upload the plug-in file and display the supported devices.

Successfully updated
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SNMP Devices

By default, MXview One will show basic information for third-party SNMP devices by polling the RFC-1213
public MIB and does not require users to upload device plug-in files. MXview One can also monitor the
status of these SNMP devices.

To show more detailed information for third-party SNMP devices in MXview One, users can create an SNMP
device plug-in by uploading the device’s private MIB files and defining the OID and OID syntax mapping.

MXview One Control Panel

Server Control
— Plug-in Manager
DB Backup & Restore Moxa Devices SNMP Devices
Plug-in Manager

Upload a plug-in file
Certificates

Select a plug-in file (]

Supported Device Model(11)
= Q search
O Model
O

Hirschmann MACH

ABB

Alcatel

Cisco Device

Emerson

Hirschmann

HP Networking Device

S < O CIN O C I < O

Rockwell

AR R T T N )

&

Schneider

The tab SNMP Devices includes the following information:

e Upload a plug-in file: This function allows users to upload plug-in files for third-party SNMP devices.

e Supported Device Model: This is the third-party SNMP device plug-in list, including built-in and user-
defined SNMP plug-in. You can edit, download but cannot delete the built-in plug-in. If your third-party
device is not in the list, you can create a new SNMP plug-in, and please refer to the Create a Plug-in

Creating a Plug-in
Steps to Create an SNMP Plug-in:

1. Navigate to Control Panel > Plug-in Manager > SNMP Devices.

+
2. Click the Add ( . ) icon.
The Add an SNMP Model Plug-in screen will appear.
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MXview One Control Panel

s contel < Add an SNMP Model Plug-In

Configuration
DB Backup & Restore

Plug-in Manager

Specify sysObjectID Load Device F
Certificates

sysObjectlD *

Model *

Get sysObjectiD

@ english

2 admin ¥

IL D Alias anc

There are four steps to creating a third-party SNMP device plug-in file:

3. Specify sysObjectID.

a. sysObjectID: You can manually type in the sysObjectID or click the Get sysObjectID button to let
MXview One retrieve the sysObjectID. When clicking the Get sysObjectID button, the Get

sysObjectID From a Device window will appear.

Get sysObjectID From a Device

IP Address *

IP Address 192.168.127.32

SNMP Settings *

SNMP Version vl T Port L
Username Passward

Read Community = Public

Data Encryption Authentication

E Pratos

Cancel

Get sysObjectiD

After specifying all the necessary information, click Get sysObjectOID. If successful, a confirmation

message will appear.

Model: Specify the model name. The model name only supports A-Z a-z 0-9 _ -, (comma) ( ) and

space.
b. When finished, click Next.
4. Load Device Files.

a. MIB Files: Upload all the necessaryYou can upload multiple MIB files at once.

b. Icon File: Upload the device icon in PNG format. The maximum resolution is 150 x 150 px. The

maximum file size is 500 KB limit.

O 1Icon Preview: The icon preview will show the uploaded image as it will appear in the

topology.
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< Add an SNMP Model Plug-In

© (2]
(v)
©

Specify sysObjectiD Load Device Files

MIB Files HIRSCHMANN-DISCOVERY-MGN [
Icon File * Hirschmann mach104.png (]

at. Maximum image size 150x150
B limit

Icon Preview

‘,.u: ==
. -]

c. When finished, click Next.
Select and Test OIDs.

Select and Test OIDs

o o

0ID Alias and Value Defination

After uploading the MIB files, the OIDs from the MIB files will be shown. You can test the OIDs to check
the value before selecting them and moving on to the next step.

@ MXview One Control Panel

Server Control < Add an SNMP Model Plug-In

Configuration

DB Backup & Restore

©

Plug-in Manager
Specify sysObjectid Load Device Files

Certificates

@cngish 2

o o

Selectand Test 0IDs.

(1) router-intf(2)mgmtintf(3)}

1)ipv6(2)dns(16)}

g oo oD Name oD syntax

0 %y 1361412481610011 1)reac-only(2)
O 5 1361412481610012 hmMgmiDiscMacAdcr octetstring

0O &y 1361412481610013 Typ

O % 13614128161000.8 hmMgmDiscswversion octetsting

0 5y 1361412481610015 hmMgmiDiscProductDescr octetstiing

O 5 1361412481610021 hmMgmiDiscCiguuiD Octetstring

O 5 1361412081610022

0 % 13614124816.10023 Ty

O 5 1361412481610024 hmMgmiDiscCigiPAddr octetstring

a. Test OIDs.

i Click on the Test OID (
The Test OID window will appear.

ii. Specify the IP address and SNMP settings.

ig
ﬂ-) icon of the OID you want to test.
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iii. Click the Get OID Value button. The retrieved value will show in the Value retrieved from
OID field.

Test OID
IP Address and 01D * ~
IP Address 192.168.127.32
oID 1.3.6.1.4.1.248.16.100.1.3
Value retrieved from 0ID
Value 3
SNMP Settings *
SNMP Version W1 - Port 161
Username Password ©
Read Community public
Data Encryption Aut N Authentication 5 N
o
Cancel Get 0ID Value
b. Select OIDs.
i Select the OIDs you want to monitor in MXview One.
ii.  When finished, click Next.
@ MXview One Control Panel @englsh & e
Servr Contl
O & 1361412407670011 hmigr ode Integersz(read-urite(1)reaconiy(z)}
Canfquration
S O @ 13s1412481610012 hmMgmtDiscMacaddr Octetsting
Plagin Manager 0 & 1asi4izeiemo S a
Certficates O 53 1861412481610014 hmbgmiDiscSw\ersion OetetStiing
O » 12s141281810015 hmbgmiiscProductbeser g
O R 1361412481610021 hmMgmIDisECAULID octetstrng
O & 1361412481610022 hmMgmtDiscCigProto (none(1)boatp(2)hcp(3))
5 1360412481610023 hmAgID sCCTgIPAdrTypS
O & 1361412481610024 hmMgmiDiscCigIPAddr Octetstring
O & 13s1412:81610025 AmbsgmDsocigPreiLen
T3 1361412481670026 gy WPAdS Type S2(unknown(OMIpVA(1 ) pYe2)Ins(16))
O @ 126141208160027 hmigmiDiscCigGmPAdcT octetstring
O 5§ 13s1412481610028 hmigmiDiscCigaction Integerazlother(1)activate(2)
O R 1261412481610020 ‘gBlinking

Back
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6. OID Alias and Value Definition

An overview of all selected OIDs will be shown.

listed for each entry.
< Add an SNMP Model Plug-In

©

Specify sysObjectiD

0ID Name 0ID Alias

N

hmMgmtDiscMode

/' hmMgmtDiscipintfType

N

hmMgmtDiscProductDescr

N

hmMgmtDiscCfgIPAddrType

hmMgmtDiscCfgPrefLen

NS

hmMgmtDiscCigGwiPAddType

®  hmMgmtDiscCfgGwIPAddr

N\,

N

hmMgmtDiscCigAction

Back

N
©

©

Load Device Files

OID Syntax

Integer32{read-write(1) read-only(2)}

Octetstring

Integera2{unknown(0)ipv4(1)ipve(2),dns(16)}

Integer32{unknown(0)ipv4(1)ipv6(2),dns(16)}

Octetstring

Integer32{other(1) activate(2)}

Select and Test 0IDs

Qsearch

o

0ID Alias and Value Defination

0ID Syntax Mapping

read-write(1), read-only(2)

loopback-intf(1), router-intf(2), mgmt-intf(3)

unknown(0), ipva(1), ipv6(2), dns(16)

unknown(0), ipva(1), ipv6(2), dns(16)

other(1), activate(2)

If necessary, you can manually edit the OID information.

a. Click the Pencil ( / ) icon of the OID you want to edit.
The Custom Name and Syntax window will appear.

Custom Name and Syntax

Alias for 0ID Name *

hmMgmitDisclpintfType

0ID Alias Type

0ID Syntax Mapping

Integer32{loopback-intf{1) router-inth{2)momt-intf(3)}

| B loogback-intt
| 2 router-intf
| mgmtntf

o~

b. Edit the OID Alias and OID Syntax Mapping information as required.
c. When finished, click Apply.

7. When finished with all four steps, click Complete.
The Update Plug-in window will appear.

Update Plugin

° MXview One stopped

o Updating

w0
;

tarting MXview One

The OID Alias, OID Syntax, and OID Syntax Mapping is
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8. If successful, a confirmation will appear indicating the plug-in was created.

SNMP Model Plug-in added

The plug-in will now show in the Supported Device Model list.
Plug-in Manager

Upload a plug-in file

L (]

Supported Device Model(11)

- IO} Q

a Model

0 7

B irschmann Ack

.
B EEE B

Hirschmann

Certificates

From the Certificate page, you can view the certificates used by MXview One. By default, you can view
information for Web certificates. If this MXview One instance is managed through MXview One Central
Manager, an additional MQTT certificate tab will be available.

Web Certificates

On the Web tab, you can view the information for the current web certificates, including:

e Issue To - Common Name (CN)
e Issue By - Common Name (CN)
e Issue By - Organization (O)

e Issued On

e Expires On

MXview One Control Panel

Server Control

Configuration Web MQTT

DB Backup & Restore

Certificate Information
Plug-in Manager

Issue To - Common Name (CN)

Certificates MXview One
Issue By - Common Name (CN)

MXview One

Issue By - Organization (0)
Moxa Inc.

Issued On
Tuesday, Jul 19, 2033 at 12:00:00 AM

Expires On
Wednesday, Jul 19, 2023 at 12:00:00 AM

Import Certificate

Private Key (.key) * O

CA Certificate (.crt, .cer) * [}
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Regenerating the Web Certificate

1. Navigate to Control Panel > Certificates.

2. Go to the Web tab.
3. Click the Regenerate button.

The Regenerate Certificate window will appear.

Web OPC UA Server

Certificate Information

Issue To - Commaon Name (CN)
MXview One

Issue By - Common Mame (CN)
MXview One

Issue By - Organization (0)
Moxa Inc

Issued On
Wednesday, Jun 19, 2024 at 12:00:00 AM

Expires On
Wednesday, Jul 19, 2034 at 12:00:00 AM

4. Click Regenerate to regenerate the certificate.

Regenerate Certificate

A\ Are you sure you want to regenerate the certificate?

Syslog Forwarding

The existing certificate will be deleted and a new certificate will be

generated.

5. After successfully regenerating the certificate, MXview One Central Manager Control Panel will need to

be restarted for the certificate to take effect. Click Close and restart the instance.

Restart Required

Please restart MXview One Control Panel and MXview One to

activate the certificate.

Importing a Web Certificate
You can manually important a certificate file and key file.

1. Navigate to Control Panel > Certificates.

2. Go to the Web tab.

3. In the Import Certificate section, click the folder icon for the Private Key and CA Certificate fields and

navigate to the certificate (.crt, .cer) and key (.key) file on the local host.
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Import Certificate

Private Key (.key) * Chmxview.key m]
CA Certificate (.crt, .cer) *  C:\mxview.crt m}
Click Import.

After successfully importing the certificate, MXview One Control Panel will need to be restarted for the
certificate to take effect. Click Close and restart the instance.

Restart Required
Please restart MXview One Control Panel and MXview One to

activate the certificate.

Close

OPC UA Server Certificates

On the OPC UA Server tab, you can view the information for the current OPC UA certificates, including:

Issue To — Common Name (CN)
Issue By - Common Name (CN)
Issue By - Organization (O)
Issued On

Expires On

Regenerating the OPC UA Server Certificate

Navigate to Control Panel > Certificates.
Go to the OPC UA Server tab.

Click the Regenerate button.
The Regenerate Certificate window will appear.

Web OPC UA Server Syslog Server Syslog Forwarding

Certificate Information

Issue To - Commeon Name (CN)
MXview One

|ssue By - Commeon Name (CN)
MXview One

Issue By - Organization (0)
Moxa Inc.

Issued On
Wednesday, Jun 19, 2024 at 12:00:00 AM

Expires On
Wednesday, Jul 19, 2034 at 12:00:00 AM
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4. Click Regenerate to regenerate the certificate.

Regenerate Certificate

A\ Are you sure you want to regenerate the certificate?

The existing certificate will be deleted and a new certificate will be

generated.

5. After successfully regenerating the certificate, MXview One Control Panel will need to be restarted for
the certificate to take effect. Click Close and restart the instance.

Restart Required

Please restart MXview One Control Panel and MXview One to
activate the certificate.

Close

Exporting the OPC UA Server Certificate

1. Navigate to Control Panel > Certificates.
2. Go to the OPC UA Server tab.

3. Click the Export Certificate button.
MXview One will export the OPC UA certificate as a ZIP file.

Web OPC UA Server Syslog Server Syslog Forwarding

Certificate Information

Issue To - Common Name (CN)
MXview One

Issue By - Common Name (CN)
MXview One

Issue By - Organization (D)
Moxa Inc.

Issued On
Wednesday, Jun 19, 2024 at 12:00:00 AM

Expires On
Wednesday, Jul 19, 2034 at 12:00:00 AM

Importing an OPC UA Server Certificate

Navigate to Control Panel > Certificates.
Go to the OPC UA Server tab.

In the Import Certificate section, click the folder icon for the Private Key, Certificate, and CA
Certificate fields and navigate to the CA certificate (.crt, .cer), certificate (.pem), and key (.key) file on
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the local host.

Import Certificate

4. Click Import.

5. After successfully importing the certificate, MXview One Control Panel will need to be restarted for the

certificate to take effect. Click Close and restart the instance.

Restart Required

Please restart MXview One Control Panel and MXview One to
activate the certificate.

Close

Syslog Server Certificates

On the Syslog Server tab, you can view the information for the current syslog server certificates,
including:

e Issue To - Common Name (CN)
e Issue By - Common Name (CN)
e Issue By - Organization (O)

e Issued On

e Expires On
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[@! MXview One Control Panel @engish 2 sdmin v
Server Control
Configuration Web Syslog Forwarding
DB Backup & Restore
PilgEin Mamaoa: Certificate Information
Issue To - Comman Name (CN)
Certificates Miview One
Issue By - Common Name (CN)
MXview One
Issue By - Organization (0)
Moxa Inc.
Issued On
Sunday, May 19, 2024 at 12:00:00 AM
Expires On
Monday, Jun 19, 2034 at 12:00:00 AM
o
Import Certificate
Private Key (.key) * (]
Certificate (.pem) * ()
CA Certificate (.crt, .cer) * o]
Regenerating the Syslog Server Certificate
1. Navigate to Control Panel > Certificates.
2. Go to the Syslog Server tab.
3. Click the Regenerate button.
The Regenerate Certificate window will appear.
Web OPC UA Server Syslog Forwarding
Certificate Information
Issue To - Common Name (CN)
MXview One
Issue By - Common Name (CN)
MXview One
lssue By - Organization (0)
Maoxa Inc
Issued On
Wednesday, Jun 19, 2024 at 12:00:00 AM
Expires On
Wednesday, Jul 19, 2034 at 12:00:00 AM
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4. Click Regenerate to regenerate the certificate.

Regenerate Certificate

A\ Are you sure you want to regenerate the certificate?

The existing certificate will be deleted and a new certificate will be

generated.

5. After successfully regenerating the certificate, MXview One Control Panel will need to be restarted for
the certificate to take effect. Click Close and restart the instance.

Restart Required

Please restart MXview One Control Panel and MXview One to
activate the certificate.

Close

Exporting the Syslog Server Certificate

1. Navigate to Control Panel > Certificates.
2. Go to the Syslog Server tab.

3. Click the Export Certificate button.
MXview One will export the syslog server certificate as a ZIP file.

Web OPC UA Server Syslog Server Syslog Forwarding

Certificate Information

Issue To - Common Name (CN)
MXview One

Issue By - Common Mame (CN)
MXview One

|ssue By - Organization (0)
Moxa Inc

Issued On
Wednesday, Jun 19, 2024 at 12:00:00 AM

Expires On
Wednesday, Jul 19, 2034 at 12:00:00 AM

oo

Importing a Syslog Server Certificate

Navigate to Control Panel > Certificates.
Go to the Syslog Server tab.

In the Import Certificate section, click the folder icon for the Private Key, Certificate, and CA
Certificate fields and navigate to the CA certificate (.crt, .cer), certificate (.pem), and key (.key) file on
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the local host.

Import Certificate

4. Click Import.

5. After successfully importing the certificate, MXview One Control Panel will need to be restarted for the
certificate to take effect. Click Close and restart the instance.

Restart Required
Please restart MXview One Control Panel and MXview One to

activate the certificate.

Close

Syslog Forwarding Certificates

On the Syslog Forwarding tab, you can view the information for the current syslog forwarding certificates,

including:

e Issue To - Common Name (CN)
e Issue By - Common Name (CN)
e Issue By - Organization (O)

e Issued On

e Expires On

Importing a Syslog Forwarding Certificate

Navigate to Control Panel > Certificates.
Go to the Syslog Forwarding tab.

3. In the Import Certificate section, click the folder icon for the Private Key, Certificate, and CA
Certificate fields and navigate to the CA certificate (.crt, .cer), certificate (.pem), and key (.key) file o

n
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the local host. Repeat these instructions for both the 1st and 2nd syslog forwarding server.

Import Certificate
Remote IP/Domain 1

Private Key (.key) *

[}
Certificate (.pem) * (]
CA Certificate (.crt, .cer) * (]
Remote IP/Domain 2
Private Key (.key) * D
Certificate (.pem) * (]
CA Certificate (.crt, .cer) * =

4. Click Import.

5. After successfully importing the certificate, MXview One Control Panel will need to be restarted for the
certificate to take effect. Click Close and restart the instance.

Restart Required
Please restart MXview One Control Panel and MXview One to

activate the certificate.

Close

MQTT Certificates

/  NOTE

By default, no MQTT certificate will be available. To view MQTT certificate information, import the CA
Certificate generated through MXview One Central Manager. Refer to Importing the MXview One Central
Manager CA Certificate.

If this MXview One instance is managed through MXview One Central Manager, the MQTT tab will be available. On the
MQTT tab, you can view the information for the current MQTT certificates, including:

e Issue To - Common Name (CN)

e Issue By - Common Name (CN)

e Issue By - Organization (O)

e Issued On

e Expires On
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[@ MXview One Control Panel

Server Control
Configuration

DB Backup & Restore
Plug-in Manager

Certificates

Web MQTT

Certificate Information

Issue To - Common Name (CN)
MXview One

Is5ue By - Common Name (CN)
MXview One

Issue By - Organization (0)
Moxa Inc

Issued On
Friday, Jul 15, 2033 at 12:00:00 AM

Expires On
Saturday, Jul 15, 2023 at 12:00:00 AM

Delete CA Certificate

Import Certificate

CA Certificate (.crt, .cer) *

Importing the MXview One Central Manager CA Certificate

If this MXview One instance is managed through MXview One Central Manager, upload the CA certificate
generated through MXview One Central Manager Control Panel here.

1. Click the folder icon for the CA Certificate field and navigate to the certificate file generated through
MXview One Central Manager Control Panel on the local host.

@ MXview One Control Panel

Server Control
Configuration

DB Backup & Restore
Plug-in Manager

Certificates

Wweb MQTT

Import Certificate

CA Certificate (.crt, .cer) *

If the uploaded certificate is not from Central Manager, an error message will appear.

Failed to import the certificate. Please make sure

the certificate is the same as MXview One Central

Manager.

Click Import.

3. After successfully importing the certificate, MXview One Control Panel will need to be restarted for the

certificate to take effect. Click Close and restart the instance.
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Restart Required

Please restart MXview One Control Panel and
MXview One to activate the certificate.

Close

Deleting the CA Certificate

1. Click Delete CA Certificate to delete the current CA certificate file.
The Delete CA Certificate window will appear.

Web MaQTT

Certificate Information

ssue To - Common Name (CN)
MXview One

ssue By - Comman Name (CN)
MXview One

ssue By - Organization ()
Moxa Ine.

ssued On

Wednesday, June 7, 2023 at 12:00:00 AM

Expires On

Tuesday, June 7, 2033 at 12:00:00AM

Delete CA Certificate |

2. When prompted, click Delete.

Delete CA Certificate

A\ Are you sure you want to delete CA certificate?

The existing certificate will be deleted

3. After successfully deleting the certificate, MXview One Control Panel will need to be restarted for the
certificate to take effect. Click Close and restart the instance.

Restart Required

Please restart MXview One Control Panel and
MXview One to activate the certificate.

Close
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Starting the MXview One Server and Logging
Into MXview One

1. On the Server Control page, click Start. The MXview One server will start running.

@ MXview One Control Panel @english & admin v
Configuration @
DB Backup & Restore Service stopped

Plug-in Manager

1t to begin monitoring
Cenificate m

HTTP port is disabled
HTTPS Port: 500

Database Port: 443

Internal Service Port 1: 8883
Internal Service Port 2: 8882

2. Wait for the status to display Service is running, then click Open MXview One and log in to MXview
One:

v

Service is running

You are monitoring your network.

Stop Open MXview One

MXview ONE

Username

Password

MOXAN

Copyright Moxa, Inc. All Rights Reserved.

Provide the following login credentials
» Username: The default username is admin.
> Password: The default password is moxa.
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/  NOTE

Alternatively, you can log in to MXview One from a computer located remotely after starting the MXview
One service. For more information, see Logging Into MXview One Remotely.

Logging Into MXview One Remotely

You can log in remotely to MXview One that is installed on your local site computer from another computer.

1. Launch the MXview One server at the local site computer. Go to the tool bar and click the MXview One

icon. Select Remote Access.

Launch Control Panel
v Remote Access

Stop and Exit

T4 02:52

2022/6/13

/7  NOTE

If the Remote Access function is enabled, you can access the MXview One Control Panel from another
computer. To disable this function, click Remote Access again.

Open a web browser on the computer located at the remote site.

In the address bar, input the IP address or domain name of the computer that you want to log in to
MXview One from.

» Format: https://[IP address]:[Port]
» Example: https://192.168.1.250:7100
The MXview One Control Panel appears.

MXview One Control Panel

Username

Password Q

4. Provide the following login credentials
» Username: The default username is admin.
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> Password: The default password is moxa.
5. You can choose one of the actions listed below:
» Click the Start button
» Click the Stop button
> Change the configurations on the Configuration page

@ MXview One Control Panel @englisn & admin v
DB Bacia: & fcstare Service stopped

Plug-in Manager

Certificate n

HTTP port is disabled
HTTPS Port: S00
Database Port: 443

nitoring network

Internal Service Port 1: 8883
Internal Service Port 2: 8882

6. To open the MXview One web console, you can type the IP address of the computer at the local site into

another web browser once the MXview One Control Panel displays 'Service is running now'.
» Format: https://[IP address]

» Example: https://192.168.1.250

The MXview One web console appears.

7. Provide the following login credentials
» Username: The default username is admin.
» Password: The default password is moxa.

MXview ONE

Username

Password

L\ [@) @ AN

Copyright Moxa, Inc. All Rights Reserved.

/  NOTE

A maximum of 10 users can log in to MXview One web console at the same time.

MXview One 1.5.0 User Manual

38



License Management

You can monitor your devices inside the networking status via MXview One. Please note, in order to monitor
the devices, you need to activate the Node-based license. For example, if you activate 123 nodes in MXview
One, then during the device discovery MXview One will only recognize up to 123 nodes. MXview One will
stop the device discovery process once it reaches the 123-node limit.

To increase the node limit, you can purchase additional licenses and import the license into MXview One.

/7  NOTE

Click "Start Trial" to start using MXview One.

Checking the License

The License Management screen displays information about your MXview One license, including the
number of licensed nodes, nodes currently in use, and application license. You can also use the License
Management screen to add a new license or deactivate an existing license.

To access the License Management screen, navigate to Menu (E) > Administration > License
Management.

= MXview ©ONE @english 8 admin¥

License Management

MXview One
k Node License Wireless Add-on License Power Add-on License Security Add-on License
Mode: Trial Mode: Trial Mode: Trial Mode: Trial
Currently Used: 0
Q) Total Number of Licenses: 2000
N

Moxa Licer

Deactivated licenses

>
Trial Remaining Wireless Add-on License Power Add-on License Security Add-on License Re-activate License
Start 1o experience the Miview One Wireless Start to experience the MXview One Power Start to experience the MXview One Security Use both the Deactivation Code and a User
Add-on Add-on Add-on Code to re-activate your license.
days
) Enabled 4% Enzbled AT
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Adding a New License

To increase the node limit of your MXview One server, you need to add the node-based license.

1. Navigate to Menu (E) > Administration > License Management.
The License Management screen appears.
In the Add New License section, click Add New License.
2. Login to the Moxa License Site to activate the MXview One license. Click Next to get the User Code.

Add New License

o o ©

Log in to the Moxa License Copy User Code Activate
Site

1. Log in to the Moxa License Site [4
2. Choose "Activate a Product License" and "MXview One" on the site.
3. Registration Code

Your registration code (Type: MXview One NEW)

(Model name: LIC-MXviewOne-NEW-XN-SR) is
XXXXHXXHXCCAKHKXKHKHXXXEAK XK KKK

3. Copy the User Code.

Add New License

o (2] ©

Log in to the Moxa License Copy User Code Activate
Site

Copy the User Code to the Moxa License Site [4

- [

4. Input a valid activation code.

Add New License

o o ©

Log in to the Moxa License Copy User Code Activate
Site

Download the license from the Moxa License Site, and paste the Activation Code
here.

Activation Code

Close Apply
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5. Click Apply.
MXview One activates the new license.

/  NOTE

Please reference Chapter 4: License Management to get more details on how to get the activation code.

Using Device Discovery

MXview One provides Device Discovery to help users quickly determine the network topology and handle
basic configuration tasks.

1. To launch Device Discovery manually please do the following:
Navigate to Menu (E) > Device Discovery.
Device Discovery appears to the right of the navigation panel.

Device Discovery

o Network Range(s)

A Scanned range(s) will be saved after device discovery.

Enabled/Disabled Name First IP Address Last IP Address Group Site Name
<

2. Add the IP address ranges to scan for devices.

/  NOTE

MXview One supports scanning multiple IP address ranges. The selected IP address scan ranges must be
enabled in order for MXview One to scan for devices.

/  NOTE

Moxa devices must have the SNMP function enabled for MXview One to scan the devices.
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Add Scan Range
Enable Scan Range
Enabled »i
Name *

CIDR Prefix *
First IP Address * /24 (255.255.255.0) ~
Last IP Address * CIDR Address Range
Group *
Root *

Cancel

a. Click the Add (E3) icon.
The Add Scan Range screen appears.
b. Select one of the following options:
O Enabled: Select to enable scanning of the specified IP address range.
O Disabled: Select to disable scanning of the specified IP address range.
c. Configure the following:
Provide a custom display Name for the scan range.
Specify the First IP Address of the scan range.
Specify the Last IP Address of the scan range.
Select the CIDR Prefix for the scan range (if applicable).

QaaaaQq

Select the MXview One Group to assign the scan range to.

Click Add.

(Optional) Add additional network scan ranges, repeat the previous steps.

(Optional) Modify scan range settings, click the Edit (/') icon next to an added scan range.
(Optional) Remove a scan range, click the Delete (i) icon next to the added scan range.

Sa ™o a

Select one or more scan ranges to scan.
i. Click Next.
MXview One scans the specified IP address ranges for devices.

Device Discovery

o Network Range(s) e Discovery Result 9 Complete

A Scanned range(s) will be saved after device discovery.

2 a Enabled/Disabled Name First IP Address Last IP Address Group Site Name
O /‘ i Enabled Test 162.168.127.1 192.168.127.254 Root ClaireYHChang-NB
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3. View devices discovered on the network.

a. MXview One displays discovered devices on the Discovery Result list. Scroll down to view more
devices on the list.

Device Discovery
° Network Range(s) e DiSCDVEW Result 9 Complete

Device Alias Device IP Group Site Name

Device discovery successful

]

b. Click Next.
4. Click Browse Topology to view the detailed network topology.
The Topology screen appears.

Device Discovery

o Network Range(s) o Discovery Result o Complete

0 device(s) added to MXview One

/7  NOTE

MXview One cannot guarantee that it can draw the link of the topology for non LLDP devices. However,
you can draw the link of the topology manually by clicking Add Link.

Account Management

To launch Account Management, please do the following: Navigate to Menu (E ) > Account
Management.

The Account Management screen allows you to view, add, modify, and delete user accounts from MXview
One. You can also export a list of user accounts and related information as a CSV file.

Account Management
User Account Password Policy Login Netification

All Users (3)

[+]

(<] Q seal

Administrator (1)

Usemame Authority
Supervisor (0)
B admin Administrator
User(2)

user User

oo o|o

gquest User
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MXview One provides three default accounts:

e admin

e user

e guest

admin moxa Administrator
user moxa User

guest moxa User

Each account can be assigned one of the following Authority permissions:
e Administrator: Has full access rights to modify any settings/configurations and can assign authorities
to other accounts.

e Supervisor: Has full access rights to modify any settings/configurations on all pages apart from the
Account Management page.

e User: Has the permissions listed below.

Function Description

Dashboard

Read-only

Topology

Read-only

Event History

Can do some actions: Export, Filter

Syslog Viewer

Can do some actions: Export, Filter

Inventory Report

Can do some actions: Export

About MXview One

Can check the version

User Manual

Can link to the document

API Documentation

Can link to the document

Adding User Accounts

1. Navigate to Menu (E) > Administration > Account Management.
The Account Management screen appears.

2. Click the Add () icon in the top right corner of the screen.
The Add User Account screen appears.

Add User Account

Username *

Cancel

3. Configure the following account details:

» Username: Specify the username for the account.

» Password: Specify the login password (minimum length: 4 characters) for the account.

> Authority: Assign the authority permission (Administrator, Supervisor, or User) for the account.
4. Click Add.

Modifying User Accounts

1. Navigate to Menu (E) > Administration > Account Management.
The Account Management screen appears.

2. Click the Edit (f) icon in front of the account you want to modify.
The Modify user account screen appears.
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Meodify User Account

(o

Cancel

3. Modify the following account details:

» Password: Specify the login password (minimum length: 4 characters) for the account.

» Authority: Assign the authority permission (Administrator, Supervisor, or User) for the account.

4. Click Apply.

Deleting User Accounts

1. Navigate to Menu (E) > Administration > Account Management.
The Account Management screen appears.
(Optional) Select the check box(es) in front of one or more account(s).

Click the Delete (i) icon in front of the account you want to delete, or in the top left corner of the
screen (if multiple accounts are selected).

MXview One deletes the account(s).

Exporting User Accounts

The Account Management screen allows you to export a CSV file containing all user accounts with
corresponding authority permissions and accessible sites.

1. Navigate to Menu (E) > Administration > Account Management.
The Account Management screen appears.

2. Click the Export (E) icon.
&

Export CSV
D p

3. Select Export CSV.

Configuring the Password Policy

Use the Password Policy screen to modify the password requirements for user accounts.

1. Navigate to Menu (E) > Administration > Account Management > Password Policy.
The Password Policy screen appears.
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Account Management

User Account Password Policy Login Notification

Minimum length (4 - 16) *
4

Password complexity strength check
(] At least one digit (0-9)
(] Mixed upper and lower case letters (A-Z, a-z)
< |[J At least one special character (~!@#$%"8*-_;:,.<>[{}()

Specify the minimum password length (between 4 to 16 characters).

3. Select one or more of the following password complexity requirements:
> At least one digit (0~9)
» Mixed upper and lower case letters (A~Z, a~z)
> At least one special character (~!'@#$%"N&*-_|;:,.<>[1{}())

4. Click Save.

MXview One requires all new account passwords to satisfy the modified password policy.
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Configuring Login Notifications

Use the Password Policy screen to customize the notifications displayed when users log in to MXview One.

1. Navigate to Menu (E) > Administration > Account Management > Login Notification.
The Login Notification screen appears.

Account Management

User Account Password Policy Login Notification

Show Login Failure Records
~ B Show Default Password Notification

Login Message

o4

Login Authentication Failure Message

2. To enable the following notification(s), select the corresponding checkbox(es):
> Show Login Failure Records
» Show Default Password Notification

3. To disable the following notification(s), clear the corresponding checkbox(es):
> Show Login Failure Records
» Show Default Password Notification

4. To display a custom login message, type a string (up to 250 characters in length) in the Login
Message field.

5. To display a custom login authentication failure message, type a string (up to 250 characters in length)
in the Login Authentication Failure Message field.

6. Click Save.

MXview One displays the configured login notifications the next time a user logs in.
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Changing the Display Language
Use the Language icon screen to customize the notifications displayed when users log in to MXview One.

1. Navigate to Language (C)

The Language screen appears.
2. Select language.

Language

Language

English >

Cancel Apply

3. MXview One supports the following languages:
German (Deutsch)
Japanese (H4:E)
English
Spanish (Espaiiol)
French (Frangais)
Simplified Chinese (f®j{&$3)
Traditional Chinese (BfEH)
4. Click Save.
MXview One updates the display language.

YV V V V VYV VYV V
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4. License Management

License Management Overview

The License Management screen displays information about your MXview One license, including the
license types, the number of licensed nodes, nodes currently in use, and the Add-on license. You can also
use the License Management screen to add a new license or deactivate an existing license.

To access the License Management screen, navigate to Menu (E) > Administration > License
Management.

= MXview ONE @eroten 2 aominy

License Management

MXview One
k Node License Wireless Add-on License Power Add-on License Security Add-on License
Mode: Trial Mode: Trial Mode: Trial Mode: Trial
Currently Used: 0
. Total Number of Licenses: 2000
I

Moxa License Site (3

Deactivated licenses

> 3 & " & "
Trial Remaining Wireless Add-on License Power Add-on License Security Add-on License Re-activate License
i Start 1o experlence the Miview One Wireless Start 10 experience the MXview One Power Start to experience the MXview One Security Use both the Deactivation Code and a User
Add-on Add-on Add-on Code to re-activate your license.

81

days

& Enavled 4@ Enabled Re-activate
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License Type

MXview One provides numerous types of licenses. Each license has a specific function.

Trial License You can experience the power of MXview One for 90 days.

Node License Specifies the number of devices that MXview One can monitor in the network.

Wireless Add-on License |Allows users to access additional wireless related functions.

Power Add-on License Allows users to access additional power related functions.

Security Add-on License |Allows users to access additional security related functions.

License Type

; : You can experience the power of MXview One for 90
Trial License d
ays.
. Specifies the number of the devices that MXview One
Node License

can monitor in the network.

. . Allows users to access additional wireless related
Wireless Add-on License S —

: Allows users to access additional power related
Power Add-on License ¢ . B

: 3 Allows users to access additional security related
Security Add-on License R Y

Close
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Adding a New License

1. Navigate to Menu (E) > Administration > License Management.
The License Management screen appears.
2. Inthe Add New License section, click Add New License.

License Management

MXview One
(\ License Wireless Add-on License  Power Add-on License
Mode: None Mode: None Mode: None
State: No valid licenses
. Current Nodes: 0
A

Licensed Nodes: 0

Moxa License Site 4

Add New License License Type

The Add New License screen appears.

Add New License

@ (2] ©

Log in to the Moxa License Copy User Code Activate
Site

1. Log in to the Moxa License Site (4
2. Choose "Activate a Product License” and "MXview One" on the site.

3. Registration Code

Your registration code (Type: MXview One NEW)
(Model name: LIC-MXviewOne-NEW-XN-SR) is

OO0

3. Click Next.
4. Copy the User Code and click Next.

Add New License

o (2] ©

Log in to the Moxa License Copy User Code Activate
Site

Copy the User Code to the Moxa License Site (4

o

5. Open a web browser and go to https://license.moxa.com/. Select MXview One and Log in to your
Moxa account.
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https://license.moxa.com/

6. Click Products and Licenses > Activate a Product License. Then, select MXview One from the
product type list.

Products and Licenses / Activate a Product License

Product Type Please select a product v

Please select a product
sSDC

IEF

IEC

MRC QuickLink
MXview

MX-AOPC UA Server
MX-AOPC UA Logger
MXsecurity

Security Package

7. Input a valid Registration Code and see if the Product Type behind the Registration Code has
displayed correctly of your license.

8. Paste a valid User code from MXview One. Click “I have read and agree to the EULA (End-user License
Agreements)” checkbox. Then click Activate to get the activation code.

Products and Licenses / Activate a Product License

Product Type MXview One v

Registration Code Product Type : MXview One Node_and_Site

User code

() 1 have read and agree fo the EULA (End-user License Agreements)
This is the first activation of the software, you need to read the EULA, and click | know, so that the activation process can be
handled.

MXview ONE

9. Once the process has been successfully completed, a pop-up window will appear to inform you that your
license code has been activated. Click I know to close the window. If the license failed to activate,
enter the correct Registration Code and User code again. If you are still experiencing problems, please
contact Moxa Support.

Message notification

Thank you for purchasing an MXview One product license!
Your license has been activated, we will send you an activation notification
to your mailbox.
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10. Check your email account you used to apply for your moxa account. The activation code will be sent to
this email address.

Dear Customer,

Your MXview One Activation Code

has been activated successf

ully. Visit the License Activation Portal to see more details about your product and license activation code

11. Copy the activation code from the email.
12. In MXview One, paste the activation code into the Activation Code field.

Add New License

o o ©

Log in to the Moxa License Copy User Code Activate
Site

Download the license from the Moxa License Site , and paste the Activation Code
here.

Activation Code

Close

13. Click Apply and then MXview One will activate the new license.

Adding an Add-on License

1. Navigate to Menu (E) > Administration > License Management.
The License Management screen will appear.

License Management

MXview One @
k License Wireless Add-on License ~ Power Add-on License
Mode: Authorized Mode: None Mode: None
Current Nodes: 0
. Licensed Nodes: 3
n

Moxa License Site [

> Add New License License Type
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2. Click Add New License. The Add New License screen will appear.
Add New License

o (2] (3]

Log in to the Moxa License Copy User Code Activati
Site

®

1. Log in to the Moxa License Site 3
2. Choose "Activate a Product License” and "MXview One” on the site.
3. Registration Code

Your registration code (Type: MXview One NEW)
(Model name: LIC-MXviewQOne-NEW-XN-SR) is

XOOCOOOOCOOCOOCOOOOOOOOONXXX
-

3. Click Next.
4. Copy the User Code and click Next.

/7  NOTE

Please activate the Node-based License before activating the Add-on License.

Add New License

© (2] (3

Log in to the Moxa License Copy User Code Activate
Site

Copy the User Code to the Moxa License Site (3

User Code: |E|

- -

5. Open a web browser and go to https://license.moxa.com/. Select MXview One and log in to your Moxa
account.

6. Click Products and Licenses > Activate an add-on or renewal License. Input a valid Add-on
Registration Code and see if the Product Type behind the Registration Code has shown your license
correctly.

Products and Licenses [ Activate an add-on or renewal License

Add-on or Renewal Registration Code Enter your Registration Code Product type :
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7. Paste a valid User code from MXview One. Then, click Activate to get the activation code.

Products and Licenses / Activate an add-on or renewal License

Add-on or Renewal Registration Product type : MXview One Power
Caode )
User code Enter your user code
License Type ADD

8. Once the process has been successfully completed, a pop-up window will appear to inform you that your
license code has been activated. Click I know to close the window. If the license failed to activate,
enter the correct Registration Code and User code again. If you are still experiencing problems, please
contact Moxa Support.

Message notification

Thank you for purchasing an MXview One product license!
Your license has been activated, we will send you an activation notification
to your mailbox.

9. Check the email account you used to apply for your moxa account. The activation code will be sent to
this email address.

Dear Customer,

Your MXview One Activation Code

has been activated successf

ully Visit the License Activation Paortal to see more details about your product and license activation code

10. Copy the activation code from the email.
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11. In MXview One, paste the activation code into the Activation Code field.

Add New License

& o o

Log in to the Maxa License Copy User Code Activate
Site

Download the license from the Moxa License Site , and paste the Activation Code
here.

Activation Code

Close

12. Click Apply and MXview One will activate the license.

Deactivating a License

If you want to transfer a license to a different instance of MXview One, the license has to be deactivated
first.
1. Navigate to Menu (E) > Administration > License Management.
The License Management screen appears.
2. Expand the Licenses section.
A list of activated licenses and activation codes appears.
3. Click Deactivate and MXview One will deactivate the license.

License Management

MXview One o
\ License Power Add-on License
Mode: Authorized Mode: Authorized
. Current Nodes: 0
) Licensed Nodes: 6
A

>

— Moxa License Site (4

Add New License License Type

Licenses

License Type: Power Add-on License

Activation Code:
License Start: 2022-06-16 15:15:13

/  NOTE

If you only have one Node-based License with one Add-on License, you will have to deactivate the Add-on
License first, then deactivate the Node-based License next.

If you have more than one Node-based License, it is ok for you to deactivate the Node-based License or
Add-on License without any order.
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Reactivating a Deactivated License

A deactivated license can be reactivated on the current instance of MXview One.

1. Navigate to Menu (E) > Administration > License Management.
The License Management screen appears.

2. Expand the Deactivated Licenses section.
A list of deactivated licenses and deactivation codes will appear.

License Management

MXview One [}
‘ License Power Add-on License
Mode: Authorized Mode: Authorized
Current Nodes: 0
: Licensed Nodes: 6

> | Moxa License Site 4
g Add New License License Type
Licenses v

Deactivated licenses

Wireless Add-on License
Deactivation Code:

License Start: 2022-06-16 15:07:15

3. Click Re-activate and then click Next.
Copy the deactivation code and click Next.

Re-activate License

(/] (2]

Log In to the Moxa Copy Deactivation Activate
License Site Code

Copy Deactivation Code and paste it on Moxa License Site

Deactivation Code:

5. Open a web browser and go to https://license.moxa.com. Select MXview One and log in using your
Moxa account.

6. Select Products and Licenses and click Transfer a Product License. Then, select MXview One
from the product type list.
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7. Paste the Deactivation Code followed by the New User Code from MXview One. Then, click Product

Transfer.
Products and Licenses / Transfer a Product License
Product Type MXview One 4
Deactivation Code Enter your deactivation code

New User Code Enter your New User Code
Product
Transfer

K3
V4 NOTE

'Reactivating a Deactivated License' and 'Transfer a Deactivated License to another MXview One instance'
are using the same menu here.

If you are implementing 'Reactivating a Deactivated License' on the current instance of MXview One,
please paste the current MXview One User code in the 'New User Code' section.

8. Once the process has been successfully completed, a pop-up window will appear to inform you that your
license code has been deactivated. Click I know to close the window. If the license failed to deactivate,
enter the license key again. If you are still experiencing problems, please contact Moxa Support.

Message notification

Deactivation Success

9. Check the email account you used to apply for your moxa account. The activation code will be sent to
this email address.

Dear Customer,

Your New MXview One Activation Code

ed successfully. You can now start using MXview on this system. Visit the License Activation Portal to see more details about yo

ur product and license activation code.

10. Copy the activation code from the email.

MXview One 1.5.0 User Manual 58



11. In MXview One, paste the activation code into the Activation Code field.

Re-activate License

/] o (/] o

Log In to the Moxa Copy Deactivation Copy User Code Activate
License Site Code

Download the license from the Moxa License Site , and paste the Activation Code
here.

Activation Code

Close

12. Click Apply and MXview One will reactivate the license.

Transferring a License to a Different Instance
of MXview One

A deactivated license can be transferred to a new instance of MXview One.

1. Navigate to Menu (E) > Administration > License Management.
The License Management page will appear.

2. Expand the Deactivated Licenses section. A list of deactivated licenses and deactivation codes will
appear. Copy the deactivation codes.

License Management

MXview One

License Power Add-on License
Mode: Authorized Mode: Authorized

Current Nodes: 0

Licensed Nodes: 6

> | Moxa License Site 4
d Add New License License Type
Licenses

Deactivated licenses a

Wireless Add-on License
Deactivation Code:

License Start: 2022-06-16 15:07:15

3. Open a web browser and go to https://license.moxa.com. Select MXview One and log in using your
Moxa account.

4. Select Products and Licenses and click Transfer a Product License. Then, select MXview One
from the product type list.
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5. Paste the Deactivation Code and the New User Code from a new installation of MXview One. Then,
click Product Transfer.

Products and Licenses / Transfer a Product License

Product Type MXview One 4
Deactivation Code Enter your deactivation code
New User Code Enter your New User Code

Product
Transfer

/ NOTE

To obtain a new User Code, please visit "Adding a New License”, and follow steps 1 to 4 to obtain and
copy the new User Code.

6. Once the process has been successfully completed, a pop-up window will appear to inform you that your
license code has been deactivated. Click I know to close the window. If the license failed to deactivate,
enter the license key again. If you are still experiencing problems, please contact Moxa Support.

Message notification

Deactivation Success

7. Check the email account you used to apply for your moxa account. The activation code will be sent to
this email address.

Dear Customer,

Your New MXview One Activation Code

ed successfully. You can now start using MXview on this system. Visit the License Activation Portal to see more details about yo

ur product and license activation code.

8. Copy the activation code from the email.
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9. In MXview One, paste the activation code into the Activation Code field.

Re-activate License

/] o (/] o

Log In to the Moxa Copy Deactivation Copy User Code Activate
License Site Code

Download the license from the Moxa License Site , and paste the Activation Code
here.

Activation Code

Close

10. Click Apply and MXview One will reactivate the license.

Quantity of Monitored Devices Exceeds the
Number of Node-based Licenses

When the quantity of monitored devices exceeds the activated number of license nodes, you can purchase
additional Node-based Licenses and activate them as required. Or you can delete the extra devices that you
don't have to monitor.

License Management

MXview One
N\ License Wireless Add-on License
Mode: Authorized Mode: Trial
State: Not enough nodes fo Mview One will be locked after 30 please purchase additional nodes
D e zon A R

usage limit.
Licensed Nodes: 2000 =

Moxa License Site [

Add New License License Type

Licenses

Wireless Trial Remaining Re-activate License

58

days

Use both the Deactivation Code and a
User Code to re-activate your license.

1. Buy Extra Node-based Licenses
Order the required quantity of Node-based Licenses from your channel or Moxa Sales Representative.
Then, follow the instructions on Adding a New License to activate a new license.

2. Delete Extra Devices

a. You can delete the devices on the Topology page to meet the number of Node-based Licenses you
available.
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b. Please follow the instructions below:
O Press the Stop button in the Control Panel.

v

Service is running

You are monitoring your network.
m Open MXview One

O After 1 minute, Click Start and wait for the status to display 'Service is running now'. Then,
click Open MXview One and Log in to MXview One.

O Navigate to Menu (E) > Topology.
The Topology screen will appear and displays the Topology Map by default.

O Click the devices you want to delete and then click Delete. From now on, MXview One will not
count the delete devices.
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5. Dashboard Widgets

The MXview One Dashboard contains several widgets that provide summary information about your
network devices and event highlights.

Dashboard Overview

To access the Dashboard, navigate to Menu (E) > Dashboard.
Use the Dashboard to gain a quick overview of your network devices, important system events.
The Dashboard displays the following widgets:

e Device Summary

e Event Highlights: Cold/Warm Start Trap
e Event Highlights: ICMP Unreachable

e Event Highlights: Link Down

To refresh the data displayed in all the widgets, click the Settings ( i) icon in the top right corner of the
screen and select Refresh All.

Device Summary

The Device Summary widget displays the following information about the devices on your network:

Device Summary

022-12-1410:51:24 (3

3 0

Healthy Devices Warning Devices Critical Devices

View Network Topology.

)

¢ Healthy Devices: The number of devices with no critical events or warnings.
Click to view additional details about the devices on the Topology screen.

e Warning Devices: The number of devices with warnings.
Click to view additional details about the devices on the Topology screen.

e Critical Devices: The number of devices with critical events.
Click to view additional details about the devices on the Topology screen.
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Event Highlights

The Event Highlights will display the following events during the past seven days: Cold/Warm Start Trap,
ICMP Unreachable, and Link Down.

Event Highlights Last Update: 20221214 10:53:24 (3

20

Count

12108 12109 12710 12M 1212 12/13 1214
B Cold/Warm Start Trap ICMP Unreachahble Link Down

Event Highlights: The Cold/Warm Start Trap widget displays the number of cold start traps and warm
start traps issued by devices at a site, and the day on which the events occurred.

Event Highlights: The ICMP Unreachable widget displays the number of times an ICMP-enabled device
on your network was unreachable, and the day on which the events occurred.

Event Highlights: The Link Down widget displays the number of times a port link was down on a device
on a specific date.

You can perform the following actions on this widget:

To view the number of event highlights issued at a site on a specific date, hover over a bar in the
widget chart.

To view additional details about the event on the Event History screen, click a bar on the widget chart.
To refresh the widget data, click the Refresh (C) button following the Last Update timestamp.
To download the Event Highlights data, click (=) below the Refresh button.
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6. Device Discovery and Polling

Device Discovery Overview

MXview One uses SNMP, ICMP, and MMS to discover devices within the scan ranges. When a Moxa device

has been located, MXview One will generate an actual image of the device, demonstrated below, to indicate

the device’s location on the network.

MXview One will also list detailed properties and configuration parameters, including the following:

e MAC Address

e Model Name

e IP Address

e Netmask

o Gateway

e Trap Server Address

e Auto IP Configuration

e Type of Redundancy Protocol

e Role in Redundancy Protocol

e  Status and Properties of the Port
e Power Status

e Status and Version of the SNMP Protocol

MXview One will display one of the following graphics to indicate devices:

BOXA

Moxa devices with SNMP enabled.

Non-Moxa devices with SNMP enabled. l m

Non-Moxa devices with ICMP enabled. l m]

Non-Moxa devices with MMS enabled.
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Configuring IP Address Scan Ranges

MXview One allows you to scan multiple ranges of IP addresses within your network. Each network range is

defined by a starting IP address and an ending IP address. Use Device Discovery to configure network

scan ranges.

1. Access the Device Discovery screen by the following method:
a. Navigate to Menu (E) > Device Discovery.

b. Navigate to Menu (E) > Topology, and then navigate to Topology > Device Discovery from the

Topology toolbar menu.

A Topology v e G

Q_ Device Discovery

Auto Topology

>

Auto Layout

e

The Device Discovery screen will appear.

° Network Range(s) ° Discovery Result

A The scanned range(s) will be saved after the device has been discovered.

<
O Enabled/Disabled Name First IP Address Last IP Address Group
O o W Enabled Test 192.168.127.1 192.168.127.254  Root

2. To add a new scan range:
a. Click the Add () button in the top left corner.
The Add Scan Range screen will appear.

Add Scan Range

Enable Scan Range

Enabled -

Name *

CIDR Prefix
First IP Address * /24 (255.255.255.0) ~

Last IP Address * CIDR Address Range

Root -

Cancel

e Complete

Site Name

Site BRANDON

»
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b. Select the scan range status:

O Enabled

O Disabled

Provide a Name for the scan range.

Provide the starting IP address for the scan range.
Provide the ending IP address for the scan range.

Select the CIDR Prefix (if applicable).

Assign the scan range to a Group.

Click Add.

The new scan range appears in the Network Range table.

T@a ™o a o

To edit a scan range:
Select the check box next to the scan range in the Network Range table.
Click the Edit (") icon.
The Edit Scan Range screen appears.
Modify the scan range settings.
Click Apply.

The Device Discovery screen displays the Network Range table with the updated scan range
information.

Click Next to discover the devices within the specific IP address ranges.

a Network Range(s) 9 Discovery Result e Complete

Device Alias Device IP Group Site Name

Device discovery is finished 0of0

To complete scan range configuration, click Next.

s

I

The Complete tab and the number of devices added to MXview One.

o Network Range(s) o Discovery Result o Complete

There are 0 device(s) added to MXview One

|—=" Browse Topology

<

_J

To view the updated topology, click Browse Topology.
The Topology screen will appear and display the updated Topology Map.
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Configuring Device Polling Settings

Devices in the assigned scan range can be discovered via SNMP and ICMP protocols. (The default polling
interval of ICMP is 10 seconds, while SNMP is 60 seconds. Users can go to the Default Device Template
page to change the polling intervals.) After a device is discovered, MXview One will use SNMP and ICMP to
poll the device periodically. To configure this function properly, you will need to know the following
information:

7/  NOTE

MXview One Dashboard widgets also use the device polling settings. For more information about the
MXview One Dashboard widgets, see Chapter 5: Dashboard Overview.

1. Navigate to Menu (E) > Administration > Default Device Template.
The Default Device Template screen appears.
2. Scroll down to the MXview One Polling Interval section.

MXview One Polling Interval

10

3. Configure the following ICMP polling settings:

ICMP polling interval: Specify the time in seconds between polls. MXview One will use ICMP protocol
to check if the device is alive.

4. Configure the following SNMP polling settings:
SNMP polling interval: Specify the time in seconds between polls.

5. Scroll down to the Log In section to configure the device web console login credentials:
» Username: The login username for the device web console
» Password: The login password for the device web console

admin

6. Click Save.
MXview One will update the modified settings.
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Changing the Default SNMP Configuration

The default SNMP read community string that is used to discover devices is public. Use the Default Device
Template screen to change the default read community string or modify other default SNMP configuration.

1. Navigate to Menu (E) > Administration > Default Device Template.
The Default Device Template screen will appear.
2. Scroll down to the SNMP Configuration section.

SNMP Configuration

Vi v 161

< public private

Encryption Password

3. Configure the following settings:

SNMP Version: Select the SNMP protocol version
SNMP Port: Specify the SNMP port

Username: Specify the SNMP server username
Password: Specify the SNMP server password

Read Community: Specify the new community string
Write Community: Specify the new community string

@ ™o a0 T o

Data Encryption: Select the data encryption method
O NoAuth
3  AuthNoPriv
3O  AuthPriv
h. Authentication: Select the authentication method
dJ MD5
O SHA
O SHA256
0 SHA512
i. Encryption Protocol: Select the encryption protocol and input the Encryption Password.
d DES
d AES
4. Click Save.
MXview One updates the modified settings.
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Changing Modbus TCP Settings

By configuring Modbus TCP Settings in the Default Device Template section, MXview One will be able to
detect whether a device has Modbus attributes or not. If a device supports Modbus, a Modbus string will
appear above the device icon in the topology to easily identify the device.
1. Navigate to Menu (E) > Administration > Default Device Template.

The Default Device Template screen will appear.
2. Scroll down to the Device Identification Settings section.

Device Identification Settings

Disabled -~ 502
Disabled v 44818 44818
Disabled v 102

3. Configure the following settings:
a. Modbus Enabled: Enable or disable Modbus TCP settings.
b. Modbus Port: Specify the Modbus TCP port.

4. Click Save.
MXview One updates the modified settings.

Changing EtherNet/IP Settings

By configuring EtherNet/IP Settings in the Default Device Template section, MXview One will be able to
detect whether an ICMP device has EtherNet/IP attributes or not. If an ICMP device supports EtherNet/IP,
an EtherNet/IP device icon will be displayed in the topology to easily identify the device.

1. Navigate to Menu (E) > Administration > Default Device Template.

The Default Device Template screen will appear.
2. Scroll down to the Device Identification Settings section.

Device |dentification Settings

Disabled + 502

Disabled ~ 44818 44818
Disabled * 102

3. Configure the following settings:
> EtherNet/IP Enable: Enable or disable EtherNet/IP settings.
> EtherNet/IP TCP Port: Specify the EtherNet/IP TCP port.
» EtherNet/IP UDP Port: Specify the EtherNet/IP UDP port.
>

Click Save.
MXview One updates the modified settings.
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Changing Siemens S7comm Settings

By configuring Siemens S7comm Settings in the Default Device Template section, MXview One will be able
to detect whether an ICMP device has Siemens S7comm attributes or not. If an ICMP device supports
Siemens S7comm, a Siemens S7comm device icon will be displayed in the topology to easily identify the
device.

1. Navigate to Menu (E) > Administration > Default Device Template.

The Default Device Template screen will appear.
2. Scroll down to the Device Identification Settings section.

Device Identification Settings

Disabled ~ 502

Disabled ~ 44818 44818
Disabled * 102

3. Configure the following settings:
» Siemens S7comm Enable: Enable or disable Siemens S7comm settings.
» Siemens S7comm Port: Specify the Siemens S7comm port.

4. Click Save.
MXview One updates the modified settings.
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7. Topology Management

MXview One allows you to view a graphical representation of your network topology, add/delete devices and
links to the Topology Map, organize the topology structure, and export the Topology Map as a PNG image.
You can also scan specific IP address ranges to discover devices on your network.

Topology Overview

The Topology screen allows you to view the Topology Map, which is a graphical representation of the
devices in your network, and perform most actions in MXview One. For example, you can use the Network
Topology screen to do the following:

e Display a graphical representation of a real network.

e Show connecting relationships between devices.

e Indicate the status of devices and links.

All > Site BRANDONYANG-PC > Root

A Topology v @ Growp v /' Edit v @ Visualization v aZSFP v

Q
192.168.127.114 g
192.168.127.93
. m
>
]
a
192.168.127.104 1921681271- 168.127.115
2
a Y-
4 »
[J Always show "Recent Events” at startup
= T @ Q Search
(m] Site Name D Source  Source IP Device Alias Description Time Issued
Mxview
0o e B  Ssite BRANDONYANG-PC 180 192.168.127.169  192.168.127.169-AWK-4131A Device SNMP reachable 2022-05-12 17:09:27

One
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Viewing the Topology Map

Use the Topology screen to view the Topology Map of your network.

1. Navigate to Menu (E) > Topology.
The Topology screen will appear and displays the Topology Map by default.
2. If the List view is displayed, click the Topology view ( %) icon in the top right corner.

The Topology screen will display a graphical representation of the devices and links on your network.

3. To search for a specific device on the Topology Map:
a. Click the Search topology (2 ) icon in the top left corner.
The topology search box appears with a drop-down directory tree of the Topology Map structure.

Search topology

Q

Root

CC:30:80:3C:75:1C

| 192.168.127.252--EDS-505A
00:90:E8:7D:AB:23

‘ 192.168.127.253-EDS-508A
00:90:E8:80:2B:6B

b. Search the device in the drop-down directory tree or type a string in the search box. Click the
specific device and MXview One will bring you to the device on the Topology Map.

I' 192.168.127.1--ICMP Device

4. To view the details of a specific device, select the device in the Topology Map.

- a

192.168.127.252 H 4]
EDS-505A

Ring 1 Master

192.168.127.253
EDS-508A

The Device Properties pane appears to the right of the Topology Map.

Device Properties Current Status

Basic Device Properties

Alias
EDS-510E

Model Name
EDS-510E

MAC Address
00:90:E8:86:2F:16

Availability
100.00%

System Description
EDS-510E-3GTXSFP

System Object ID
.1.3.6.1.4.1.8691.7.84
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5. To view events associated with the device, click the Current Status.
The Current Status pane displays events associated with the device.

Device Properties Current Status

No events

6. To view details about a link between devices, select a link in your Topology Map.

Ring 1 Master
. — = —
192.168.127.252 192.168.127.253
EDS-505A EDS-508A

The Link Properties pane appears to the right of the Topology Map.

Link Properties

Link Information

From
10.81.10.12

Port 9

To
10.81.10.13

Port 8

Link Speed
1Gb

SFP Information

From
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Viewing Recent Events

Use the Topology screen to view recent events from devices in your topology. You can filter the

the list or export the data as a CSV file.

For more information on viewing all events, see Event Monitoring.

1. Navigate to Menu (E) > Topology.

The Topology screen will appear and displays the Recent Events panel on the bottom.

All > Site BRANDONYANG-PC > Root

X Topology v @ Gropv S Edty @ Visualization v

Ring Master Ring Master

192168.127.13  192.168.127.67_192.168.127.95

|

[ Always show 'Recent Events” at startup

<]

v
oo ofE

1

o ol o e o e o s e R

lo©ol©ol0|0o|o|o|0o|o 0|0 |00 |0 o |0 |0
NENBNNENEBRENEBNEENDR
PrPPPCPrPEPCPEEREDOEECDD

site Name
Site BRANDONYANG-PC
Site BRANDONYANG-PC
Site BRANDONYANG-PC
Site BRANDONYANG-PC
Site BRANDONYANG-PC
Site BRANDONYANG-PC
Site BRANDONYANG-PC
Site BRANDONYANG-PC
Site BRANDONYANG-PC
Site BRANDONYANG-PC
Site BRANDONYANG-PC
Site BRANDONYANG-PC
Site BRANDONYANG-PC
Site BRANDONYANG-PC
Site BRANDONYANG-PC
Site BRANDONYANG-PC

Site BRANDONYANG-PC

Ring 1 Master

aSPy T Wirless v

RingMaster  Ring Master

Ring 2 Master
Ring 1 Master

L o

12180258 s iz0s i1z dopissIze wies) RIS 21681210

1754
1753
1752
1751
1750
1749
1748
1747
1746
1745
1744
1743
1742
1741
1740
1739
1738

Source Source 1P

Device Alias

Mxview One  192.168.127.168  102.168.127.168-AWK-1131A

MXview One  192.168.127.168 102.168.127.168-AWK-1131A

Mxview One  192.168.127.168  102.168.127.168-AWK-1131A

Mxview One  192.168.127.168  192.168.127.1

AWK-1131A

Mxview One  192.168.127.168  102.168.127.168-AWK-1131A

Mxview One  192.168.127.168  192.168.127.168-AWK-1131A

Mxview One

Mxview One  192.168.127.168 192.168.127.168-AWK-1131A

MXview One  192.168.127.168  102.168.127.168-AWK-1131A

Mxview One 192.168.127.168  192.168.127.168-AWK-1131A

MXview One  192.168.127.168 102.168.127.168-AWK-1131A

Mxview One  192.168.127.168  192.168.127.168-AWK-1131A

MXview One  192.168.127.168 102.168.127.168-AWK-1131A

Mxview One  192.168.127.168  102.168.127.168-AWK-1131A

MXview One  192.168.127.168 102.168.127.168-AWK1131A

Mxview One  192.168.127.160  102.168.127.160-AWK-4131A

Mxview One  192.168.127.169 102.168.127.160-AWK-4131A

Q searct

events in

BRI

Description

Device SNMP reachable
Device SNMP unreachable
Device SNMP reachable
Device SNMP unreachable
Device SNMP reachable
Device SNMP unreachable
User login: admin

Device SNMP reachable
Device SNMP unreachable
Device SNMP reachable
Device SNMP unreachable
Device SNMP reachable
Device SNMP unreachable
Device SNMP reachable
Device SNMP unreachable
Device SNMP reachable

Device SNMP unreachable

Time Issued

20220428 13:48:34
20220428 13:48:28
20220428 133818
20220428 1338:08
20220428 1322:12
20220428 1322:04
20220428 13:16:52
20220428 1301:53
20220428 13:01:45
20220428 12:53:20
20220428 1253:15
20220428 12:32:32
20220428 1232:23
20220428 1221:28
20220428 1221:23
20220428 12119:52

20220428 12:19:44

2. To filter the information in the table, type a full or partial string that matches the value in any of the
table columns on the right of the search space.

MXview One filters the table to only display events with values that fully or partially match the specified

string.

3. To filter the information in the table by specific criteria:

a. Click the Filter (¥) icon below the Recent Events tab.

The criteria selection screen appears.

= o

Severity

Source

Group

IP Address

b. Specify any of the following criteria:

Reset Apply

O Severity: Select the event severity level

>

YV V VYV VYV

Any
Information
Warning
Critical

System Information
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O Source: Select the source that detected the event
» Any
» MXview One
» Trap
O Group: Select the device group
O IP Address: Select the device IP address
c. Click Apply.
MXview One filters the table to only display events that match the specified criteria.
4. To acknowledge the events in the table:
a. Click the Acknowledge (Bd) icon before the specific event, then the event will be confirmed.

b. If you want to acknowledge more events, click the checkbox before the events or click the checkbox
on the tool bar to select all the events. Then, click the Acknowledge icon.

5. To sort the data in the table by a specific column, click the column heading.
MXview One sorts the table by the column.

ID Source Source I Device Alias

43 g":’(\ e 192.168.127.252 192.168.127.252--EDS-505A
ne

6. To export data displayed in the Recent Events tab:

a. Click the Export (E) icon.
= T &

a Export CSV N

O 9e t

b. Select Export CSV.
c. Specify the location to save the exported file.
d. Click Save.
MXview One exports the displayed event data as a CSV file.

7. To quickly filter event, click the Quick filter event (:==) icon to find the events.

The events include the following:

» Unacknowledged Events

» Last 20 Unacknowledged Events
» Last 20 Events

» Last 50 Events.

== @&

Unacknowledged Events

Last 20 Unacknowledged Events

Last 20 Events

Last 50 Events

8. MXview One allows users to display the Recent Events panel all the time by clicking the Always show
"Recent Events" at the startup checkbox.
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[] Always show "Recent Events” at startup

O Site Name

Organizing the Topology Structure By Group
Function

The Topology Map can be organized into a multi-layer tree structure of up to 5 layers. Organizing the
topology structure into groups helps manage a large number of nodes on the computer screen. For
example, users can move nodes of the same subnet or location into the same group. Root, which is the only

group at the first layer, exists by default and cannot be deleted. Groups created by users are in the layer
under Root. Devices can be moved between groups.

1. Navigate to Menu (E) > Topology.
The Topology screen appears and displays the Topology Map by default.
» MXview One represents the Topology Map structure by a path at the top of the Topology screen:

All > Site BRANDONYANG-PC > Root »
J\ Topology v e Group v /' Edit v

» If the Topology Map contains groups under the Root layer, you can click the right arrow (>) and
select the group:

All > Site BRANDONYANG-PC > Root

J\ Topology v 0 Group v /‘ |

v

group 1

(@]

» You can also click the following icon used to indicate user-defined groups within the Topology Map:

Group1
2. If List view is displayed, click the Topology view ( *) icon in the top right corner.
The Topology screen displays the following toolbar above the Topology Map:

o Topology w & Grouwp v # Edit~ @ Visualization v
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3. To create a group:
a. Navigate to Group > Create Group.
The Create Group screen appears.

Create Group

Root v

group

Test

Image

The maximum image sizeis 1 MB

b. Configure the following:
O Parent Group
O Group Name
O Group Description
O Group Icon
c. Click Create.
MXview One will add the group below to the specified parent group.
4. To reorganize the groups within the Topology Map structure:
a. Navigate to Group > Group Maintenance.
The Group Maintenance screen appears.

Group Maintenance

¥ Root

group 1

Cancel
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b. Select a layer to modify.
The group details appear to the

Group Maintenance
[ ]

¥ Root

group 1

right of the topology directory tree.

Group Name *

group 1

Group Description

Image B

The maximum image size is TMB

Cancel Apply

c. (Optional) Edit the group details or perform one of the following points:

i (Optional) Click Add to add a new group below the selected layer.

ii. (Optional) Click Delete to remove a group from the topology structure.

d. Click Apply.

5. To reassign the device(s) in a group:

a. There are two ways to reassign the device(s) in a group:

i Navigate to Group > Change Group. The Change Group screen appears.

ii. Select the device(s) you want to reassign on the topology and click the Change Group icon on

the toolbar.

Change Group

Root -

IP Address
192.168.127.154

192.168.127.155
192.168.127.156
192.168.127.157
192.168.127.158
192.168.127.159
192.168.127.160

192.168.127.161

000 |00 |00 |0 O

102 168 127 142

0 Selected / 50 total

group 1 -

Cancel
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b. If the IP Address list does not display the IP address(es) of the device(s) you want to reassign,
select the Current Group drop-down list.

Select the IP address(es) of the device(s) that you want to reassign to a different group.
From the Assign to Group drop-down list, select the new group for the selected device(s).
e. Click Apply.

Redundant Topologies

Redundant topologies have at least one backup link, which will be indicated with a dashed line:

Tail

T = (il o a @ i

182168 127.52 18216812755 18216812756 182 168727 58
5 a g8
2]
182.168.127.51
[ 4 H a 5]
Head Ring 1 Master Raoot
. B HSe=r=n - i3 2 ‘ <] o
182,166 127 50 182 168.127.54 182 168.127.53 182 16B127.57 192168127 .59

For devices that play a particular role in the topology, MXview One will label the devices by displaying the
roles above the images of the devices. Backup links will be indicated with dashed lines.

e RSTP has a Root

e Turbo Ring has a Master

e Turbo Chain has a Head and a Tail

e Dual Homing

NOTE

Only the Auto Topology function can draw dashed lines for redundancy links. Redundant links that are
added manually will appear as solid lines.

PoE

Power Consumption Visualization

By periodic polling, a PoE link will display the port number, power (watts), voltage (V), and current (mA)
directly on the topology map.

192.168.127.75 port 6 l I
E i 3W / 45V / B1mA

e

192.168.127.75 192.168.127.16
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VPN Tunnel Visualization

The VPN tunnel link will display 'VPN' on the link.

1. The VPN tunnel is connected.

‘ 192.168.128.198/T2 VPN 192.168.127.198/T1
192.168.128.199 192.168.127.13

2. The VPN tunnel is disconnected.

192.168.128.198/T2 VPN

92.168.127.198/T1

192.168.128.199 192.168.127.13

7

NOTE

VPN Tunnel Visualization is only available on Moxa’s EDR-810 and EDR-G9010 series of secure routers.

Port Trunking

Port trunking, also called link aggregation, involves grouping links into a link aggregation group. Trunking
links will be indicated with thick, solid lines.

192.168.127.105 162.168.127.107

NOTE

Only Auto Topology can draw thick lines for trunking links. Trunking links that are added manually will
appear as solid lines.

NOTE

For trunked link, check Device Properties to get the port number corresponding to the trunking
information.

CUICHIIELLSHIauu JCUICIHNICL FUIL 274

interface.29

m up / 200M / Full-duplex

ethernetCsmacd /Ethernet Trunking

192.168.127.105 192.168.127.107 Port 1 of EtherDevice Switch
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Adding Devices and Links

MXview One allows you to manually add devices and links to an automatically generated Topology Map. The

Topology screen allows you to add devices from Topology View or List View.

1. Navigate to Menu (E) > Topology.
The Topology screen appears and displays the Topology Map by default.
2. To add a device to the Topology Map:
a. Click Edit > Add Device.
The Add Device screen will appear.

Add Device

P Addre

A e A I -
Vi - 161

public private

Cancel

b. Configure the following:

O IP Address: Specify the IP address of the device
Assign Model: Select the model of the device
Assign to Group: Select the group to assign the device to
SNMP Version: Select the SNMP version
Port: Specify the port number
Username: Specify the device login Username
Password: Specify the password
Read Community: Specify the SNMP read community string
Write Community: Specify the SNMP write community string
Data Encryption: Select the data encryption method
Authentication: Select the authentication method

Qoo oooaooaoa

Encryption Protocol: Select the encryption protocol and input the Encryption Password
c. Click Add.
MXview One adds the device to the topology.
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3. To add a link to the Topology Map:
a. Navigate to Edit > Add Link.
The Add Link screen will appear.

Add Link

From

To

Cancel

b. Configure the following information for the two devices joined by the link:
O Device: Specify the IP address of the device
O Port: Specify the device port number

c. Click Add.
MXview One adds the link between the specified devices.

NOTE

Links drawn between two devices in the Topology Map are bidirectional. You may specify either device as
the From device or the To device.

NOTE

Trunking and redundancy links added manually will appear as solid lines.

NOTE

Port numbers must be numeric and entered correctly to obtain the correct traffic information.

NOTE

For modular switches, a port number depends on the chassis to which the port belongs, but not on how
many modules are inserted. For switches such as the PT-7828, the first module’s port numbers are from 1
to 8, the second module’s port numbers are from 9 to 16, and so on. The port number depends only on
which slot the module is in; in other words, the port number is the same regardless of whether other slots
are empty or occupied.
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Deleting Devices and Links

You can delete devices and links from the Topology Map. After a device is deleted, it will be removed from
the topology map, and the device will not be polled or located when performing Device Discovery. Deleting a
link will delete a link from the topology map, but it will not affect the actual network configuration.
1. Navigate to Menu (E) > Topology.

The Topology screen will appear and display the Topology Map by default.
2. To delete a device from the Topology Map:

a. Select the device.

‘\ Device Configuration v o Device Control v T web console B Run seript v # change Group C Refresh GO addLink  Bg Device Dashboard O Delete

The following toolbar menu will appear.
b. Click Delete.
A confirmation screen will appear.

Delete Device

Are you sure you want to delete this device?

c. Click Delete.
MXview One deletes the device from the Topology Map.
3. To delete a link from the Topology Map:
a. Select the link.
The following toolbar menu will appear.

@ Link Traffic v X Severity Threshold B Set Port Label _U- Delete

b. Click Delete.
A confirmation screen will appear.

Delete Link

Are you sure you want to delete this link?

Cancel

c. Click Delete.
MXview One deletes the link from the Topology Map.

Updating the Topology Map

Updating the existing topology adds new links and updates existing links, but does not change the status of
links that are indicated as having been disconnected or links that were drawn manually.

For devices with LLDP functionality, MXview One can draw the physical topology map, down to the port level
of the devices. For devices without an LLDP MIB, MXview One is able to draw links by using ARP. To activate
this function, select the Advanced Topology Analysis checkbox from the Auto Topology screen.

1. Navigate to Menu (E) > Topology.
The Topology screen appears and displays the Topology Map by default.

2. If List view is selected, click the Topology view (%) icon in the top right corner.
The Topology screen displays a graphical representation of the devices and links on your network.
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3. Navigate to Topology > Auto Topology.
The Auto Topology screen appears.

Auto Topology

(O New Topology

Existing links are going to be deleted

(® Update Topology

Existing links will be kept while new links are added

Advanced Topology Analysis o
[ Strict Link Verification Mode @

*Additional time is required.

(Optional) Select Advanced Topology Analysis to draw links for devices without an LLDP MIB.

Select Update Topology.

(Optional) Select Strict Link Verification Mode. If enabled, links between devices will only be shown
on the topology if the devices on both ends have the other device's information in their LLDP table.

7. Click Apply.
MXview One will update the Topology Map.

/  NOTE

MXview One cannot guarantee that it can draw the link of the topology for non LLDP devices. However,
you can draw the link of the topology manually by clicking Add Link.

Refreshing the Topology Layout

After changes have been made, use the Auto Layout feature to refresh the layout of the Topology Map.
Auto Layout does not update any devices or links. It only redraws the topology to better fit the screen.
1. Navigate to Menu (E) > Topology.

The Topology screen will appear and displays the Topology Map by default.
2. If List view is selected, click the Topology view (*) icon in the top right corner.

The Topology screen will display a graphical representation of the devices and links on your network.
3. Navigate to Topology > Auto Layout.

The Auto Layout screen appears.

Auto Layout

Are you sure you want to use Auto Layout?
(current layout will be overridden)

Cancel m
4. Click Apply.

MXview One refreshes the Topology Map layout.
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Creating a New Topology Map

Creating a new topology deletes all links, requests LLDP information from devices, and draws topology maps
based on the gathered information.

For devices with LLDP functionality, MXview One can draw the physical topology map, down to the port level
of the devices. For devices without an LLDP MIB, MXview One is able to draw links by using ARP. To activate
this function, select the Advanced Topology Analysis checkbox from the Auto Topology screen.

NOTE

Links drawn manually will also be deleted by this action.

NOTE

Your devices must have firmware version 3.1 or higher to use Advanced Topology Analysis.

NOTE

If the Auto Topology function does not create an accurate representation of the actual network, deselect
the Advanced Topology Analysis check box and try again.

1. Navigate to Menu (E) > Topology.

The Topology screen appears and displays the Topology Map by default.
2. If List view is selected, click the Topology view (*) icon in the top right corner.

The Topology screen displays a graphical representation of the devices and links on your network.
3. Navigate to Topology > Auto Topology.

The Auto Topology screen appears.

Auto Topology

@ New Topology

Existing links are going to be deleted

O Update Topology

Existing links will be kept while new links are added

Advanced Topology Analysis o
[ Strict Link Verification Mode @

*Additional time is required.

(Optional) Select Advanced Topology Analysis to draw links for devices without an LLDP MIB.

Select New Topology.

Click Apply.
MXview One will create a new Topology Map.
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/  NOTE

MXview One cannot guarantee that it can draw the link of the topology for non LLDP devices. However,

you can draw the link of the topology manually by clicking Add Link.

Setting/Editing the Background Image

MXview One allows you to customize the Topology Map by uploading a background image in JPG, GIF, or

PNG format.

1. Navigate to Menu (E) > Topology.
The Topology screen appears and will display the Topology Map by default.

2. If List view is selected, click the Topology view ( *) icon in the top right corner.
The Topology screen will display a graphical representation of the devices and links on your network.

3. Navigate to Edit > Background.
The Background screen appears.

Background

Preview (Topology Size: 2265 x 2771)

MOXAN:

I

4. Upload the background image by using one of the following methods:
» The image size must be less than 20 MB.
» Click Set Background (B) icon to upload the image file.
MXview One will set the uploaded image as the Topology Map background.

Background Color

[ #FFFFFF

Image
7 MOXA

Position

0 0

700 136 H

Alpha
e e ]

Saturation @

5. Use the sliders to modify the Alpha and Saturation value of a background image.
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6. Under the Position section, modify the value of X and Y to move the origin of the image to a suitable
location. Modify the 'Width' and 'Height' to change the size of the image.

Background
Preview (Topology Size: 2265 x 2771) Background Color
[] #FFFFFF
E Image

i MOXA

Position
0 0
700 136

Alpha @

I[EU ~| Saturation
— @

7. To delete a background image, click (i) to remove the background image from the Topology Map.

Editing the Topology Appearance

Use the Preferences screen to modify how the Topology Map displays the topology line style, PoE status,
background color, link status, and traffic load.

1. Navigate to Menu (E) > Administration > Preferences..
The Preferences screen appears.

2. In the Appearance section, expand Topology.
The Topology settings appear.

Preferences

Q Search

Appearance

¢ | Topology

opology Line Style

Directed Line Style -

Directed Line Style Elbow Line Style
Text Size

Small v
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3. To modify the Topology Line Style, select one of the following from the drop-down list:

Topology Line Style

Directed Line Style v

PR T—

|
ey

B Directed Line Style Elbow Line Style

> Directed Line Style

MXview One applies the following style to the lines indicating the links between devices in the
Topology Map:

Directed Line Style'

> Elbow Line Style

MXview One applies the following style to the lines indicating the links between devices in the
Topology Map:

Elbow Line Style.

4. To modify the text size in MXview One:
Select one of the following from the drop-down list:
» Large
» Medium
» Small

Text Size
Text Size

Small -
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5. To modify how MXview One displays Power-over-Ethernet (PoE) links:

a. Select the Show PoE Status on Topology check box to indicate the PoE link status on the
Topology Map.

PoE

Show PoE Status on Topology
PoE Link Colorf | #CECECE

b. Click the PoE Link Color field and specify a new color.
PoE

Show PoE Status on Topology
PoE Link Colof{ ] #CECECE 25

Background

Background Color| | #FFFFFF

Status Color

Link Up Link Down

[[] #Ccecece W #Froc @ T .

Turbo Ring V1 Turbo Ring

[[] #CECECE ] #cec #oecece s
Hex

Turbo Chain RSTP

c. (Optional) Clear the Show PoE Status on Topology check box to hide the PoE link status on the
Topology Map.

PoE

[[] Show PoE Status on Topology
PoE Link Color] | #CECECE

6. To modify the Topology Map background, click the Background Color field and specify a new color.

Background

o
Background Colofl | #FFFFFF b

Status Color

Link Up Link Down
[[] #CECECE I #FrFoo00

Turbo Ring V1 Turbo Ring V2

[ ] #CECECE | ] #CECECE

Turbo Chain RSTP

[] #CECECE [] #CECECE | i v
PRP LAN A PRP LAN B Hex
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7. To modify the color used to indicate the status of specific links in the Topology Map, click to modify the

Status Color hex code for any of the following links:
Link Up

Link Down

Turbo Ring V1

Turbo Ring V2

Turbo Chain

RSTP

PRP/Coupling LAN A

PRP/Coupling LAN B

HSR Ring

YV V V V VYV V V VYV V

Status Color

Link Up Link Down
[ ] #CECECE B #FFoo00
Turbo Ring V1 Turbo Ring V2
[ ] #CECECE [ ] #CECECE
Turbo Chain RSTP
[] #CECECE [] #CECECE
PRP LAN A PRP LANB
I #008000 I #0000FF
HSR Ring
I #800080
\g
/  NOTE

The three status colors (PRP LAN A, PRP LAN B, HSR Ring) will appear when you activate the MXview
Power license.

8. Click Save.
MXview One will update the modified settings.
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Editing the Device Appearance

Use the Preferences screen to modify how devices appear in the Topology Map.

1. Navigate to Menu (E) > Administration > Preferences.
The Preferences screen will appear.

2. In the Appearance section, expand Device.
The Device settings will appear.

Appearance
Topology v
Device &

o Preview
<
IP Address

Bottom Labe
Naone v

A If you change the Alias setting, please delete the device on the topology and
then rescan or add a device to complete the 'Alias’ setting.

Alias
Bottom Labe + Bottom Labe
IP Address v Model Name -

3. To modify the label that indicates the device in the Topology Map:
a. Locate the Bottom Label drop-down list located below the Preview image:

Device

Preview

IP Address

Bottom Label

None -

A If you change the Alias setting, please delete the device on the topology and
then rescan or add a device to complete the ‘Alias’ setting.
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b. Select one of the following properties from the Bottom Label drop-down:
O Location

O Alias
O Model Name
a MAC

MXview One displays the selected property below the IP address of the device.

Device Appearance

Preview

IP Address

Bottom Label

Location -

4. To modify the device alias:
a. Locate the Alias section.

A If you change the Alias setting, please delete the device on the topology and
then rescan or add a device to complete the 'Alias’ setting.

Alias
Bottom Label g Bottom Label

IP Address v Model Name v

b. From the first drop-down list in the Alias section, select one of the following:
IP Address

MAC

Model Name

Location

Qaaaaq

SysName
c. From the second drop-down list in the Alias section, select one of the following:
O IP Address

O MAC
O Model Name
O Location
O SysName
g
/7  NOTE

If you change the Alias setting, please delete the device on the topology and then rescan or add a device
to complete the 'Alias' setting.

5. Click Save.
MXview One updates the modified settings.
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Exporting the Topology Map

MXview One allows you to export the Topology Map as a PNG image.

1. Navigate to Menu (E) > Topology.
The Topology screen appears and displays the Topology Map by default.
2. If List view is selected, click the Topology view (%) icon in the top right corner.

The Topology screen will display a graphical representation of the devices and links on your network.

3. Navigate to Edit > Export Topology.
MXview One exports the PNG image of the Topology Map.
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8. Network and Traffic Monitoring

MXview One allows you to monitor the traffic between devices on your network and trigger events for
specific traffic conditions. You can apply topology views to monitor traffic load, network security, as well as
wireless access points and clients.

Viewing Link Properties

Click a link on the Topology Map to view link properties and perform the following:

1. Navigate to Menu (E) > Topology.

The Topology screen will appear and display the Topology Map by default.
2. Click on a link between devices in the Topology Map.

The Link Properties pane appears to the right of the Topology Map.

All > Site MOXA-KKABRVUM70 > Root

ﬁ Link Traffic v ZX Severity Threshold B Set Port Label E Delete = o
Q Link Properties
Coupling Coupling
GOOSE = : Link Information
L Sy 1021607108 192168120 192168127.105
) ‘ From

192.168.127.103

Port 4
192.168.127.106 I
[icur} To
Iuﬂ 2100123 192.168.127.1
192.168.127.1

Port 1

Link Speed

100 Mb
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Viewing Port Traffic

The Port Traffic screen displays a graph that shows the utilization percentage (Y-axis) over a specific time
period (X-axis). You can also adjust the time period for the data that is displayed by changing the starting
date and ending date. The minimum interval you can select is one day and the maximum interval you can
select is 90 days.

1. Navigate to Menu (E) > Topology.
The Topology screen appears and displays the Topology Map by default.
2. Click on a link between devices in the Topology Map.

The Link Properties pane and the following toolbar appear when a link is selected.
&P Link Traffic v X Severity Threshold @ Set Port Label B Delete

3. Navigate to Link Traffic > Port Traffic.
The Port Traffic screen will appear.

Port Traffic

5/3/2022 B 5/3/2022 ©

i L
Il
a1
b | ’|i‘ 1
AMALL

1
ERYATRI|
il

17 18 19 20 21 22 23 00 01 02 03 04 05 06
5/2/22 5/3
UTC +08:00
Time From To Value
RX
Omx

Close

4. To adjust the time period for the graph data:
a. Click the From date and select a new starting date.
b. Click the To date and select a new ending date.

5. Hover over a line to view the direction of traffic.

For example, the green line at the top of the following graph represents traffic from 192.168.127.1
(device IP address) Port 1 to 192.168.127.103 (device IP address) Port 4.

Port Traffic

0.025%

I e ‘
i

‘nf‘m.\ g

[

I |
L Ly .n[ Wil
L WITLY RN |

|

0.02% | fin.p. .\ W 4(1 I | AMIEmA! L

AR ST TR 0

i \H‘”‘ U’” \‘f‘ \M‘a VY H‘JH
r

TR T v Iy
VALY ML WL
ey ‘( ‘J’W ‘\“M‘J‘L‘r
u U U

oo1s%

0.01%

0.005%

0%

17 18 19 20 21 22 23 00 01 02 03 04 05 06
5/2/22 5/3
UTC +08:00
Time From To Value
[CJRX 2022-05-0221:15:01 192.168.127.1 Port 1 192.168.127.103 Port 4 0.0002%

[JTX 2022-05-02 21:15:01 192.168.127.103 Port 4 192.168.127.1 Port 1 0.0229%

Close
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Viewing Packet Error Rates

The Packet Error Rate screen displays a graph that shows the packet error rate (Y-axis) over a specific
time period (X-axis). You can also adjust the time period for the data that is displayed by changing the start
and end dates. The minimum interval is one day and the maximum interval you can select is 90 days.

1. Navigate to Menu (E) > Topology.
The Topology screen appears and displays the Topology Map by default.
2. Click on a link between devices in the Topology Map.
The Link Properties pane and toolbar appear when a link is selected.
ﬁ Link Traffic v X Severity Threshold B Sect Port Label B Delete
3. Navigate to Link Traffic > Packet Error Rate.
The Packet Error Rate screen appears.
Packet Error Rate
12/29/2021 B 12/29/2021 o}
03 06 09 12 1S 18 21 00 03 06 09 12
12/28/21 12429
UTC +08:00
Time From To Value
dinput
[ Output
4. To adjust the time period for the graph data:
a. Click the From date and select a new starting date.
b. Click the To date and select a new ending date.
5. Hover over a line to view the packet error rate.

Packet Error Rate

From To

12/29/2021 B 12/29/2021 ol

0.6%
0.5% i
0.4% H
03% i

02% ||

01% oA
WA\
0% | \

13:40 13:50 14:00 1410 14:20 14:30 14:40 14:50
12/29/21
UTC +08:00
Time From To Value
RX Error 2021-12-29 13:36:26 192.168.127.154 Port 2 192.168.127.151 Port 11 0.4%
I TX Error  2021-12-29 13:36:26 192.168.127.151 Port 11 192.168.127.154 Port 2 0.6%

Close

Close
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Monitoring Traffic Loads

MXview One collects the traffic load information of every link and displays the information to provide users
with a network-wide view.

1.

Navigate to Menu (E) > Topology.

The Topology screen will appear and displays the Topology Map by default.

If List view is selected, click the Topology view ( *) icon in the top right corner.

The Topology screen will display a graphical representation of the devices and links on your network.
From the toolbar menu, navigate to Visualization > Traffic View.

@ Visualization v @z SFP v
&k Traffic View
@ Security View

“~ Wireless Table View

The Traffic Load legend will appear and the Topology Map color-codes each link to indicate the traffic
load.

s Luad(%) c X _
0 20 40 60 80 100

@R0%

N

o

Monitoring Network Security

ISA/IEC 62443 is a continuously evolving cybersecurity standard whose guidelines have already been
adopted in many industrial automation applications. This standard, including its subsections, aims to cover
points such as general requirements, policies and procedure, system-level requirements, and component-
level requirements.

Moxa’s MXview One follows Moxa’s security guidelines, which are based on the IEC 62443-4-2 component-
level recommendations. Security View checks the security level of Moxa’s network devices. There are five
levels for checking the results in Security View:

High

Medium

Basic

Open: Security Level below basic

Unknown: Devices without security-related information for MXview One
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/  NOTE

The definition of general baseline is based on several industrial cybersecurity policies and requirements.

1. Navigate to Menu (E)) > Topology.
The Topology screen will appear and display the Topology Map by default.

2. If List view is selected, click the Topology view ( *) icon in the top right corner.
The Topology screen will display a graphical representation of the devices and links on your network.

3. From the toolbar menu, navigate to Visualization > Security View.

The Security View window will appear and the Topology Map indicates the security level of each device

with a color-coded circle.

All > client-generic > Root

W Maintenance v W Tools v " ChangeGroup [ Document ! Refresh @ Locator GO AddLink [ Delete = 0
Security View Co =X | 1t Status Security View
Bih “Molian * [Base ' ipen  okaown (3] Device Security LeveLHigh
30 result of fiter All" ~ o i icdong
eHign
| = coo SmESIIIIT @
10.81.10.11
Y | o S Taomortn g
10811012 e 4
. ] II EDS510E - ® @ @ Enable Trusted Access 9
[} I. ‘Smmg - ® @ @ Enable Auto Logout 9
T ‘ ) @ @ Enable DDoS Protection (]
e e i
\’\_\ . é ..Ena:le:&ccounﬁLug\nFalluve ©
B g SN TER L g
R R 3
;i/w = 4 I= = E::s;(‘coonnﬁgmauon File 9
-~ - N L -
4. To filter the devices in the Security View window by security level:
a. Click the Filter (E) icon.
b. Select the security level.
The Security View window filters the list of devices to only show devices that match the selected
security level.
5. To locate a device in the Topology Map, click the device in the Security View window.
High Medium Basic Open Unknown
3 results for "All .
192.168.127.1
g 192.168.127 1-ICMP Device
192.168.127.252
192.168.127.252--EDS-5054
- 192.168.127.253
g 192.168.127.253-EDS-508A
99
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The Security View details pane will appear on the right and the Topology Map highlights the circle
around the device.

it Status Security View

Device Security Level:High

@ Basic
@ Medium
@ High

Change Default Password / °
®®® syMP community String

Set SNMP Trap/Inform or Syslog
SO8® server 9

" @ @ @ Enable Trusted Access °

@ @ @ Enable Auto Logout
@ @ Enable DDoS Protection

Enable Password Complexity
e Strength Check

Enable Account Login Failure
®® | ockout

Disable Mon-encrypted TCP/UDP
®® poris

@ @ Set Login Message

Enable Configuration File °
® Encryption

6. View security details for a specific device by using one of the following methods:
> Select a device from the Topology Map.
» Select a device from the Security View window.

The Security View details pane will appear and displays the device security level and security-related
configuration statuses.

7. View the Security View Report:
Click Export to export the Security View Report in either CSV or PDF format.

Security View & = Bl X
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8. Review the following items in the Security View details pane:

Item Description

Enable Auto Logout Check if the Auto Logout function is enabled.

Check if both the Web Login Message and Web Login Fail Message
are configured.

Check if non-encrypted TCP/UDP Ports are disabled. HTTP, Telnet,
and Moxa Proprietary Protocol should be disabled. SNMP must be
set to V3 only.

Set Login Message

Disable Non-encrypted TCP/UDP
Ports

Enable Account Login Failure

Check if the Account Login Failure Lockout function is enabled.
Lockout

Check if the Trusted Access function is enabled or not. At least one
rule must be set.

Enable Password Complexity Check if the Password Complexity Strength Check function is
Strength Check enabled.

Check if the Configuration File Encryption function is enabled. At
least one rule must be enabled.

Check if Broadcast Storm Protection is enabled. For eCos switches,
MXview One checks whether Broadcast Storm Protection is
enabled. For EDR routers, MXview One checks whether at least
one form of DoS protection is enabled. For MXnos switches,
MXview One checks whether at least one of the following is
enabled: Broadcast, Multicast, or DLF protection.

Enable Trusted Access

Enable Configuration File Encryption

Enable DDoS Protection

Set SNMP Trap/Inform or Syslog
Server

Change Default Password/SNMP
Community String

Enable SSL/TLS High Secure Mode |[Check if the HTTPS is enabled and HTTP is disabled.

Check if the SNMP Trap/Inform or Syslog Server is set.

Check if the Default Password or SNMP Community String is set.

/7  NOTE

Users can use Security Wizard function in MXconfig to easily set the Security View status of devices.

9. To modify the colors used to indicate the security levels:
a. Navigate to Menu (E) > Administration > Preferences.
The Preferences screen will appear.
b. Under the Appearance section, expand Security View.
c. In the Colors for check result section, modify the color used to indicate a security level.

Security View ~

Profile

Built-in Profile ¥ Profile details [

Colors for check result

High Medium

I #77B800 B #o09DDB

Basic QOpen

[ #FA943E [] #cococo
d. Click Save.
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10. To define a custom security profile:
a. Navigate to Menu (E) > Administration > Preferences.
The Preferences screen will appear.
b. Under the Appearance section, expand Security View.
c. From the Profile drop-down list, select User defined.
The user-defined profile settings will appear.

Security View

Profile
User defined v

Colors for check result

. #77B800

Not Pass

#FA943E

Switch NPORTS5000A Device Server >

11|
T+

Check Item

[[] Enable Auto Logout

[C] SetLogin Message

d. (Optional) Modify the colors for the check result.

e. Click one of the following device tabs to configure the profile settings:
Switch

NPORT5000A

Device Server

Terminal Server

Gateway

Wireless

10

f. (Optional) Click the Settings (1_-5) icon to select a baseline.

g. Select the check box for each item you want to add to security profile.
h. Click Save.

[ I [ I [
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Configuring Severity Thresholds for Traffic and
Fiber Status Monitoring Events

MXview One allows you to configure the following traffic conditions on a link to trigger events:

e Bandwidth utilization is over the threshold.
e Bandwidth utilization is under the threshold.
e Packet error rate is over the threshold.
e Fiber Rx is under the threshold.
e Fiber Tx is under the threshold.
e Fiber temperature is over the threshold.
e Fiber voltage is under the threshold.
e Fiber voltage is over the threshold.
Since a link is bidirectional, the event will be triggered when the traffic condition in either direction satisfies
the configured severity threshold.
1. Navigate to Menu (E) > Topology.
The Topology screen will appear and display the Topology Map by default.
2. Click on a link between devices in the Topology Map.
The Link Properties pane and toolbar appear when a link is selected.

&P Link Traffic v X Severity Threshold @ Set Port Label B Delete

3. Click Severity Threshold.
The Severity Threshold screen will appear.

Severity Threshold
Bandwidth Utilization Packet Error Rate SFP Threshold
0 Warning -
0 Warning v
Cancel Apply
Severity Threshold
Bandwidth Utilization Packet Error Rate SFP Threshold
0 Warning ¥
Cancel Apply
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Severity Threshold

Bandwidth Utilization Packet Error Rate SFP Threshold
0 Warning v
0 | Warning -
0 | Warning v
0 Warning -

0 Warning -

Cancel

4. To trigger an event when the bandwidth utilization on a link exceeds a specified percentage:
Click the Bandwidth Utilization tab.
In the Over field, specify the maximum bandwidth utilization percentage.
c. From the adjacent drop-down list, select one of the following severity levels:
O Information
O Warning
O  Critical
5. To trigger an event when the bandwidth utilization on a link falls below a specified percentage:
Click the Bandwidth Utilization tab.
In the Under field, specify the minimum bandwidth utilization percentage.
c. From the adjacent drop-down list, select one of the following severity levels:
O Information
O Warning
O Critical
6. To trigger an event when the packet error rate exceeds a specified percentage:
Click the Packet Error Rate tab.
In the Over field, specify the maximum bandwidth utilization percentage.
c. From the adjacent drop-down list, select one of the following severity levels:
O Information
O Warning
O Critical
7. To trigger an event when the SFP Tx falls below a specific range:
Click the SFP Threshold tab.
In the SFP Tx Under field, specify the maximum Tx threshold in dB (0~-100)
c. From the adjacent drop-down list, select one of the following severity levels:
O Information
O Warning
O Critical
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8. To trigger an event when the SFP Rx falls below a specific range:
a. Click the SFP Threshold tab.
b. In the SFP Rx Under field, specify the maximum Rx threshold in dB (0~-100)
c. From the adjacent drop-down list, select one of the following severity levels:
O Information
O Warning
O  Critical
9. To trigger an event when the SFP voltage falls below a specific range:
a. Click the SFP Threshold tab.
b. In the SFP Voltage Under field, specify the maximum voltage in V (0~10)
c. From the adjacent drop-down list, select one of the following severity levels:
O Information
O Warning
O Critical
10. To trigger an event when the SFP voltage exceeds a specific range:
a. Click the SFP Threshold tab.
b. In the SFP Voltage Over field, specify the minimum voltage in V (0~10)
c. From the adjacent drop-down list, select one of the following severity levels:
O Information
O Warning
O  Critical
11. To trigger an event when the SFP temperature exceeds a specific range:
a. Click the SFP Threshold tab.
b. In the SFP Temperature Over field, specify the minimum temperature in Celsius (0~100)
c. From the adjacent drop-down list, select one of the following severity levels:
O Information
0O Warning
O  Critical
12. Click Apply.
MXview One will update the modified settings.
13. (Optional) Configure the Severity Threshold and Fiber status:
a. Navigate to Menu (E) > Administration > Global Device Settings.
The Global Device Settings screen appears.
b. To set the threshold, you can go to the sections below to complete the settings.
O Bandwidth Utilization
O Packet Error Rate
O SFP Threshold
c. Click Save.
MXview updates the web console protocol settings.

/  NOTE

If you complete the Bandwidth Utilization, Packet Error Rate, and SFP Threshold settings in the Global
Device Settings section, the settings will be implemented to all the devices in your topology.
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Configuring Custom Port Labels

MXview One uses the following port labelling convention to identify directions of traffic on a link.
<Device IP Address> / <Port Number>
You can use the Set Port Label screen to customize the port labels.

1. Navigate to Menu (E) > Topology.

The Topology screen will appear and display the Topology Map by default.
2. Click on a link between devices in the Topology Map.

The Link Properties pane and toolbar appear when a link is selected.

@B Link Traffic v X Severity Threshold B Set Port Label B Delete

3. Click Set Port Label.
The Set Port Label screen appears.

Set Port Label

[C] Use Custom Label

From:10.81.10.12 / Port 8

To:10.81.10.11 / Port 8

Cancel Apply

In the From field, provide a new label for the source port.

Select the Use Custom Label check box.

In the To field, provide a new label for the destination port.

N o u ok

Click Apply.
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9. SFP Fiber Status

Viewing the SFP Fiber Status in Table View

MXview One collects and display fiber status in SFP > SFP List

s Topology v @ Group v g Edit v (® Visualization v @z SFP v ’ Power v

Q SFP List

(&) Sync Threshold From the D..

The list shows Fiber TX, RX, temperature, and voltage of the cables that are connected.

SFP List
c Q, search
TX(dBm) RX(dBm) Temp. (°C) Volt. (V) TX (dBm) RX(dBm) Temp. (°C) Volt. (V)
10.81.10.12 10.81.10.11
-6.1 -6.3 421 3.3 -6 -5.9 43 33
Port 8 / SFP-1GSXLC Port 8 / SFP-1GSXLC
10.81.10.10 10.81.10.11
-6.3 -5.8 41.6 33 -6.2 -6.1 442 3.3
Port 8 / SFP-1GSXLC Port 9 / SFP-1GSXLC
10.81.10.12 10.81.10.13
-6 =0 43.7 38 =6:1 =6:2 40.7 3.4
Port 9 / SFP-1GSXLC Port 8 / SFP-1GSXLC
»
tems per page: 50 ¥ -30f3
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Synchronize the SFP Threshold From the
Device

MXview One can synchronize the threshold from devices, which can detect Moxa's SFP connector to get the
specific threshold.

Navigate to SFP > Sync Threshold From the Device

2 Topology v e Group v 2 Edit v ® Visualization v aZ SFP v ’ Power v
Q, i= SFPList

(&) Sync Threshold From the D..

Click Sync and the threshold from the devices will sync to the SFP Threshold of every link.

Sync the SFP Threshold From the Device

You can sync the SFP Threshold from Moxa's switch. After syncing, the
Temperature, Tx Power, and Rx Power of Fiber Check will be synced to
the SFP Threshold of every link.

on a link, then

Bandwidth Unilizat Packet Error Rate SFP Threshold

o Warning -

o ‘Warmning
o Warning -
o Waming
0 . Warmning

Are you sure you want to sync the SFP threshold from the device?
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10. Device Operation in the Topology

The MXview One Topology screen provides several features and tools for managing and maintaining
devices in your network topology.

Viewing the Device List

The List view on the Topology screen will display a list of discovered devices in your network topology.
You can also use this view to manually add devices to your network topology or export filtered data as a
CSV file.

MXview ©NE @english & admin¥
Root >
2/ it A O
- @ Q search
[] Device Alias Model Device IP MAC Address Firmware Version Location
[J 192168.123.72-AWK-1151C AWK-1151C 19216812372  00:90:E8:05717:45  v2.0 Build 2022_1007_1814
[J 192168.127.11-EDS-G516E EDS-G516E 19216812711  00:90EB:54E1E6 V6.3 build 23032200 Test
[J 192.168.127.12-EDS-G4008 EDS-G4008 19216812712  00:90:E&:8FFO18  v3.1 Build 2023_0217_1005 aa
D 192.168.127.13-EDS-408A EDS-408A 19216812713  0090E8:89F8:C2  V3.12 build 22101114 Switch Location
D 192.168.127.14-EDS-G512E-8FoE EDS-G512E-8PoE 19216812714  00:90E8:4D:A7:32 V6.2 build 20080519 Switch Location
TF 192.168.127.16-EDS-4012-8P-4GS EDS-4012-8P-4GS 192.168.127.16  00:90:E2:90:A5:6E  v2.2 Build 2023_0719_1007
7D 192.168.127.25-PT-G7728 PTG7728 19216812725 00:90:E&7171EAS V6.3 build 22120913 Switch Location
[0 192168.127.26-PT-G7728 PT-G7728 19216812726  00:90:E8:86:19:CD V6.3 build 22120913 Switch Location
|:| 192.168.127.27-PT-G7728 PT-G7728 19216812727 00:90:E8:8EF7:C6 V6.3 build 22120913 Switch Location
|:| 192.168.127.28-PT-G7828 PT-G7828 19216812728 00:90:E879:2382 V6.3 build 22120913 Switch Location
[] 192.168.127.29-PT-G7728 PTG7728 192.168.127.29  00:90:E8:99:E9:08 V6.2 build 21110316 Switch Location
[] 192.168.127.32-Hirschmann Hirschmann 192.168.127.32  00:80:63:83:82:80 Hirschmann MACH
[] 192.168.127.222-ICMP Device ICMP Device 192.168.127.222 00:E0:99:01:2A:68

1. Navigate to Menu (E) > Topology.

The Topology screen will appear and display the Topology Map in Topology view.
2. Click the List view (¥ icon in the top right corner.

The Topology screen displays a list of devices on your network.
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3. To add a device to your network topology:
a. Click Edit > Add Device.
The Add Device screen will appear.

Add Device

IP Address *

Assign Model *

SNMP Version *

Vi

public

Assign to Group * v
Port*

161

Password

Write Community

private

Authentication

Encryption Password

b. Configure the following:

O IP Address: Specify the IP address of the device
Assign Model: Select the model of the device

aoaogoooooaoa

c. Click Add.

Assign To Group: Select the group to assign the device to
SNMP Version: Select the SNMP version
Username: Specify the device login Username
Password: Create a password
Read Community: Specify the SNMP read community string
Write Community: Specify the SNMP write community string
Data Encryption: Select the data encryption method
Authentication: Select the authentication method
Encryption Key: Specify the encryption key

MXview One adds the device to the topology.

4. To delete devices in your network topology:

a. Check the box on the first column of devices.

b. Click the Delete (E) icon on the menu bar. The Delete Device screen appears.

c. For non AWK devices, read the message and then click Delete if you are sure you want to delete

the device.

Delete Device

Are you sure you want to delete this device?

MXview One 1.5.0 User Manual
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d. For AWK devices, read the message and wait for the countdown. Click Delete if you are sure you

want to delete the device.

Delete Device

A Confirmation of device(s) deletion

Historical data of deleted wireless client
device(s) will also be purged and affect
traceability of listed features. Do you want
to proceed?

* Wireless Roaming Playback

s Device Dashboard

Cancel

7

NOTE

If you click the check box for all the devices, when you click the Delete icon, you will delete all the devices

in the topology.

5. To view device properties, select the check box next to the Device Alias.

The Device Properties details pane will appear.

Device Properties Current Status

Basic Device Properties

Alias
EDS-510E

Model Name
EDS-510E

MAC Address
00:90:E8:86:2F:16

Availability
100.00%

System Description

EDS-510E-3GTXSFP

System Object ID
.1.3.6.1.4.1.8691.7.84

6. To filter the device list by severity level:

a. Click the Filter (¥) icon in the top left corner.

The Severity drop-down list appears.

X

Severity ¥

< Reset Apply
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7.

b. Select one of the following severity levels:

O Critical

O Warning

O Information
c. Click Apply.

MXview One filters the device list to only display devices with the selected severity level.
To export the device list:

a. Click the Export (E) icon.
= @

[0 | Exportcsv
M ~rentAsnans

b. Select Export CSV.
MXview One will export the displayed data as a CSV file.

Importing Device Configurations

Use the Topology screen to import an INI-formatted configuration file to a device in your network topology
by selecting the device from the Topology Map or Device List.

1. Navigate to Menu (E) > Topology.
The Topology screen will appear and display the Topology Map by default.
2. Select one of the following views:
» Topology view: Displays a graphical representation of devices in your network topology.
> List view: Displays a list of the devices in your network topology.
3. Select the device that you want to import configurations to:
» Topology view: Click the icon of the device in the Topology Map.
» List view: Select the check box next to the site name in the Device List.
The toolbar options change.
&, Device Configuration v X, Device Control v @ Cybersecurity Controls v [T Web Console [ Run Seript v / ChangeGroup ' Refresh  GD AddLink B PRP/HSRTags [ Delete
4. Navigate to Device Control > Import Config.
The Import Config screen appears and indicates the IP address of the selected device.
Import Config - 192.168.127.252
Import Config * 0O
The maximum file size is 1 MB
* Please make sure the username and password
for this device are correctly set in "Advanced
Settings”
Cancel
5. Click the folder () icon to upload the configuration file from your local machine.
6. Click Import.
MXview One imports the configuration file to the specified device.
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Exporting Device Configurations

Use the Topology screen to export an INI-formatted configuration file from a device in your network
topology by selecting the device from the Topology Map or Device List.
1. Navigate to Menu (E) > Topology.

The Topology screen will appear and display the Topology Map by default.
2. Select one of the following views:

> Topology view: Displays a graphical representation of the devices in your network topology.

> List view: Displays a list of the devices in your network topology.
3. Select the device that you want to export configurations from.

» Topology view: Click the icon of the device in the Topology Map.

» List view: Select the check box next to the device in the Device List.

The toolbar options change.

R, Device Configuraion v &, Device Control v Q) Cybersecurty Controls v [ WebConsole @] RunSeript v " ChangeGrowp (G Refiesh GO AddLik WD PRR/HSRTags [ Delete

4. Navigate to Device Control > Export Config.

The Export Config screen will appear and indicate the IP address of the selected device.

Export Config - 192.168.127.252

* Please make sure the username and password
for this device are correctly set in "Advanced

Settings"
5. Click Export.

MXview One exports the device configurations as an INI file in the specified location.
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Upgrading Firmware

Use the Topology screen to upgrade the firmware (ROM-formatted file) on a device in your network
topology by selecting the device from the Topology Map or Device List.

1.

5.

Navigate to Menu (E) > Topology.
The Topology screen appears and displays the Topology Map by default.
Select one of the following views:
> Topology view: Displays a graphical representation of the devices in your network topology.
b. List view: Displays a list of the devices in your network topology.
Select the device that you want to upgrade the firmware for:
» Topology view: Click the icon of the device in the Topology Map.
» List view: Select the check box next to the device in the Device List.
The toolbar options change.
R Device Configuration v &, Device Control v Q@) Cybersecurity Controls ~ £ WebConsole B RunSeript v ° ChangeGroup (3 Refresh GO AddLink M PRP/HSRTags
Navigate to Device Control > Upgrade Firmware.
The Upgrade Firmware screen appears and indicates the IP address of the selected device.

Upgrade Firmware - 192.168.127.252

Upgrade Firmware * O

* Please make sure the username and password
for this device are correctly set in "Advanced
Settings"

Cancel

Click the folder (M) icon to upload the ROM-formatted firmware file from your local machine.

6. Click Upgrade.

MXview One will upgrade the firmware on the specified device.

B Delete
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Configuring SNMP Trap Server

MXview One can collaborate with other network management software and send SNMP Traps to non-Moxa
NMS. MXview One supports up to two trap servers depending on the device.
1. Navigate to Menu (E) > Topology.

The Topology screen will appear and display the Topology Map by default.
2. Select one of the following views:

» Topology view: Displays a graphical representation of the devices in your network topology.

> List view: Displays a list of the devices in your network topology.
3. Select the device.

» Topology view: Click the icon of the device in the Topology Map.

» List view: Select the check box next to the device in the Device List.

The toolbar options change.

R Device Configuration v &, Device Control v Q) Cybersecurity Controls £ Web Console @ RunScript ' ChangeGroup (G Refresh GO AddLik BB PR/HSRTags [ Delete
4. Navigate to Device Configuration > Trap Server.

The Trap Server screen appears.

Trap Server

Destination IP1 *

10.82.10.6

Community Name1 *

public

Destination IP2 *

_ommunity Name2 *

public

Cancel

5. Configure the following SNMP trap server settings for the device:
> Destination IP1
> Community Namel
» (Optional) Destination IP2
» (Optional) Community Name2
6. Click Apply.
MXview One sends SNMP traps to the configured trap server(s) when events are detected on the device.

/7  NOTE

When a device fails to reply within seven seconds, MXview One will display the message "Failed to update
device Trap server settings." Please confirm the execution results via the same settings page or go to the
web page of the devices.
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Configuring Port Settings

Use the Topology screen to configure port settings for a device in your network topology by selecting the
device from the Topology Map or Device List.
1. Navigate to Menu (E) > Topology.

The Topology screen appears and displays the Topology Map by default.
2. Select one of the following views:

» Topology view: Displays a graphical representation of the devices in your network topology.

> List view: Displays a list of the devices in your network topology.
3. Select the device.

» Topology view: Click the icon of the device in the Topology Map.

» List view: Select the check box next to the device in the Device List.

The toolbar options will change.

R, Device Configuraion v &, Device Control v Q) Cybersecurty Controls v [ WebConsole @] RunSeript v " ChangeGrowp (G Refiesh GO AddLik WD PRR/HSRTags [ Delete

4. Navigate to Device Configuration > Ethernet/Fiber Port Settings.

The Ethernet/Fiber Port Setting screen appears.

Ethernet/Fiber Port Settings

Enabled v

*If the port settings fail, please go to device's web console by following
this path: Port = Port Settings to confirm whether the selected port can

be configured or not.

5. Configure the following port settings for the device:
> Port: Select the port number.
> Enable: Enable or disable the port.
> Port Description: Provide a description of the port.
>

Apply settings to another port: Select to apply the configured settings to other ports on the
device.

6. Click Apply.
MXview One will update the port settings to the device.
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Configuring SNMP Communication Protocol

Use the Topology screen to configure SNMP settings for a device in your network topology by selecting the
device from the Topology Map or Device List.
1. Navigate to Menu (E) > Topology.

The Topology screen appears and displays the Topology Map by default.
2. Select one of the following views:

» Topology view: Displays a graphical representation of the devices in your network topology.

> List view: Displays a list of the devices in your network topology.
3. Select the device.

» Topology view: Click the icon of the device in the Topology Map.

» List view: Select the check box next to the device in the Device List.

The toolbar options will change.

R Device Configuration v &, Device Control v Q) Cybersecurity Controls £ Web Console @ RunScript ' ChangeGroup (G Refresh GO AddLik BB PR/HSRTags [ Delete
4. Navigate to Device Configuration > SNMP Communication Protocol.

The SNMP Communication Protocol screen will appear.

SNMP Communication Protocol

V3 + 161

admin o
AuthPriv * SHA v
DES TR S S Q

5. Configure the following SNMP settings for the device:
SNMP Version

SNMP Port

Username

Password

Read Community

Write Community

Data Encryption

Authentication

Encryption Protocol

YV V.V V V V V V VYV VY

Encryption Password
6. Click Apply.
MXview One updates the SNMP communication protocol settings to the device.

/  NOTE

For the first time, users can use the Default Device Template function to set the function template. For
more information, see Changing Default SNMP Configuration.
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Configuring MXview One Polling Interval

Use the Topology screen to configure ICMP or SNMP polling settings for a device in your network topology
by selecting the device from the Topology Map or Device List.
1. Navigate to Menu (E) > Topology.

The Topology screen will appear and display the Topology Map by default.
2. Select one of the following views:

» Topology view: Displays a graphical representation of the devices in your network topology.

> List view: Displays a list of the devices in your network topology.
3. Select the device.

» Topology view: Click the icon of the device in the Topology Map.

» List view: Select the check box next to the device in the Device List.

The toolbar options change.

R Device Configuration v &, Device Control v Q) Cybersecurity Controls £ Web Console @ RunScript ' ChangeGroup (G Refresh GO AddLik BB PR/HSRTags [ Delete
4. Navigate to Device Configuration > MXview One Polling Interval.

The MXview One Polling Interval screen appears.

MXview One Polling Interval
10

60

5. Configure the following polling settings for the device:
» ICMP polling interval
» SNMP polling interval
6. Click Apply.
MXview One will update the polling settings for the device.

/7  NOTE

For the first time, users can use the Default Device Template function to set the function template. For
more information, see Default Device Template.
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Configuring Device Accounts

Use the Topology screen to configure advanced settings for a device in your network topology by selecting
the device from the Topology Map or Device List.
1. Navigate to Menu (E) > Topology.

The Topology screen will appear and display the Topology Map by default.
2. Select one of the following views:

> Topology view: Displays a graphical representation of the devices in your network topology.

> List view: Displays a list of the devices in your network topology.
3. Select the device.

» Topology view: Click the icon of the device in the Topology Map.

» List view: Select the check box next to the device in the Device List.

The toolbar options change.

R Device Configuration v &, Device Control v Q) Cybersecurity Controls £ Web Console @ RunScript ' ChangeGroup (G Refresh GO AddLik BB PR/HSRTags [ Delete

4. Navigate to Device Configuration > Device Accounts.

The Device Accounts screen appears.

Device Accounts

admin

o

5. Enter the Username and Password for the device web console.
6. Click Apply.
MXview One updates the advanced settings.
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Modifying the Device Alias

Use the Topology screen to configure advanced settings for a device in your network topology by selecting
the device from the Topology Map or Device List.
1. Navigate to Menu (E) > Topology.

The Topology screen will appear and display the Topology Map by default.
2. Select one of the following views:

> Topology view: Displays a graphical representation of the devices in your network topology.

> List view: Displays a list of the devices in your network topology.
3. Select the device.

» Topology view: Click the icon of the device in the Topology Map.

» List view: Select the check box next to the device in the Device List.

The toolbar options change.

R Device Configuration v &, Device Control v Q) Cybersecurity Controls £ Web Console @ RunScript ' ChangeGroup (G Refresh GO AddLik BB PR/HSRTags [ Delete
4. Navigate to Device Configuration > Device Alias.

The Device Alias screen appears.

Device Alias

192.168.127.14-EDS-G512E-8PoE

5. Edit the Alias field.
6. Click Apply.
MXview One updates the advanced settings.
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Changing the Device Icon

Use the Topology screen to change the device icon by selecting the device from the Topology Map or
Device List, and then upload a JPG, GIF, or PNG image file. You can change the icon for multiple devices at

once.
1. Navigate to Menu (E) > Topology.
The Topology screen will appear and display the Topology Map by default.
2. Select one of the following views:
» Topology view: Displays a graphical representation of the devices in your network topology.
> List view: Displays a list of the devices in your network topology.
3. Select the device(s).
» Topology view: Click the icon of the device in the Topology Map. To select multiple devices, click
and drag over the devices or CTRL + left-click the devices individually.
> List view: Select the check box next to the device(s) in the Device List.
The toolbar options will change.
W, Device Configuration X, Device Control v @ Cybersecurity Controls v () web Console & Run Script v /" ChangeGroup (3 Refresh GO AddLink W PRP/HSRTags [ Delete
4. Navigate to Device Configuration > Change Device Icon.
The Change Device Icon screen appears.
Change Device Icon
IP Address: 10.81.10.11
Model Icon * 0O [E
Cancel
5. Click the folder () icon to upload the device icon from your local machine. (The maximum image size
is 100 KB.)
6. Click Apply.

MXview One will change the device icon(s) to the uploaded JPG, GIF, or PNG image file.
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Signing on to Device Web Consoles

MXview One allows you to use the Topology screen to the web console for a device from the Topology
Map or Device List.

7

NOTE

You can use the Global Device Settings screen to configure the web console protocol. The web console
protocol can be set to HTTP or HTTPS, and then the port numbers of the HTTP and HTTPS can be set by
users.

(Optional) Configure the web console protocol:

a. Navigate to Menu (E) > Administration > Global Device Settings.

The Global Device Settings screen appears.

b. Find the Management Interface to complete the settings.

Management Interface

HTTP i

c. Configure the following:

0 Web Console Protocol

O HTTP Port
a HTTPS Port
d. Click Save.

MXview One updates the web console protocol settings.

NOTE

If you complete the Management Interface settings in the Global Device Settings section, the settings will
be applied to all the devices in your topology.

Navigate to Menu (E) > Topology.

The Topology screen will appear and display the Topology Map by default.

Select one of the following views:

» Topology view: Displays a graphical representation of the devices in your network topology.

> List view: Displays a list of the devices in your network topology.

Select the device.

» Topology view: Click the icon of the device in the Topology Map.

> List view: Select the check box next to the device in the Device List.

The toolbar options change.

W, Device Configuration X, Device Control v @ Cybersecurity Controls

Navigate to Web Console.

B web console

B Run script v

/" Change Group

The login screen for device web console appears in a new browser tab.

C Refresh

G2 Add Link

I PRP/HSR Tags

B Delete
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7/  NOTE

You may need to allow pop-ups on your web browser in order to view the device web console.

6. Enter the Username and Password for the device web console.

7. Click Login.
The device web console will successfully log in.

Managing and Running Scripts

The Run Script function allows you to quickly perform a set of actions on one or multiple devices at once.
You can run scripts on selected devices from the Topology or Device Management screen.

Click the Run Script ( E) icon in the menu bar to expand the script functions. There are two main
functions:

e Run CLI Script: Write and run a CLI script and test if the script works correctly.

Run Saved Script: Select and run a CLI Script from the Saved CLI Scripts database. Refer to the

Saved CLI Scripts section.

ﬂ Run Script ["

(=] Run CLI Script

B FRun Saved Script

Running a CLI Script

1. In the Topology or Device Management screen, select the device(s) to run the script on.

2. Click the Run Script ( H) icon in the menu bar and click Run CLI Script.
The Run CLI Script window will appear.

Run CLI Script

Selected Devices

Model

P Alias
192.168.127.12 192.168.127.12--EDS-G4008 EDS-G4008
192.168.127.16 192.168.127.16--EDS-4012-8P-4GS EDS-4012-8P-4GS -

4

Cancel

3. Enter the script:
a. In the CLI Script field, enter the CLI command(s) to execute.

b. Confirm the selected devices that the script will be executed on.

c. Click Run.
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4. The system will show the script execution status for each device.

Run CLI Script

A CLIExecution Results
If you leave this screen, you can download the execution results from Saved CLI Scripts > Execution Results.

FY
P Alias Model Status
192.168.127.12 192.168.127.12-EDS-G4008 EDS-G4008 In Progress ...
192.168.127.16 192.168.127.16-EDS-4012-8P-4GS EDS-4012-8P-4GS In Progress ... -
4 »

7/  NOTE

You cannot perform any actions on the device while the script is running. If you close the MXview One web
page, you can download the execution results from Saved CLI Scripts > Execution Results page.

5. Check the script results.

When all devices have finished running the script, click the Expand ( ") icon next to the device to

check the result.

Run CLI Script

show interfaces description -

-~
P Alias Model Status
192.168.127.12 192.168.127.12-EDS-G4008 EDS-G4008 Finished v
192.168.127.16 192.168.127.16-EDS-4012-8P-4GS EDS-4012-8P-4GS Finished v -
] »
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6. You can either run or save the script:

a. Run script: Modify the CLI script (if necessary) and click Run. The system will execute the CLI

script on the selected devices.

b. Save script: Click Save as a CLI Script to save the CLI script for future use.
The Save CLI Script window will appear.

Save CLI Script

Name *

Description *

show interfaces description

i Enter a name and description for the script.
The CLI Script field is read-only and cannot be modified here.

ii. Click Save. A confirmation message will appear.

New CLI script created successfully

Cancel

Back

iii. The CLI script will be stored and shown in the Saved CLI Scripts section.

Saved CLI Scripts

A scheduled Script

Automation Buttons

You can create scheduled tasks to run CLI scripts at a specified date and time from the Administration > Maintenance Scheduler page.

Name
< |IREL
B Vs reload-task
7 reload-task-new

O # W Imerface description

Description Linked Scheduled Tasks

eload-description

reload-description-new

‘Show interface description

Q Seal

Linked Script Automations

ff_cli-btn, same_cli_btn1

diff_cli-btn, same_cli_btn2
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Running a Saved CLI Script

1. In the Topology or Device Management screen, select the device(s) to run the script on.

2. Click the Run Script (E) icon in the menu bar and click Run Saved Script.
The Run Saved Script window will appear.

Run Saved Script
Select a CLI Script -
Q, Search
CLI Script Name Description

O Interface description  Show interface description

-

4 »

Cancel b

If no saved scripts can be found, the following message will appear.

Run Saved Script

ﬂ 'No CLI scripts found. Add a CLI script first from Saved CLI Scripts”

;
Close

Click the Add a CLI Script to create a script. Refer to Adding a CLI Script.

3. Select the script you want to execute and confirm the selected devices that the script will be executed
on.
You can modify the script if necessary.

Run Saved Script

Select a CLI Script

CLI Script Name Description

@ Interface description Show interface description

show interfaces description

Selected Devices

P Alias Model
192.168.127.12 192.168.127.12-EDS-G4008 EDS-G4008
192.168.127.16 192.168.127.16-EDS-4012-8P-4GS EDS-4012-8P-4GS =
4 4
Cancel m
4. Click Run.
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5. The system will show the script execution status for each device.

Run CLI Script

192.168.127.12

192.168.127.16

A CLI Execution Results
If you leave this screen, you can download the execution results from Saved CLI Scripts > Execution Results.

Alias

192.168.127.12-EDS-G4008

192.168.127.16-EDS-4012-8P-4GS

Model

EDS-G4008

EDS-4012-8P-4GS

Status

In Progress ...

In Progress ...

/ NOTE

You cannot perform any actions on the device while the script is running. If you close the MXview One web

page, you can download the execution results from Saved CLI Scripts > Execution Results page.

6. Check the script results

When all devices have finished running the script, click the Expand ( ") icon next to the device to

check the result.

Run Saved Script

A CLIExecution Results

192.168.127.12

Result

Interface AdminStatus

Eth1/1 down
Eth1/2 down
Eth1/3 down
Ethi/4 up
Eth1/s down
Eth1/6 down
Eth1/7 up
Eth1/8 up

192.168.127.16

P Alias

192.168.127.12-EDS-G4008

OperStatus Description
doun

doun

doun

up

doun

doun

up

up

192.168.127.16-EDS-4012-8P-4GS

Model

EDS-G4008

EDS-4012-8P-4GS

If you leave this screen, you can download the execution results from Saved CLI Scripts > Execution Results

Status

Finished

Finished

Fs
~
-~
v
A
v
v
»
Close

L 4
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Changing Device Groups

Use the Topology screen to change the assigned group for a device by selecting the device from the
Topology Map or Device List.
1. Navigate to Menu (E) > Topology.

The Topology screen will appear and display the Topology Map by default.
2. Select one of the following views:

» Topology view: Displays a graphical representation of the devices in your network topology.

> List view: Displays a list of the devices in your network topology.
3. Select the device.

» Topology view: Click the icon of the device in the Topology Map.

» List view: Select the check box next to the device in the Device List.

The toolbar options change.

R, Device Configuraion v &, Device Control v Q) Cybersecurty Controls v [ WebConsole @] RunSeript v " ChangeGrowp (G Refiesh GO AddLik WD PRR/HSRTags [ Delete
4. Click Change Group.

The Change Group screen will appear and displays the following information:

Change Group

Root -

IP Address

10.81.10.10

10.81.10.11

10.81.10.12

10.81.10.13

10.81.10.14

10.81.10.15

10.81.10.16

10.81.10.17

1'a 00000 O

5. (Optional) Select additional IP addresses to assign other devices from the current group to the new
group.

6. From the Assign to Group drop-down list, select the new group that you want to assign the selected
device(s) to.

7. Click Apply.
MXview One will assign the selected device(s) to the new group.
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Refreshing the Device Status

Since some device data is collected by polling, there may be a time delay for some data. Use the Topology
screen to refresh the device status by selecting the device from the Topology Map or Device List.
1. Navigate to Menu (E) > Topology.

The Topology screen appears and displays the Topology Map by default.
2. Select one of the following views:

» Topology view: Displays a graphical representation of the devices in your network topology.

> List view: Displays a list of the devices in your network topology.
3. Select the device.

» Topology view: Click the icon of the device in the Topology Map.

» List view: Select the check box next to the device in the Device List.

The toolbar options change.

R Device Configuration v &, Device Control v Q) Cybersecurity Controls [ Web Console @ RunScript ' ChangeGroup (G Refresh GO AddLik BB PRP/HSRTags [ Delete
4. Click Refresh.

MXview One polls the device for updated data.

Deleting Devices

Use the Topology screen to delete devices from the Topology Map. After a device is deleted, it will be
removed from the topology map and the device will not be polled.
1. Navigate to Menu (E) > Topology.

The Topology screen appears and displays the Topology Map by default.
2. Select one of the following views:

» Topology view: Displays a graphical representation of the devices in your network topology.

> List view: Displays a list of the devices in your network topology.
3. Select the device.

» Topology view: Click the icon of the device in the Topology Map.

> List view: Select the check box next to the device in the Device List.

The toolbar options will change.

R, Device Configuration v X, Device Control v Q& Cybersecurity Controls v (1] Web Console [ Run Script v 7 ChangeGroup (3 Refresh GO AddLink W PRP/HSRTags [ Delete
4. Click Delete.

MXview One removes the device from your network topology.
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11.

Device Management

The Device Management feature lets users perform certain functions directly from within MXview One,
without having to enter the device’s web console. This feature covers two sections: Configuration and

Control and Account and Password.

The Device Configuration and Control section provides quick access buttons to quickly execute
commonly used device management functions. Users can perform these functions either from the menu bar
on the Topology screen, or directly from the Configuration and Control page.

The Account and Password section allows administrators to check device accounts and perform account

and default password audits.

Configuration and Control

Configuration and Control Overview

To access the Configuration and Control page, in the function tree, navigate to Menu (E) > Device

Management> Configuration and Control.

At the top of this screen is the menu bar which provides quick access buttons for device management

functions. At the bottom part of the page is the device list which allows users to select the devices to

perform the quick function on.

The quick access functions are organized into four main types:

e Device Configuration

e Device Control

e  Cybersecurity Controls
e Run Script

= MXview ONE

@ Select Device

Q. Type keyword to search &, Device Configuration A, Device Control @8 Cybersecurity Controls

Dashboard =

Topology
[] Device Alias
Device Discovery

EomrrrD Pl O 1oziesazaT0-AwK3z52A

e [] 192168.123.152-EDS-518A

Saved CLI Scripts

[ 192168.123.157-IEX-402-SHDSL
Firmware Management

[ 192168.127.2-A88

Device Configuration Center

Event Management

Notification Management

Inventory Management
Integration
Administration

Help

Wiodel

AWK-3252A

EDS-G516E

EDS-518A

EX-402-5HDSL

488

1B Run Script

Device IP

192.168.123.70
132.168.123.151
192.168.123.152
192.168.123.157

192.168.127.2

MAC Address

00:90:E8:00:04:12

00:90:E8:44:52AE

00:90:E8:00:00:55

00:90:E8:D1:02:10

00:21:C1:56:30:91

Firware Version

w2.0 Build 2023 0217_1145

V6.2 build 20080519

V3.9 build 21110513

V1.0 buikd 12112311

Refer to the following section for an overview of all functions in each category.

@ english

2 adminvy

Location

NSD Lab ab

NSD Lab lalala

NSD Lab
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Device Configuration

Change Wi-Fi Channel

If the performance of your wireless devices is affected by interruptions in the current Wi-Fi channel, you can
use the Change Wi-Fi Channel function to switch to another channel to improve performance.

Navigate to Menu (E) > Device Management> Configuration and Control.
2. Select the device(s) to configure from the device list.

= MXview ©ONE
@ Select Operation

‘\ Device Configuration v A Device Control v
Device Alias

192.168.3.16-AWK-1161C

192.168.3.65-AWK-1165A

O 0O O m

192.168.123.72-AWK-1151C

192.168.123.73-AWK-4252A

’T]] 192.168.127.25-PT-G7728

e Cybersecurity Controls v

Model

AWK-1161C

AWK-1165A

AWK-1151C

AWK-4252A

PT-G7728

3. From the Device Configuration drop-down list, select Change Wi-Fi Channel.
The Change Wi-Fi Channel screen will appear.

= MXview ©ONE

@ select Operation

l\ Device Configuration v X Device Control v

%3 Change WiFi Channel

3 Add Wi-Fi SSID

[0 192.168.3.16-AWK-1161C
[0 192.168.3.65-AWK-1165A
[0 192.168.123.72-AWK-1151C

192.168.123.73-AWK-4252A

>’:| 192.168.127.25-PT-G7728

@ Cybersecurity Controls v

Model

AWK-1161C

AWK-1165A

AWK-1151C

AWK-42524

PT-G7728

4. Modify the Wi-Fi channel settings.

@english 8 adminy
B Run script v B web Console
Q search

Device IP MAC Address Firmware Version Location
192168316  Q09OEB:11:61:02  v2.0 Build 2023 04170232 a
192.1683.65  0090E8:11:6549  v2.0 Build 2023 0418_1026
192.168.123.72  0090:EB:05:17:45  v2.0 Build 2023_0217_1145
192.168.123.73  00:90:EB:9D:CAFE
192.168.127.25  0090:E871:1EA5 V6.3 build 22120013 Switch Location

@cEnglish & admin¥

Location

B8 Run Script v = Web Console
Q search
Device IP MAC Address Firmware Version
192168316  00:90:EE11:61.C2  v2.0 Build 202304170232 a

192.168.3.65 00:90:E8:11:65:49

192.168.123.72  00:90:E8:05:17:45

192.168.123.73  00:90:E8:9D:C4:FE

192.168.127.25  00:90:E8:71:1EAS V6.3 build 22120913

v2.0 Build 202304181026

v2.0 Build 2023_0217_1145

Switch Location

Change Wi-Fi Channel

192.168.123.73

2.4G 56

Channel Channel

1 36

113 36-196

Channel Widtt Channel Widtt

20 MHz -  20/40 MHz -
P

Alias

192.168.123.73-AWK-4252A

Model

AWK-4252A

Cancel Change

Channel

Desc

Enter the channel for the 2.4 GHz and 5 GHz band.

2.4 GHz: 1to 13
5 GHz: 36 to 196

Channel Width

Select the width of the channel.

2.4 GHz: 20 MHz, 20/40 MHz
5 GHz: 20 MHz, 20/40 MHz,
20/40/80 MHz
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5. When finished, click Change. The system will execute the action.

Change Wi-Fi Channel

192.168.123.73

192.168.123.73-AWK-4252A

6. If successful, a confirmation will be shown in the Status column.

Change Wi-Fi Channel

P

192.168.123.73

If unsuccessful, check the error description in the Status column to identify the issue. Click Retry

Alias

192.168.123.73-AWK-4252A

Failed Devices to perform the action again.

Change Wi-Fi Channel

P

192.168.3.16

192.168.3.65

Add Wi-Fi SSID

Use the Add Wi-Fi SSID function to create additional Wi-Fi SSIDs for your wireless environment.

192.168.3.16-AWK-1161C

192.168.3.65-AWK-1165A

Model Status

AWK-4252A In Progress ...
Model Status
AWK-4252A Finished

Model

AWK-1161C

AWK-1165A

Status

Failed(Login fa

Failed(Login fa

Cancel Retry Failed Devices

ilure)

ilure)

1. Navigate to Menu (E) > Device Management > Configuration and Control.

2. Select the device(s) to configure from the device list.

= MXview ONE

@ select Operation

'\ Device Configuration v

O 0 0O o

<]

Device Alias

192.168.3.16-AWK-1161C

192.168.3.65-AWK-1165A

192.168.123.72-AWK-1151C

192.168.123.73-AWK-4252A

192.168.127.25-PT-G7728

.’~. Device Control v

Model

AWK-1161C

AWK-11654

AWK-1151C

AWK-42524

PT-G7728

e Cybersecurity Controls v

B8 Run script v
Device IP MAC Address
192168316 00:00:E8:1161:02

192.168.3.65

192.168.123.72

192.168.123.73

192.168.127.25

00:90:E8:11:65:49

00:90:E8:05:17:45

00:90:E8:9D:C4:FE

00:90:E8:71:1E:AS

BD web Console

Q search

Firmware Version

v2.0 Build 2023_0417_0232
v2.0 Build 2023_0418_1026

v2.0 Build 2023_0217_1145

V6.3 build 22120913

Location

a

Switch Location

Close

@Engiish
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3. From the Device Configuration drop-down list, select Add Wi-Fi SSID.
The Add Wi-Fi SSID screen will appear.

= MXview ©ONE @engish & admin¥

@ select Operation

9, Device Configuration v A Device Control v @ cybersecurity Controls B Rrun script v BT web Console

“Z3 Change Wi-Fi Channel Q, search
“a Add Wi-FiSsID
Model Device IP MAC Address. Firmware Version Location
192.168.3.16-AWK-1161C AWK-1161C 192.168.3.16 00:90:E8:11:61:C2  v2.0 Build 2023_0417_0232 a
ild
[0 192.168.3.65-AWK-1165A AWK-1165A 192.168.3.65 00:90:E8:11:65:49  v2.0 Build 2023_0418_1026
192.168.123.72-AWK-1151 AWK-1151 192.168.1 :90:E8:05:17:4. V! uil 3.0217_114:
92.168.123.72- 51C 51C 92.168.123.72  00:90:E8:05:17:45 2.0 Build 2023_0217. 5
192.168.123.73-AWK-4252A AWK-4252A 192.168.123.73  00:90:E8:9D:C4:FE
> b 192.168.127.25-PT-G7728 PT-G7728 192.168.127.25  00:90:E8:71:1E:A5 V6.3 build 22120913 Switch Lacation

4. Modify the Wi-Fi SSID settings.

Add Wi-Fi SSID
Clear All Existing SSID
Disabled -
RF Band
SSID * 2.4 GHz >
Open -
1P Alias Model
192.168.123.73 192.168.123.73-AWK-4252A AWK-4252A

Cancel

Clear All Existing SSIDs

|Description
Enabled or Disabled Choose to keep or delete all existing SSIDs on the selected device(s).
SSID
Setting Description |
SSID Name Enter a name for the SSID.
RF Band
Setting Description |
2.4 GHz, 5 GHz Select the RF band for this SSID.

|Description

Select the security mode for the SSID.

WPA/WPA2 Mixed
WPA2/WPA3 Mixed

When using any security mode other than Open, configure the following settings:

WPA Mode

|Description
Personal Authenticate WPA, WPA2, or WPA3 with a Pre-shared key (PSK).

Protected Management Frame
Setting |Description
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Disabled

Disable the protected management frame. This option is not available when using
WPA3.

802.11w Use the 802.11w protocol as the protected management frame.

Encryption

Setting |Description |
AES

Use Advance Encryption System (AES) encryption.

TKIP/AES Mixed

Use TKIP/AES Mixed encryption. This option provides a TKIP broadcast key and
TKIP+AES unicast key to support legacy AP clients. This option is rarely used and is
not available when using WPA3.

EAPOL Version

8 to 63 characters

Setting Description |
1 Use EAPOL Version 1 as the security authentication method.

2 Use EAPOL Version 2 as the security authentication method.

Passphrase

Setting |Description |

Enter the passphrase. This is the master key to generate keys for encryption and
decryption.

5. When finished, click Add. The system will execute the action.

Add Wi-Fi SSID

P

192.168.123.73

Alias Model Status

192.168.123.73-AWK-4252A AWK-4252A In Progress ...

6. If successful, a confirmation will be shown in the Status column.

Add Wi-Fi SSID

P

192.168.123.73

Alias Model Status

192.168.123.73-AWK-4252A AWK-4252A Finished

Close

If unsuccessful, check the error description in the Status column to identify the issue. Click Retry
Failed Devices to perform the action again.

Add Wi-Fi SSID
P Alias Maodel Status
192.168.123.73 192.168.123.73-AWK-4252A AWK-4252A Failed(Maximum number of SSIDs: 9)

Cancel Retry Failed Devices

Dynamic Sticky MAC

Use the Dynamic Sticky MAC function to configure Dynamic Sticky MAC settings for one or multiple
selected devices at once.

1. Navigate to Menu (E) > Device Management > Configuration and Control.
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2.

3.

Select the device(s) to configure from the device list.

= MXview ONE

@ select Operation

'\ Device Configuration

8 0O 0O 0 b

Device Alias

192.168.3.16-AWK-1161C

192.168.3.65-AWK-1165A

192.168.123.72-AWK-1151C

192.168.123.73-AWK-4252A

192.168.127.25-PT-G7728

A Device Control v

e Cybersecurity Controls v m Run Script v ED web Console

Q search
Model Device IP MAC Address Firmware Version
AWK-1161C 192.168.3.16 00:90:E8:11:61:C2  v2.0 Build 2023_0417_0232 a
AWK-11654 192.168.3.65 00:90:E8:11:65:49  v2.0 Build 2023_0418_1026
AWK-1151C 192.168.123.72  00:90:E8:05:17:45  v2.0 Build 2023_0217_1145
AWK-4252A 192.168.123.73  00:90:E8:9D:C4FE
PT-G7728 192.168.127.25  00:90:E8:71:1E:A5 V6.3 build 22120913

Location

Switch Location

From the Device Configuration drop-down list, select Dynamic Sticky MAC.

The Dynamic Sticky MAC screen will appear.

@Engiish

2 admin¥

= MXview ©ONE

W, Device Configuration

£ Dynamic Sticky MAC |

@ select Operation

-]
O
O
O
O
>
k

Device Alias

192.168.3.16-AWK-1161C

192.168.3.65-AWK-1165A

192.168.123 . 72-AWK-1151C

192.168.123.73-AWK-4252A

192.168.127.25-PT-G7728

X Device Control

@ Cybersecurity Controls v B Rrun script v

Model Device IP MAC Address
AWK1161C 192.168.3.16 00:90:E8:11:61:C2
AWK1165A 192.168.3.65 00:90:£8:11:65:49
AWK-1151C 192.168.123.72  00:90:E8:05:17:45
AWK-4252A 192.168.123.73  00:90:E8:9D:C4:FE
PT-G7728 192.168.127.25  00:90:E8:71:1E:AS

N web Console

Q search

@english L adminy ‘

Firmware Version

Location

v2.0 Build 202304170232 a

v2.0 Build 2023_0418_1026

v2.0 Build 2023_0217_1145

v2.0 Build 2023_0217_1145

V6.3 build 22120913

Switch Location

NOTE

You can only select devices with the same port format (either non-modular or modular device) and the

same number of ports to execute the Dynamic Sticky MAC function. For example, you can set multiple
non-modular switches at the same time, but not non-modular and modular switches. Because non-
modular switch and modular switches have different port formats. An error message will appear if the

selection is incompatible.

A Models must have the same port format and number of ports.
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4. Click the Add ( ) icon and configure the following settings:

Dynamic Sticky MAC

0 Port Name Key

PT-G7728
Port 0/1 0/2 0/3 0/4 11 1/2 1/3 1/4 211 2/2 2/3 2/4 3/1 3/2 3/3
On-
Device 1 2 3 4 1-1 1-2 13 1-4 21 22 23 24 31 32 33
Web Ul
e._______________________________________________________________J] »

Sticky MAC Settings

ticky MAC Address Limit
B Alias >  Port ~  Enabled \

Drop Packet -

Cancel

Alias

i Description
Device Alias Select the device(s) to configure Sticky MAC settings for.
Port

|Description

Port Select the port(s) associated with the device for which to configure the Sticky MAC
settings for. You can refer to the Port Name Key section at the top of the page to
understand the correlation between the ports listed in the Port drop-down menu and
the on-device web UI.

Sticky MAC

|Description
Enable or disable the Sticky MAC function for the selected port(s).

Enabled or Disabled

Address Limit

Setting |Description |
1to 1013 Specify the maximum numbers of the learned MAC addresses.

Security Action

Setting Description |
Shutdown Port Shut down the port if a violation occurs.

Drop Packet Drop the packet if a violation occurs.

5. When finished, click Apply. The system will execute the action.

Dynamic Sticky MAC

P Alias Model Status

192.168.127.25 192.168.127.25-PT-G7728 PT-G7728 In Progress ...
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If successful, a confirmation will be shown in the Status column.

Dynamic Sticky MAC

P Alias Model Status

192.168.127.25 192.168.127.25-PT-G7728 PT-G7728 Finished

Close

If unsuccessful, check the error description in the Status column to identify the issue. Click
Failed Devices to perform the action again.

Dynamic Sticky MAC
P Alias Model Status
192.168.127.25 192.168.127.25-PT-G7728 PT-G7728 Failed(Login failure)

Cancel Retry Failed Devices

Serial Port Monitoring

Retry

/0

NOTE

This function is only supported by the NPort 6000 Series and NPort 6000-G2 Series.

Navigate to Menu (E) > Device Management > Configuration and Control.

Select the NPort 6000 Series or NPort 6000-G2 Series device(s) to configure from the device list.

= MXview ONE Deroren

@ Sselect Operation

\ Device Configuration v ,‘L Device Control v e Cybersecurity Controls v ﬂ Run Script v B0 web console

Q search
B Device Alias Model Device IP MAC Address Firmware Version Location
192.168.4.246~NPort-6150 NPort-6150 192.168.4.246 00:90:E8:0E:79:3A 2.2 Build 22110116
O 192.168.4.247-NPort-6150 NPort-6150 192.168.4.247 00:90:E8:65:.C3:4F 2.2 Build 22110116
[0 192.168.127.35-EDR-G9010 EDR-G9010 192.168.127.35  00:90:E8:91:86:82  V3.13.99 build 24110411 Device Location
O 192.168.127.69-NPort-6450 NPort-6450 192.168.127.69  00:90:E8:12:FA:42  1.21 Build 21053111

From the Device Configuration drop-down list, select Serial Port Monitoring.
The Serial Port Events screen will appear.
= MXview ONE @engish

@ select Operation

9, Device Configuration v &, Device Control v @ Cybersecurity Controls v [ RunScript v [ Web Console

- admin¥

2 admin¥

ﬂ Serial Port Monitoring Q, Search
B Device Alias Model Device IP MAC Address Firmware Version Location
192.168.4.246-NPort-6150 NPort-6150 192.168.4.246 00:90:E8:0E:79:3A 2.2 Build 22110116
[0 192.168.4.247-NPort-6150 NPort-6150 192.168.4.247 00:90:E8:65:C3:4F 2.2 Build 22110116
[0 192.168.127.35-EDR-G9010 EDR-G9010 192.168.127.35  00:90:E8:91:86:82  V3.13.99 build 24110411 Device Location
D 192.168.127.69-NPort-6450 NPort-6450 192.168.127.69  00:90:E8:12:FA:42  1.21 Build 21053111

In the Event Trigger Rules section, configure the event trigger rules.
To add an event trigger rule:

Use the Serial Port Monitoring function to configure event trigger rules for triggering serial port events.
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a. Click the Add () icon and configure the following settings:

Serial Port Events

Event Trigger Rules (1/64)
Event Type * Trigger Threshold Severit

Seral Port * E pe
All Ports ~  Any Serial Error Count ~ 1 Warning -

1-10000 Count(s
Cancel

O Serial Port: Select the device port(s) to apply the event trigger rule to.
O Event Type: Select the rule event property.

O No Data Period: If the Event Type is set to RX Inactivity, TX Inactivity, or TX & RX Inactivity,
specify the duration the port does not transmit or receive data before triggering a no data
event.

O Trigger Threshold: If the Serial Port Properties to any Error Count type, specify the number
of consecutive error counts the serial can receive before triggering an error event.

O Severity: Select the event severity for this rule.

b. (Optional) If there are other devices of the model type in the topology, use the Condition Copy
option to copy the event trigger rules to these devices.

c. Click Apply.

/ NOTE

MXview One supports a maximum of 64 event trigger rules. Different rules cannot have identical Serial
Port and Event Type settings.

6. To delete an event trigger rule:

a. Click the Delete (.) icon next to the rule you want to delete.

7. When a serial port event is triggered, a yellow triangle icon will appear the above affected devices in the
Topology screen. Click the device icon to show the event list.

= MXview ONE @ English & admin ~
Root
9, Device Configuration & Deviee Conrol v Q) Cybessecurlty Centrol ~ B cecutecu v BN Web Consale # Change Group C Refresh = [ ]
Q
S S S N\
Serial Port Error Status v
1921681272 192168127.3 1921681274

1921680275
The T of serial port 1 did not receive any
data in last 10 minutes
How to resolve?

The RX of sevial port 1 did not receive any
data in last 10 minutes:
How to resolve?

The TX & RX of serial port 1 did not receive
any data in last 10 minutes.

Honw {6 resnlve?

Serial Port 1 received an eror: Eror Counter
Qvernun.

How 10 resolve?
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8. Click the How to resolve? link to open a pop-up window with step-by-step instructions to

issue.

resolve the

Still not working?

Resolve Serial Port 1 Issue

If you have further questions, contact your channe! partner first.
Contact Moxa Technical Support if you still need additional support.

Try these steps to resolve the “Serial port {{port}} has not transmitted and received any data in the last {imin}} minutes” issue,

1. Check if the serial cable is properly cennected to the Moxa device and the serial end devices,
2. Check if the connected serial device(s) are working properly.

Device Control

Reboot

Close
Use the Reboot function to manually reboot devices or configure a reboot schedule.
1. Navigate to Menu (E) > Device Management > Configuration and Control.
2. Select the device(s) to configure from the device list.
MXview ONE @english
@ Select Operation
W, Device Configuration v &, Device Control v | Cybersecurity Controls ~ (8 Runseript v ] web Console
Q search
B Device Alias Model Device IP MAC Address Firmware Version Location
[0 192.168.3.16-AWK-1161C AWK-1161C 192.168.3.16 00:90:E8:11:61:C2  v2.0 Build 2023 0417_0232 a
[0 192.168.3.65-AWK-1165A AWK-1165A 192.168.3.65 00:90:E8:11:65:49  v2.0 Build 2023_0418_1026
D 192.168.123.72-AWK-1151C AWK-1151C 192.168.123.72  00:90:E8:05:17:45  v2.0 Build 2023_0217.1145
192.168.123.73-AWK-4252A AWK-4252A 192.168.123.73  00:90:E8:9D:CAFE
’—]] 192.168.127.25-PT-G7728 PT-G7728 192.168.127.25 00:90:E8:71:1E:A5 V6.3 build 22120913 Switch Location

3. From the Device Control drop-down list, select Reboot.
The Reboot screen will appear.

= MXview ONE

Q Type keyword to search

Dashboard

Topology

Device Discovery

Saved CLI Scripts

Firmware Management
Device Configuration Center
Event Management
Notification Management

Reports

Integration

Administration

Help

@ select Operation

=
O
O
O
O

W, Device Configuration

Device Alias

102.168.123.72~

192.168.127.12-

192.168.127.14-

192.168.127.16-

192.168.127.25-

192.168.127.26-

192.168.127.27-1

192.168.127.28-

192.168.127.29-

192.168.127.31-

A Device Control v

() Reboot

-AWK-1151C

EDS-G4008

EDS-G512E-8PoE

EDS-4012-8P-4GS

PT-G7728

PT-G7728

PT-G7728

PT-G7828

PT-G7728

PT-G503

Model

AWK1151C

EDS-G4008

EDS-G512E-8PoE

EDS-4012-8P-4GS

PT-G7728

PT-G7728

PT-G7728

PT-G7828

PT-G7728

PT-G503

@ Cybersecurity Controls v B8 Run Script v

Device IP MAC Address

192.168.123.72  00:90:E8:05:17:45

192.168.127.12  00:90:E8:8F:F0:18

192.168.127.14  00:90:E8:4D:A7:32

192.168.127.16  00:90:E8:90°:A5:6E

192.168.127.25  00:90:EB:71:1EAS

192.168.127.26  00:90:E8:86:19:CD

192.168.127.27  00:90:E8:8EF7:C6

192.168.127.28  00:90:E8:79:23:82

192.168.127.29  00:90:E8:99:E9:08

192.168.127.31  00:90:E8:00:02:65

Firmware Versien

v2.0 Build 2023_0217_1145

¥3.1 Build 2023_0217_1005

V6.2 build 20080519

¥3.2 Build 2023_0719_1007

V6.3 build 22120913

V6.3 build 22120913

V6.3 build 22120913

V6.3 build 22120913

V6.2 build 21110316

V5.3 build 23090110

Location

aa

Switch Location

Switch Location

Switch Location

Switch Location

Switch Location

Switch Location
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4. Configure the reboot sequence and execution time.

Reboot

Smart Sequential v
Order P Alias Model
1 192.168.127.29 192.168.127.29-PT-G7728 PT-G7728
2 192.168.127.31 192.168.127.31-PT-G503 PT-G503

Cancel Add to Scheduler Reboot

a. Select the reboot sequence:

O Strict Sequential: Reboot the devices based on the device sequence in the topology starting
from the device furthest away from the computer running MXview One, proceeding to the
nearest one.

O Smart Sequential: Reboot the devices based on the device sequence in the topology but
simultaneously reboot all devices in the same topology layer.

b. Select an execution time:
O Reboot: Click Reboot to restart the devices instantly.

O Add to Scheduler: Click Add to Schedular to create a new scheduled task. MXview One will
reboot the devices based on the specified time and date in the schedule.

5. To reboot devices instantly, click Reboot. The system will execute the action.

Reboot
P Alias Model Status
192.168.127.29 192.168.127.29-PT-G7728 PT-G7728 In Progress ...
192.168.127.31 192.168.127.31-PT-G503 PT-G503 In Progress

6. If successful, a confirmation will be shown in the Status column.
If unsuccessful, check the error description in the Status column to identify the issue. Click Retry
Failed Devices to perform the action again.

Reboot
P Alias Model Status
192.168.127.29 192.168.127 29-PT-G7728 PT-G7728 Finished
192.168.127.31 192.168.127.31-PT-G503 PT-G503 Failed(Connection failure)

Cancel Retry Failed Devices

Create Snapshot

Use the Snapshot function to create a snapshot of the current configuration. The snapshot can be used to
restore the configuration later.

1. Navigate to Menu (E) > Device Management > Configuration and Control.
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2.

'\ Device Configuration

Select Operation

A Device Control v e Cybersecurity

B Device Alias Model

[0 192.168.3.16-AWK-1161C AWK-1161C

[0 192.168.3.65-AWK-1165A AWK-11654

O 192.168.123.72-AWK-1151C AWK-1151C

192.168.123.73-AWK-4252A AWK-4252A
192.168.127.25-PT-G7728 PT-G7728

3.

Controls v

Device IP

192.168.3.

192.168.3.

192.168.123.72

192.168.123.73

192.168.127.25

The Create Snapshot screen will appear.

= MXview ONE

@ select Operation

Qype keyword to search & Device Configuration X, Device Control v/

@ Cybersecurity Controls

38

54008

EDS-408A

EDS-G512E-8POE

EDS-4012.8P-4GS

PT.G7728

PT-G7728

PT.G7728

PT-G7628

PT.G7728

Hirschmann

SDS-G3008

ICMP Device

V2406C (Windows)

uc12224

192.168.127.5-ABB
Dashboard m O Reboot
192.168.127.11-EQS OF-G516E
Topology O [ Create Snapshot
Device Discovery e
0 1921681271205 ™ Restore from Snapshot
Device Management
[ 192168.127.13-EDSH0BA
saved CLI Scripts
[J 192.168.127.14-EDS-G512E-8PoE
Firmware Management
e e inpme o Gt D 192.168.127.16-EDS-4012-8P-4GS
Event Management [J 192168.127.25-PT-67728
Notification Management B 192168.127.26-PT67728
Reports
] 192168.127.27-PT-G7728
Integration
[J 192168.127.28-PT-67828
Administration
Help D 192.168.127.29-PT-G7728
[] 192.168.127.32-Hirschmann
[] 192.168.127.33-SDS-G3008
[ 192.166.127.222-1CMP Device
[J 192.168.127.223-V2406C (Windows)
192.168.128.12-UC-1222A

192.168.128.22-UC-22224T

<]

4. Configure the execution time.

Create Snapshot

192.168.128.12

192.168.128.22

Uc-22224T

Al

192.168.128.12-UC-1222A

Select the device(s) to configure from the device list.

MXview ©ONE

B Rrun script v

MAC Address
16 0090E811:61:02
65 00:90:E811:65:49

00:90:E8:05:17:45
00:90:E8:9D:C4:FE

00:90:E8:71:1E:AS

B Run Seript »

192.168.127.5  0021¢1568bb7

192168.127.11  009DESS4ETES
192.168.127.12  0090EBBFFO18
192162.127.13  0090ES:BOFEC2
192.168.127.14  00:90E8:4D:AT:32
192.168.127.16  009DEB:00ATGE
192.168.127.25  009DES71:1EAS
192.168.127.26  00:90EB:86:19:CD
192168.127.27  009DESBEF7.CE
192.168.127.28  0090E8:79:23:82
192168.127.20  009DEB:99:EQ08
192.168.127.32  00:80:63:83:82:80

192.168.127.33  00:90E8:00:00:00

192.168.127.222  00ED:99:01:2468

192.168.127.223  0090E8:89:9C49
19216812812 009DES:00FAFA
19216812822 0090EB:00:FB:56
as

ED web Console

Q se

Firmware Version

V6.3 build 22120913

From the Device Control drop-down list, select Create Snapshot.

V6.3 build 23032200
V3.1 Build 2023_0217_1005
V3.12build 22101114

V6.2 build 20080519

@Engiish

2 admin¥

arch

Location

v2.0 Build 2023_0417_0232 a

v2.0 Build 2023_0418_1026

v2.0 Build 2023_0217_1145

Switch Location

Test

£

Switch Location

Switch Location

V3.2 Build 2023_0719_1007

V6.3 build 22120913

V6.3 build 22120913

V6.3 build 22120913

V6.3 build 22120913

V6.2 build 21110316

192.168.128.22-UC-2222A-T

> Create: Click Create to create a snapshot instantly.

Switch Location
Switch Location
Switch Location
Switch Location
Switch Location

Hirschmann MACH

Custorizable feld (configure
Jusr/share/snmp/snmpd local conf)

Gustomizable feld (configure
Justshare/snmp/snmpd.Jocal conf)

Madel

UC-1222A

UC-2222A-T

Add to Scheduler

Cancel

> Add to Scheduler: Click Add to Schedular to create a new scheduled task. MXview One will create
a snapshot based on the specified time and date in the schedule.
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5. To create a snapshot instantly, click Create. The system will execute the action.

Create Snapshot
P Alias Model Status
192.168.128.12 192.168.128.12-UC-1222A UC-12224 In Progress ..
192.168.128.22 192.168.128.22-UC-2222A-T UC-2222A-T In Progress ..

6. If successful, a confirmation will be shown in the Status column.
If unsuccessful, check the error description in the Status column to identify the issue. Click Retry
Failed Devices to perform the action again.

Create Snapshot

P Alias Model Status
192.168.128.12 192.168.128.12-UC-1222A uc-1222a Finished
192.168.128.22 192.168.128.22-UC-2222A-T UC-2222A-T Failed(Login failure

Cancel Retry Failed Devices
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Restore From Snapshot

Use the Restore from Snapshot to restore the configuration from a previously created snapshot.

1. Navigate to Menu (E) > Device Management > Configuration and Control.

2.
= MXview ©ONE

@ Sselect Operation

* Device Configuration v X, Device Control v G Cybersecurity

B Device Alias Model

[0 192.168.3.16-AWK-1161C AWK-1161C

[0 192.168.3.65-AWK-1165A AWK-11654

[0 192.168.123.72-AWK-1151C AWK-1151C

192.168.123. 73-AWK-4252A AWK-4252A
’T’] 192.168.127.25-PT-G7728 PT-G7728

3.

Select the device(s) to configure from the device list.

Controls v [ Run Script v
Device IP MAC Address
192168316 00:00:E8:11:61:C2

192.168.3.65 00:90:E8:11:65:49

192.168.123.72  00:90:E8:05:17:45
192.168.123.73  00:90:E8:9D:C4:FE

192.168.127.25  00:90:E8:71:1E:AS

The Restore from Snapshot screen will appear.

= MXview ONE

@ select Operation

LU IR &, pevice Configuration R, Device Control v

192.168.127.5-ABB

() Reboot

Dashboard

Topology 192.168.127.11-f

Device Discovery

O
O
[m]
[m)
[m]
O
(]

19216812712 605" 15 Restore from Snapshot

192.168.127.13-EDSA08A

Saved CLI Scripts
192.168.127.14~EDS-G51 2E-8Pok
Firmware Management
192.168.127.16-EDS-4012-8P-4G5
Device Gonfiguration Genter
Event Management 192.168.127.25-PT-67728
Notification Management 192.168.127.26-PT-G7728
Reports

192.168.127.27-PT-67728

Integration
102.168.127.28-PT.67528
Administration

192.168.127.29-PT-67728
Help

192.168.127.32-Hirschmann

192.168.127.222-1CMP Device

192.168.127.223-V2406C (Windows)

[m]
O
[}
[] 192168.127.33-SDS-G3008
O
[m]

102.168.128.12-UC-12224

102.168.128.22-UC-2222AT

4. Configure the execution time.

Restore from Snapshot

192.168.128.12

192.168.128.22

@ Cybersecurity Controls

B Run Script v

38 192.168.127.5 0021¢1569bb7

192.168.127.11 00:90:E8:54E1E6

G400 192168.127.12  00S0E8SFFO1E
EDS-408A 192168.127.13  00:90:E8:89:F8:.C2
EDS-G512E-8PoE 192168.127.14  00:90:E8:4D:A7:32
EDS-4012-8P-4GS 192.168.127.16  00:90:E8:90:A5:6E
PT-G7728 192168.127.25  00:90:E871:1EAS
PT-G7728 192168.127.26  00:90:E8:86:19:CD
PT-G7728 192168.127.27  00:90:E8:8EF7:C6
PT-G7828 192168.127.28  00:90:E8:79:23:82
PT-G7728 192.168.127.29  00:90:E8:99:E9:08
Hirschmann 192168.127.32  00:80:63:B3:82:80
SDs-G3008 192.168.127.33  00:90:E8:00:00:00
ICMP Device 192168.127.222 00:E0:99:01:2A:68
V2406C (Windows) 192.168.127.223 00:90:E8:89:9C:49
uc1z22a 192168.128.12  00:90:E8:00:FAFA
UC-2222AT 192168.12822  00:90:E8:00:FB:56

Alias

192.168.128.12-UC-1222A

192.168.128.22-UC-2222A-T

> Restore: Click Restore to restore the snapshot instantly.

> Add to Scheduler: Click Add to Schedular to create a new scheduled task. MXview One will

T Web Console

2 admin'¥

@engiish

Q search

Firmware Version

V6.3 build 22120913

V6.3 build 23032200

Location

v2.0 Build 2023_0417_0232 a

v2.0 Build 2023_0418_1026

v2.0 Build 2023_0217_1145

Switch Location

From the Device Control drop-down list, select Restore from Snapshot.

Test

va.1 Build 202302171005 a2

V3.12build 22101114

V6.2 build 20080519

Switch Location

Switch Location

V3.2 Build 2023_0719_1007

V6.3 build 22120913
V6.3 build 22120913
V6.3 build 22120913
V6.3 build 22120913

V6.2 build 21110316

Cancel

Switch Location
Switch Location
Switch Location
Switch Location
Switch Location

Hirschmann MACH

Customizable feld (configure
Just/share/snmp/snmpd Jocal conf)
Customizable feld (configure

Jusr/share/snmp/snmpd local conf)

Model

uc-1222A

UC-2222A-T

Add to Scheduler

restore the snapshot based on the specified time and date in the schedule.
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5. To restore the snapshot instantly, click Restore. The system will execute the action.

Restore from Snapshot

IP Alias
192.168.128.12 192.168.128.12-UC-1222A
192.168.128.22 192.168.128.22-UC-2222A-T

Model Status
uc-12224 In Progress ..
UC-2222A-T In Progress ..

6. If successful, a confirmation will be shown in the Status column.

If unsuccessful, check the error description in the Status column to identify the issue. Click Retry

Failed Devices to perform the action again.

Restore from Snapshot

P Alias
192.168.128.12 192.168.128.12-UC-1222A
192.168.128.22 192.168.128.22-UC-2222A-T

Cybersecurity Controls

Sticky MAC On/Off

Use the Sticky MAC On/Off function to enable or disable Sticky MAC for the selected device(s).

Model Status
UC-1222A Finished
UC-2222A-T

Cancel Retry Failed Devices

Failed(Login failure)

1. Navigate to Menu (E) > Device Management > Configuration and Control.
2. Select the device(s) to configure from the device list.

= MXview ONE
@ select Operation

\K Device Configuration v _’\_ Device Control v
Device Alias

192.168.123.72-AWK-1151C

192.168.127.14-EDS-G512E-8PoE

2

[m]

192.168.127.12-EDS-G4008
m]

[0 192.168.127.16~EDS-4012-8P-4GS
O

192.168.127.25-PT-G7728

e Cybersecurity Controls v

Model

AWK-1151C

EDS-G4008

EDS-G512E-8PoE

EDS-4012-8P-4GS

PT-G7728

Device IP

192.168.123.72

192.168.127.12

192.168.127.14

192.168.127.16

192.168.127.25

n Run Script v

MAC Address

00:90:E8:05:17:45

00:90:E8:8F:F0:18

00:90:E8:4D:A7:32

00:90:E8:90:A5:6E

00:90:E8:71:1E:A5

B web Console

Firmware Version

v2.0 Build 2023.0217.1145

v3.1 Build 2023_0217_1005

V6.2 build 20080519

v3.2 Build 2023_0719_1007

V6.3 build 22120913

@ enalish

Location

aa

Switch Location

Switch Location
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3. From the Cybersecurity Controls drop-down list, select Sticky MAC On/Off.
The Sticky MAC On/Off screen will appear.

= MXview ONE

© Sselect Operation

QTYPE keyword to search \ Device Configuration v A Device Control v e Cybersecurity Controls v n Run Script v E]

Dashboard [] 192.168.127.4-ABB Sticky MAC On / Off 00:21:01:50:52:95

Topology > . .
[J 192.168.127.5-ABB Relearn Dynamic Sticky MAC 00:21:C1:56:98:87

Device Discovery

192.168.127.11-EDS-G516E Q) Disable Unused Ethernetan..  op.00:£6:54£1 6
) 192.168.127.12-EDS-GA008 X1 Disable Insecure HTTP and .. gp.ap£8:8F:F0:18

Saved CLI Scripts
Firmware Management 192.168.127.13-EDS-408A EDS-408A 192.168.127.13  00:90:E8:89:F8:C2
Device Configuration Center [0 192.168.127.14-EDS-G512E-8PoE EDS-G512E-8PoE 192.168.127.14  00:90:E8:4D:A7:32

4. Choose to enable or disable Sticky MAC.

Sticky MAC On / Off

Enabled

P Alias Model

192.168.127.12 192.168.127.12-EDS-G4008 EDS-G4008

Cance' m

5. Click Apply. The system will execute the action.

Sticky MAC On / Off
P Alias Model Status
192.168.127.12 192.168.127.12-EDS-G4008 EDS-G4008 In Progress ...

6. If successful, a confirmation will be shown in the Status column.

Sticky MAC On / Off
P Alias Model Status
192.168.127.12 192.168.127.12-EDS-G4008 EDS-G4008 Finished

Close

If unsuccessful, check the error description in the Status column to identify the issue. Click Retry
Failed Devices to perform the action again.
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Relearning Dynamic Sticky MAC

Use the Relearn Dynamic Sticky MAC function to reset all previously learned MAC addresses and relearn
them again for the selected device(s).

Navigate to Menu (E) > Device Management > Configuration and Control.
2. Select the device(s) to configure from the device list.

. MXview ONE @english 2 admin¥Y

© Select Operation
\\ Device Configuration v _’\_ Device Control v e Cybersecurity Controls v m Run Script v B web Console
-
B Device Alias Model Device IP MAC Address Firmware Version Location
O 192.168.123.72-AWK-1151C AWK-1151C 192168.123.72  00:90:E8:05:17:45  v2.0 Build 2023.0217.1145
192.168.127.12-EDS-G4008 EDS-G4008 192.168.127.12  00:90:E8:8F:F0:18  v3.1 Build 2023_0217_1005 aa
[0 192.168.127.14~EDS-G512E-8PoE EDS-G512E-8PoE 192.168.127.14  00:90:E8:4D:A7:32 V6.2 build 20080519 Switch Location
[0 192.168.127.16~EDS-4012-8P-4GS EDS-4012-8P-4GS 192.168.127.16  00:90:E8:90:A5:6E  v3.2 Build 2023_0719_1007
[ 192.168.127.25-PT-G7728 PT-G7728 192.168.127.25 00:90:E8:71:1E:A5 V6.3 build 22120913 Switch Location

3. From the Cybersecurity Controls drop-down list, select Relearn Dynamic Sticky MAC.
The Relearn Dynamic Sticky MAC screen will appear.

= MXview ONE

© Select Operation

QTVPE keyword to search ‘\ Device Configuration v )\ Device Control v e Cybersecurity Controls v n Run Seript v /|

Dashboard 0] 192.168.127.4-ABB Sticky MAC On / Off 00:21:C1:50:52:95

Topology > . .
[J 192.168.127.5-ABB Relearn Dynamic Sticky MAC 0:21:C1:56:9B:87

Device Discovery

Device Management

Saved CLI Scripts

192.168.127.11-EDS-G516E ) Disable Unused Ethernetan...  oo.90.E5:54£1:E6
192.168.127.12-EDS-G4008 I Disable Insecure HTTPand . gg.9p.£8:8FF0:18
Firmware Management 192.168.127.13-EDS-408A EDS-408A 192.168.127.13  00:90:E8:89:F8:C2
Device Configuration Center O

192.168.127.14-EDS-G512E-8PoE EDS-G512E-8PoE 192.168.127.14  00:90:E8:4D:A7:32

4. Click Relearn. The system will execute the action.

Relearn Dynamic Sticky MAC

P Alias Model

192.168.127.12 192.168.127.12-EDS-G4008 EDS-G4008

ca " ce'

5. If successful, a confirmation will be shown in the Status column.

Relearn Dynamic Sticky MAC

P Alias Model Status

192.168.127.12 192.168.127.12-EDS-G4008 EDS-G4008 Finished

Close

If unsuccessful, check the error description in the Status column to identify the issue. Click Retry
Failed Devices to perform the action again.

Disable Unused Ethernet and Fiber Ports

Use the Disable Unused Ethernet and Fiber Ports function to disable any unused Ethernet or fiber ports
to make sure these ports cannot be exploited to gain unauthorized access to the device.
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1.
2.

3.

4.

5.

Navigate to Menu (E) > Device Management > Configuration and Control.
Select the device(s) to configure from the device list.

= MXview ONE

@ select Opseation
U ype keyword 1o search 9, Device Configuration A, DeviceControl v @ Cybersecurity Controls v [ Fun Script v

Dashboard
Topohiy
B Device Alias Madél Dirvice IP WAL Addreds Fieminane Vi Location
] 192168.123.72-AWK1 151G ANENIEIC WZ16812372 OO9DERDSITAS V20 Buld 2022 1007_1814
| 192168127 1-4CMP Device IEMP Device 1921681271 O0DOERSIBED4
oo B 152160127 11-EDSG516E EDSGS16E 15216812711 OOSOEBSSETES V63 buld 23032200 Test
Dawvice Confl
B 152168127 12-E05-54008 EDS-G4008 15218812712 OOSOERAFFONE 37 Bulld 202302171008 &
. 192168, 127 13-E054084 EDS-2084 192.168.127.13  009OEEBESFECZ VI 12buld 22701114 Switch Location
‘|
[ 192168127 14-ED5 651 2E-8P0E EDS-G512E-8P0E WL16B1I714  OO9UERADATIZ V6T build 20080519 Switch Location
192168, 127 16-E05-4012-8P-455 EDE-301 2-8P-455 15216802716 00POERSOASEE 3.2 Build 202307191007
162 168127 25-PT.67728 PRGTTIE 19216812725  0090EETIIEAS Ve 3buld 22120913 Switch Location

From the Cybersecurity Controls drop-down list, select Disable Unused Ethernet and Fiber Ports.
The Disable Unused Ethernet and Fiber Ports screen will appear.

= MXview ONE

@ select Operation

Q Type keyword to search * Device Configuration XA Device Control v @ Cybersecurity Controls v B Run Script v

Dashboard [] 192.168.127.4-ABB @ Disable Unused Ethernetan.. 4 00.21:61:50:52:95

Topology .
[J 192.168.127.5-ABB X1 Disable Insecure HTTPand .. 15 go.01.c1:56:96:87

Device Discovery

Device Management

Saved CLI Scripts

192.168.127.11-EDS-G516E EDS-G516E 192.168.127.11  00:90:E8:54:E1E6

192.168.127.12-EDS-G4008 EDS-G4008 192.168.127.12  00:90:E8:8F:F0:18

Choose to keep ports with temporary inactivity active.

Disable Unused Ethernet and Fiber Ports

Keep in-use ports with temporary outage active

P Alias Model
192.168.127.11 192.168.127.11-EDS-G516E EDS-GS16E
192.168.127.12 192.168.127.12-EDS-G4008 EDS-G4008

Cancel Disable Unused Ports

Click Disable Unused Ports. The system will execute the action.

Disable Unused Ethernet and Fiber Ports

IP Alias Model Status
192.168.127.11 192.168.127.11-EDS-G516E EDS-G516E In Progress ...
192.168.127.12 192.168.127.12-EDS-G4008 EDS-G4008 In Progress ...

If successful, a confirmation will be shown in the Status column.
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Disable Unused Ethernet and Fiber Ports

192.168.127.11

192.168.127.12

If unsuccessful, check the error description in the Status column to identify the issue. Click Retry

Alias

192.168.127.11-EDS-G516E

192.168.127.12-EDS-G4008

Failed Devices to perform the action again.

Disable Insecure HTTP and Telnet Console

Model Status
EDS-G&16E Finished
EDS-G4008 Finished

Close

Use the Disable Insecure HTTP and Telnet Console function to disable the non-secure HTTP and Telnet

connection interfaces.

1. Navigate to Menu (E) > Device Management > Configuration and Control.

2. Select the device(s) to configure from the device list.

@ select Opseation

= MXview ©ONE
Q. Type keyword to search aQ
Dashboard
Topology
=2

Device Discovery

Device Management

Saved CL Scripts

Integration

Adminisiration

3. From the Cybersecurity Controls drop-down list, select Disable Insecure HTTP and Telnet

Console.

Device Alias

] 19R168.123 TZ-AWK1 1510
] 192.168.127.1-4CMP Device
B 192168127 11-EDS-GH16E

B 192168127.12-ED5 54008

192168127 13-E05-4084

192 168,127 14-EDS-G5126-8P0E

192168127 16-EDS-4012-8P-465

192168127 25-FT.67728

Model

AWRAISIC

IEMP Device

EDG-GSIGE

EDS-G4008

E05-2084

EDS-G51 2E-BPoE

EDS-4012-8P-455

PRETTIE

192.168.1

152.168.1

152168

2372

27.1

2

152168127

152.168.127

192.168.127.

152.168.127

1521681

DUICEBDS TS

0090ERST 8664

00SOERSLETES

O0S0EREFFOIS

O0IDEEENFECT

D0VCERADAT I

0090 ERSOASEE

O0IOEETIIEAS

Firmeare Version

V2.0 Bulld 2022 1007_1814

V&3 build 23032200

w31 Bulld 2023 02171008

V312 buld 2101112

V6.2 busld 20080519

3.2 Bulld 2023 07191007

V3 buld 22120913

The Disable Insecure HTTP and Telnet Console screen will appear.

= MXview ONE

Q Type keyword to search

Dashboard
Topology

Device Discovery

Saved CLI Scripts

Device Management

@ Select Operation

\ Device Configuration

192.168.127.4-ABB

O
[] 192.168.127.5-ABB

X Device Control v

192.168.127.11-EDS-G516E

™ 192.168.127.12-EDS-G4008

@ Cybersecurity Controls v

Test

a8

Switch Location

Switch Lecation

Switch Location

Run Script v

) Disable Unused Ethernetan.. +;  00.01.01:50:52:05

N Disable Insecure HTTP and ...

5 00:21:C1:56:9B:B7

EDS-G516E

EDS-G4008

192.168.127.11  00:90:E8:54:ET:E6

192.168.127.12  00:90:E8:8F:F0:18
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4. Click Disable HTTP and Telnet. The system will execute the action.

Disable Insecure HTTP and Telnet Console

IP Alias Model
192.168.127.11 192.168.127.11-EDS-G516E EDS-G516E
192.168.127.12 192.168.127.12-EDS-G4008 EDS-G4008

If successful, a confirmation will be shown in the Status column.

Disable Insecure HTTP and Telnet Console

IP Alias Model Status
192.168.127.11 192.168.127.11-EDS-G516E EDS-G516E Finished
192.168.127.12 192.168.127.12-EDS-G4008 EDS-G4008 Finished

Close

If unsuccessful, check the error description in the Status column to identify the issue. Click Retry
Failed Devices to perform the action again.

Run Script

Refer to the Managing and Running Scripts section.

Account and Password

Account Management Overview

To access the Account Management page, in the function tree, navigate to Menu (E) > Device
Management > Account and Password and go to the Account Management tab.

The Account Management tab shows an overview of all user accounts on each device.
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= MXview ONE

Account and Password Management Automation

Account Management Passviord Automation Account Audit Default Password Audiit
Account Information
Click the 'Refresh button to retrieve the account information for all devices. This may take some time.
(=]

| Device Alias Compatible

&, 192168.123.70-AWK-32524
O &,  192168.123.151-EDS-G516E
£, 192168.123.152-EDS-5184
&,  192168.123.157-[EX-402-SHDSL

A 192.168.127.2-ICMP Device

Mo

Mo

Mo

Temporary Accounts

Madel

AWK-3252A

EDS-G516E

EDS-5184

|EX-402-SHDSL

ICMP Device

This page displays the following information in a table format:

@ English

2 adminy

Q, Search
Device IP Accounts
192.168.123.70 even,v3useradmin
192.168.123.151 adminTest even,aaaa,admin,aaaab
192.168.123.152 N/A
192.168.123.157 N/ A
192.168.127.2 N/A

Column |Description

Device Alias The unique name of the device.

Compatible Shows if the device supports MXview One retrieving account information.
Model The device model name.

Device IP The IP address of the device.

Accounts The list of accounts associated with the device. Under certain conditions, the

following statuses can show:

¢ Unable to retrieve accounts: The device supports this feature, but
MXview One was unable to successfully retrieve account information from

the device.

¢ N/A: MXview One cannot retrieve account information because the device

does not support this feature.

Click Refresh at the top of the page to update the account information in the table.

Editing Accounts on a Device

/7  NOTE

This function is only available for compatible devices. If the device is incompatible, this function will be

greyed out.

1. Navigate to Menu (E) > Device Management > Account and Password.

2. Go to the Account Management tab.
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[
3. Click the Edit (""" ) icon next to the device account you want to edit.
The Account Management window will appear.

Account Management

Change Default "Admin® Name -

Cancel

4. To change the default admin account credentials:
a. Select Change Default "Admin'' Name as the operation.
b. Specify the new username and password.
c. Click Change.
5. To add an account:
a. Select Edit Account as the operation.
b. Select the Add Account radio button.
c. Specify the username, password, and authority of the account.
d. Click Add.
6. To delete an account:
a. Select Edit Account as the operation.
b. Select the Delete Account radio button.
a. Enter the username of the account you want to delete.
b. Click Delete.

Password Automation Overview

To access the Account Management page, in the function tree, navigate to Menu (E) > Device
Management > Account and Password and go to the Password Automation tab.

The Password Automation tab shows an overview of all user accounts on each device.
= MXview ©ONE @english 2 adminv

Account and Password Management Automation

Account Management Password Automation Account Audit Default Password Audit Temporary Accounts

Password Automation
Last Executed: N/A

Managed Devices

& Device Alias Model Device IP Applicable Accounts

This page displays the following information in a table format:
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Column |Description

Device Alias The unique name of the device.

Model The device model name.

Device IP The IP address of the device.

Applicable Accounts Shows the device accounts that the password automation functions are applied
to.

Running the Password Automation Wizard

Navigate to Menu (E) > Device Management > Account and Password.
Go to the Password Automation tab.
In the Password Automation section, click Start Wizard.

W N

When prompted, verify your MXview One account.
The Password Automation Wizard screen will appear.

Password Automation Wizard

@ e 3] 4] 5]

Verify Email Recipient Select Devices Set Password Complexity Apply Password to Devices Send Password Ema

Verify Account and Password Email Recipient(s)

Close

5. Enter the 1st and 2nd recipient email addresses and click Verify Email.
MXview One will send a verification code to these addresses.

6. Enter the verification code in the Wizard to continue.
If you have not received an email, check your Spam folder or confirm the Email Server Configuration
settings in MXview One.

Password Automation Wizard

Verify Email Recipient

Verify Account and Password Email Recipient(s)

A 1f you have not received the email with the verification code, check your spam folder or verify the Email Server Configuration[

Verification code expires in: 9:34

Close
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7. Select the device(s) to generate a randomized password for and click Next.

Password Automation Wizard
© 2]
Verify Email Recipient Select Devices Set e Ar ces Sel d Emai
Select the device(s) to generate a randomized password for.
[] Device Alias Compatible Model Device IP Applicable Accounts :
10.123.35.195~ICMP Device No ICMP Device 1012335195  N/A
192.168.123.70-AWK-3252A Yes AWK-3252A 192.168.123.70  eveny3useradmin
192.168.123.151-EDS-G516E Yes EDS-G516E 192.168.123.151 adminTesteven,azaa,admin,aaaab
192.168.123.152-EDS-518A No EDS-518A 192.168.123.152 N/A
192.168.123.157~EX-402-SHDSL No IEX-402-SHDSL 192168123157 N/A
192.168.127.2-ICMP Device No ICMP Device 1921681272 N/A
Close

8. Specify the randomized password length and click Next.
MXview One will generate a random password of the specified length containing:

> At least one digit (0-9).
» Mixed upper and lowercase letters (A-Z, a-z).
> At least one special character (~!@#%$%2N&*-_|;:,.<>[1{}())

Password Automation Wizard

@ @ (5] o
A S

Verify Email Recipient Select Devices Set Password Complexity Apply Password to Devices Sen

MXview One will generate the random password for the selected devices.

A\ Make the password length is within the maximum allowed password length on the device(s).

At least one digit (0-9): Enabled
Mixed upper and lower case letters (A-Z, a-z): Enabled
At least one special character (~1@#5%"8&*_|;.<>[1{}()): Enabled

Glose m

9. MXview One will start generating new passwords for the selected devices.

Password Automation Wizard

© © © o e

Verify Email Recipient Select Devices Set Password Complexity Apply Password to Devices Send Password Ema
Device Alias Model Device IP Status
192.168.127.11-EDS-G516E EDS-G516E 192.168.127.11 In progress ...

10. When finished, MXview One will send the device account and password information to the email
recipients specified at the beginning of the Wizard.
Users will receive two emails. One email containing the account information and execution results and
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another email containing the string to unzip the account information file.

Password Automation Wizard

Fin oy 2 ey
© = © © 5]
Werify Email Recipient Select Devices Set Password Complexity Apply Password to Devices Send Password Email

MXview One has sent the device account, password, and execution result to the following email recipient(s):

Close

11. Click Close.

12. The table will show all the devices and associated accounts that password automation is applied to.
= MXview ONE @engish & admin¥

Account and Password Management Automation

Account Management Passwerd Automation Account Audit Default Password Audit Temporary Accounts
Password Automation Password Automation Schedule
Last Executed: 2024-07-23 PM 5:04:43

Next Scheduled for: 2024-10-21 AM 3:00:00

=

j] Managed Devices

%0 AM 3:00 -

Qsearch

Device Alias Model Device IP Applicable Accounts

192.168.127.11-EDS-G516E EDS.G516E 192.168.127.11 admin

/  NOTE

Click Start Over to run the Password Automation Wizard again.

Regenerating Device Passwords

/7  NOTE

This function is only available after completing the Password Automation Wizard at least once. Refer to
Running the Password Automation Wizard.

Navigate to Menu (E) > Device Management > Account and Password.
Go to the Password Automation tab.
In the Password Automation section, click Regenerate Password.

LN

When prompted, verify your MXview One account.
The Regenerate Password screen will appear.

Regenerate Password

MXview One will use the following settings to
generate a new password for each device.

Password Strength
Random Password Length: &

Password Email Recipient
1st Email: I
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5. Click Regenerate.

MXview One will generate a new password for all applicable devices.

Regenerate Password

Device Alias Model Device IP Status

192.168.127 11-EDS-G516E EDS-G516E 192.168.127.11 In progress .

6. Click Send Password Email to receive an email with the new randomized passwords to the recipients

specified in the Password Automation Wizard.

Regenerate Password
Device Alias Model Device [P Status
192.168.127.11-EDS-G516E EDS-GS16E 192.168.127.11 Finished

Send Password Email

Resending the Password Email

7

NOTE

This function is only available after completing the Password Automation Wizard at least once. Refer to
Running the Password Automation Wizard.

Navigate to Menu (E) > Device Management > Account and Password.
Go to the Password Automation tab.
In the Password Automation section, click Resend Password Email.

Ll A

When prompted, verify your MXview One account.
The Resend Password Email screen will appear.

Resend Password Email

Are you sure you want to resend the device
password to the following recipient(s)?

1st Email:

5. Click Resend.
MXview One will send an email with the device account credentials to the recipients specified in the

Password Automation Wizard.

Resend Password Email

MXview One has sent the device account and password file to the
following email address(es):

1st Email:

Close

Configuring a Password Automation Schedule

With the password automation schedule function, you can configure a specific interval at which MXview One
will generate new randomized passwords for all applicable devices.

MXview One 1.5.0 User Manual 155



/  NOTE

This function is only available after completing the Password Automation Wizard at least once. Refer to
Running the Password Automation Wizard.

1. Navigate to Menu (E) > Device Management > Account and Password.
2. Go to the Password Automation tab.

3. In the Password Automation Schedule section, configure the following settings:
Password Automation Schedule

a0 AM 3:00 -

» Interval: Select the interval (in days) at which MXview One will randomize device passwords.

> Start Time: Specify the day of time when MXview One will execute the password automation.
4. Click Save.

Account Audit Overview
To access the Account Audit page, in the function tree, navigate to Menu (E) > Device Management >
Account and Password and go to the Account Audit tab.

The Account Audit tab lets users create a device account baseline and perform an account audit to easily
identify newly added or deleted accounts.

= MXview ONE @English 2 adminy
Account and Password Management Automation
Account Management Password Automation Account Audit Default Password Audit Temporary Accounts
Accounts Baseline

Last Executed: N/A

)
e Q, Search

Device Alias Compatible Model Device IP Baseline Accounts Added Accounts Deleted Accounts
192.168.123 70-AWK-32524 Yes AWK-32524 192.168.123.70 N/A N/A

192.168.127.11-EDS-G516E Yes EDS-G516E 192.168.127.11 N/A N/A N/A

This page displays the following information in a table format:

Column Description

Device Alias The unique name of the device.

Compatible Shows if the device supports MXview One retrieving account information. If the
device does not support this function, the Accounts column will show N/A.

Model The device model name.

Device IP The IP address of the device.

Baseline Accounts Shows the user accounts associated with the device when creating the
baseline.

Added Accounts Shows the user accounts that were added compared to the baseline after
performing an account audit.

Deleted Accounts Shows the user accounts that were deleted compared to the baseline after
performing an account audit.
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Creating an Account Baseline

1. Navigate to Menu (E) > Device Management > Account and Password.
2. Go to the Account Audit tab.
3. The Accounts Baseline section includes the following information:

Accounts Baseline

Last Executed: 2024-07-23 AM 9:24:44

> Last Executed: Shows the date and time when the most recent baseline was created. If no baseline
has been created before, this will show N/A.

4. Click Create.
The Device Baseline window will appear.

[ |

Accounts Baseline

This operation will create a new baseline and will

overwrite the existing one.

5. Click Create.

Executing a Manual Account Audit

/ NOTE

This function is only available after creating an account baseline. Refer to Creating an Account Baseline.

1. Navigate to Menu (E) > Device Management > Account and Password.
2. Go to the Account Audit tab.
3. The Accounts Audit section shows the following information:

Accounts Audit

Last Audited: 2024-07-23 AM 9:31:59
Mext Audit: 2025-01-19 AM 2:00:00

> Last Audited: Shows the date and time of the most recent account audit.
» Next Audit: If automatic account auditing is enabled, this shows the time and date of the next
scheduled audit.

4. Click Audit.
MXview One will compare the current accounts to the baseline and will show any added or deleted

accounts in the table.
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Configuring an Automatic Account Audit Schedule

/7  NOTE

This function is only available after creating an account baseline. Refer to Creating an Account Baseline.

1. Navigate to Menu (E) > Device Management > Account and Password.
2. Go to the Account Audit tab.

3. In the Audit Automation section, configure the following settings:

Accounts Audit Audit Automation

Last Audited: 2024-07-23 PM 6:17.08 Enabled . 180

Next Audit: 2025-01-19 AM 2:00:00

=] =]

> Enable: Enable or disable the automatic account auditing function.

» Interval: Specify the interval (in days) when MXview One will perform an account audit.
4. Click Save.

Default Password Audit Overview

To access the Default Password Audit page, in the function tree, navigate to Menu (E) > Device
Management > Account and Password and go to the Default Password Audit tab.

The Default Password Audit tab lets users quickly check for any accounts that are using the default
password.

= MXview ONE Dengicn

2 adminy
Account and Password Management Automation
Account Management Password Automation Account Audit Default Password Audit Temporary Accounts

Default Password Audit

Last Executed: N/A

<] Q_ search

Device Alias Compatible Model Device IP Default Username,/Password

B

This page displays the following information in a table format:

Column Description

Device Alias The unique name of the device.

Compatible Shows if the device supports MXview One retrieving account information.
Model The device model name.

Device IP The IP address of the device.

Default Account/Password Shows if the account is using the default credentials:

e Yes: The device uses the default username and password. For security
reasons, it is highly recommended to change the default credentials.
No: The device is not using the default credentials.
N/A: MXview One cannot retrieve account information because the device
does not support this feature.
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Performing a Default Password Audit

Navigate to Menu (E) > Device Management > Account and Password.
Go to the Default Password Audit tab.

In the Default Password Audit section, click Scan.
The Default Password Audit window will appear.

Default Password Audit

Scanning for default account credentials may
take some time and will leave the interface
temporarily unavailable. Are you sure you want to

continua?
N -

4. Click Scan.
MXview One will scan for any accounts using the default credentials and list them in the table.

Temporary Accounts Overview

To access the Temporary Accounts page, in the function tree, navigate to Menu (E) > Device
Management > Account and Password and go to the Temporary Accounts tab.

The Temporary Accounts tab allows users to create, edit, and delete temporary accounts for devices.

@English 2 adminy

Account and Password Management Automation

Account Management Passviord Automation Account Audit Default Password Audit Temporary Accounts

Q 5em
O Device Alias Compatible Model Device IP Usemame Start Time End Time Status.
O +& & & 192168.12370-AWK-32524 Yes AWK3Z52A 192.168.123.70
O +& & & 192168.127.11-EDSG516E Yes EDSGEIEE 192.168.127.11
>
This page displays the following information in a table format:
Column |Description
Device Alias The unique name of the device.
Compatible Shows if the device supports the temporary accounts function.
Model The device model name.
Device IP The IP address of the device.
Username The username of the account.
Start Time The account validity start time.
End Time The account validity end time.
Status The status of the account.
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Adding a Temporary Account

Navigate to Menu (E) > Device Management > Account and Password.
2. Go to the Temporary Accounts tab.

.
3. Click the Add ( *™) icon next to the device you want to create a temporary account for.
The Add Temporary Account window will appear.

Add Temporary Account

©
Immediate -
2024/07/23 B
PM 6:30 -

Cancel

4. Configure the following settings:
» Username: Enter a username for the account.
» Password: Enter the password for the account.
> Action: Select the type of account.
O Immediate: The account will be active immediately until the specified end date.
O Scheduled: The account will only be active during the specified time period.
Active From: If you selected Scheduled, specify the date the account will be valid from.
Start Time: If you selected Scheduled, specify the starting time the account will be valid from.

Valid Until: Specify the date the account expires.

YV V V V

End Time: Specify the time of day the account expires.

5. Click Add.
MXview One will show the status of the account creation.

Add Temporary Account
Device Alias Model Device IP Status
192.168.127.11-EDS-G516E EDS-G516E 192.168.127.11 n Progress...
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Editing a Temporary Account

Navigate to Menu (E) > Device Management > Account and Password.
2. Go to the Temporary Accounts tab.

[
3. Click the Edit (”) icon next to the device you want to edit the temporary account for.
The Edit Temporary Account window will appear.

Edit Temporary Account

©
2 02{ L R

4. Configure the following settings:

» Action: Select the type of account.

0O Immediate: The account will be active immediately until the specified end date.

O Scheduled: The account will only be active during the specified time period.

Active From: If you selected Scheduled, specify the date the account will be valid from.

Start Time: If you selected Scheduled, specify the starting time the account will be valid from.
Valid Until: Specify the date the account expires.

Y V V VY

End Time: Specify the time of day the account expires.

5. Click Change.
MXview One will show the status of the account modification.

Edit Temporary Account
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Deleting a Temporary Account

1. Navigate to Menu (E) > Device Management > Account and Password.
2. Go to the Temporary Accounts tab.

[ 1=
3. Click the Delete (™ ) icon next to the device you want to delete the temporary account of.
The Delete Temporary Account window will appear.

Delete Temporary Account

Are you sure you want to delete this temporary

account?

4. Click Delete.
MXview One will show the status of the account deletion.

Delete Temporary Account

Device Alias Model Device IP Status

Y.
[
o
]
]

1

11-EDS8516E EDSGTIsE 19216812711 n Progress
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12. Saved CLI Scripts

The CLI Scripts function allows users to generate and execute CLI scripts from within MXview One. After
creating and saving CLI scripts, users can create script automations and automation buttons to quickly
execute batch configurations on multiple devices at once.

Saved CLI Scripts Overview

To access the Saved CLI Scripts page, in the function tree, navigate to Menu ( E) > Saved CLI Scripts.

If there are no saved CLI scripts, a script will need to be created by clicking the Add () icon. Refer to

Adding a CLI Script for information on how to create a script.

If there are saved CLI scripts, the following tabs will be available:

e CLI Scripts: This list shows all saved CLI scripts. From this table, you can create, edit, or delete CLI
scripts.

o Execution Results: From this tab, you can download or delete the execution results of previously
executed scripts.

e Script Automation: From this tab, you can view, create, edit, or delete script automations.

e Automation Buttons: Each script automation you create will generate an automation button. From
this tab, you can manage script automation buttons.

= MXview ONE @eEnglish & adminv

USRS Saved CLI Scripts

Deshboerd CLI Scripts Execution Results Script Automation Automation Buttons

Topology
Device Discovery A scheduled Script
You can create scheduled tasks to run CLI scripts at a specified date and time from the Administration > Maintenance Scheduler page.
Device Management -
Fimmware Management
O Name Description Linked Scheduled Tasks Linked Script Automations
Device Configuration Center
Er Va reloag-task reload-description start-b, diff_cli-btn, same_cli_btr1
Notification Management Va reloadask-new reload-description-new diff_cli-bm, same_cli_btn2

Inverttory Management
Integration

Administration

Help
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CLI Scripts

Adding a CLI Script

1. Navigate to Menu (E) > Saved CLI Scripts > CLI Scripts.

The Saved CLI Scripts screen will appear. A list of configured CLI scripts will show in the CLI Scripts
list (if any).

2. Click the Add (E3) icon.
The Add CLI Script screen will appear.

Add CLI Script

Cancel

3. Configure the following settings:
a. Name: Enter a name for the CLI script.
b. Description: Enter a description for the CLI script.
c. CLI Script: Enter the CLI command(s) to execute.

4. Click Add.
The CLI script will be added to the table.

Saved CLI Scripts

CL Seripts Execution Results Seript Automation Automation Buttons

A Scheduled Script
You can create scheduled tasks to run CLI scripts at a specified date and time from the Administration > Maintenance Scheduler page

Q Sea
< O Name Description Linked Scheduled Tasks Linked Seript Automations
' B Va reloadtask reload-description start-btn, diff_clibtn, same._cli_btn1

ra reload-task-new reload-description-newr diff_cli-btn, same._cli_bin2

[0 # W Imerfacedescripion Show interface description
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Searching for a CLI Script

1. Navigate to Menu (E) > Saved CLI Scripts > CLI Scripts.
The Saved CLI Scripts screen will appear. A list of configured CLI scripts will show in the CLI Scripts
list (if any).

2. In the Search ( o\) field, type the full or partial information of the CLI script.
All CLI scripts matching the entered string will be shown in the table.

Editing a CLI Script

1. Navigate to Menu (E) > Saved CLI Scripts > CLI Scripts.
The Saved CLI Scripts screen will appear. A list of configured CLI scripts will show in the CLI Scripts
list (if any).

2. Click the Edit (/') icon next to the script you want to edit.
The Edit CLI Script screen will appear.

Edit CLI Script
Interface description

Show interface description

show interfaces description

cance‘ m

3. Configure the following settings:
a. Name: Enter a name for the CLI script.
b. Description: Enter a description for the CLI script.
c. CLI Script: Enter the CLI command(s) to execute.

4. Click Apply.
A confirmation will appear to verify the CLI script was updated.

CLI script updated successfully
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Deleting a CLI Script

/  NOTE

A CLI script cannot be deleted if it is linked to a scheduled task. To delete the script, modify or delete the
scheduled task first on the Administration> Maintenance Scheduler page.

1. Navigate to Menu (E) > Saved CLI Scripts > CLI Scripts.

The Saved CLI Scripts screen will appear. A list of configured CLI scripts will show in the CLI Scripts
list (if any).

2. Click the Delete ( o ) icon next to the CLI script you want to delete.
A confirmation window will appear.

Delete CLI Script

Are you sure you want to delete this CLI script?

3. Click Delete.

A confirmation will appear to verify the CLI script was deleted.

CLI script deleted successfully

Deleting Multiple CLI Scripts

/ NOTE

A CLI script cannot be deleted if it is linked to a scheduled task. To delete the script, modify or delete the
scheduled task first on the Administration> Maintenance Scheduler page.

1. Navigate to Menu (E) > Saved CLI Scripts > CLI Scripts.

The Saved CLI Scripts screen will appear. A list of configured CLI scripts will show in the CLI Scripts
list (if any).
2. Select the checkbox of the scripts you want to delete in the list.

3. Click the Delete ( 0 ) icon at the top-left corner of the page.

Saved CLI Scripts

CLI Seript: Execution Results

A scheduled script
schedule:

You can create scheduled tasks to run CLI scripts at a specified date and time from the Administration > Maintenance Scheduler page

E‘ m Name Description Linked Scheduled Tasks Linked Script Automations

# B merace description Show interface description

s B revoct reboot device:
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4. A confirmation window will appear.

Delete CLI Script

Are you sure you want to delete these CLI

gcripts?

5. Click Delete.

A confirmation will appear to verify the CLI script was deleted.

Creating a CLI Script Scheduled Task

1. Navigate to Menu (E) > Administration > Maintenance Scheduler.
The Maintenance Scheduler screen will appear.
= MXview ONE

Q Type keyword to search

Device Management
Saved CLI Scripts
Firmware Management
Device Configuration Center
Event Management
Notification Management
Reports
Integration
Administration
Account Management
Default Device Template
Global Device Settings
System Settings

Maintenance Scheduler
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Q search
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072 B B st Export Configuration  test 2023-12-04 PM1:00 1
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Click the Add (E3) icon.

The Add Job screen will appear.

Add Job

Run Saved Script

CLI Script Name * -
Description *

-~
Registered Devices * _-
Once -
r;“”;*fdf.ifyyyy

Configure the following settings:

Cancel

Registered Devices: Select the devices that you want to run the selected CLI script on.

a. Job Name: Enter a name for the job.

b. Action: Select Run Saved Script from the Action drop-down list.
c. CLI Script Name: Select the CLI script that you want to execute.
d. Description: Enter a description for the job.

e.

f.

Repeat Execution: Select the job execution frequency: Once, Daily, Weekly, Monthly.

g. Start Date: If you select Once in the Repeat Execution field, specify the start date to begin

executing the scheduled job.

h. On: If you select Weekly or
the scheduled job.

i
Click Add.

Monthly in the Repeat Execution field, specify when to begin executing

Execution Time: Specify the time of day to run the scheduled job.

MXview One will display the scheduled job in the Maintenance Scheduler table and will run the CLI script
for the selected devices according to the defined schedule.

Maintenance Scheduler

O Job Name

0O & W B Test

Q, Search
Action Description Scheduled Time Registered Devices

Run Saved Script test 2023-12-29 PM2:38 1
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Execution Results

Download All Execution Results

1. Navigate to Menu (E) > Saved CLI Scripts.
The Saved CLI Scripts screen will appear.

2. Go to the Execution Results tab.

Saved CLI Scripts

CLI Scripts Execution Results

Download All Execution Results

Delete All CLI Script Execution Results

Delete

Delete Script Execution Results Prior to

< |2024/07/22 =]

3. Click Download.

MXview One will download all the CLI script execution results as a ZIP file.
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Delete All CLI Script Execution Results

1. Navigate to Menu (E) > Saved CLI Scripts.
The Saved CLI Scripts screen will appear.

2. Go to the Execution Results tab.

Saved CLI Scripts

CLI Scripts Execution Results

Download All Execution Results

Delete All CLI Script Execution Results

Delete

Delete Script Execution Results Prior to

< |2024/07/22 =]

3. Click Delete.
A confirmation window will appear.

Delete All CLI Script Execution Results

Are you sure you want to delete all CLI script

execution results?
4. Click Delete.

A confirmation will appear to verify all execution results have been deleted.

Script execution results deleted successfully
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Delete Execution Results Prior to a Specified Time

1. Navigate to Menu (E) > Saved CLI Scripts.
The Saved CLI Scripts screen will appear.

2. Go to the Execution Results tab.

Saved CLI Scripts

CLI Scripts Execution Results Script

Download All Execution Results
[e==
Delete All CLI Script Execution Results

Delete Script Execution Results Prior to

< |2024/07/22 u]

Specify the Date and Time. All execution results prior to this time will be deleted.

4. Click Delete.
A confirmation window will appear.

Delete CLI Script Execution Results

Are you sure you want to delete all script
execution results prior to 2024/07/22 12:00?

Cancel
5. Click Delete.

A confirmation will appear to verify all execution results have been deleted.

Script execution results deleted successfully

Script Automation

From the Script Automation screen, you can create and manage script automations. A script automation
allows you to combine multiple saved CLI scripts into a single script. A corresponding automation button
then lets you quickly execute the included commands to the specified devices with just a single click.

Adding a Script Automation

1. Navigate to Menu (E) > Saved CLI Scripts.
The Saved CLI Scripts screen will appear.

2. Go to the Script Automation tab.
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3. Click the Add () icon.
The Add Script Automation screen will appear.

Add Script Automation

CLI Scripts and Target Devices

Cancel

4. Configure the following settings:
» Name: Enter a name for the script automation.
> Description: Enter a description for the script automation.

» CLI Scripts and Target Devices: Select the saved CLI script and devices to include in this
automation. You can add a maximum of 50 scripts in a single script automation.
This requires a previously created saved CLI script. Refer to the Adding a CLI Script section.

Click the Add () icon to add additional entries to the automation.

/  NOTE

Only one saved CLI script can be assigned to an individual target device.

5. Click Add.
The script automation will be added to the table. Each script automation entry will also create an
individual button in the Automation Button section. Refer to the Automation Buttons section.

@English & adminv

Saved CLI Scripts

CLI Scripts Execution Results Script Automation Automation Buttons

o
i

[ Name Description
O 7 W statbn Abin192.168.123.152
O # ¥ dfficibm A-bin-192.168.123.153
<. O # B samedibmi 1538154
B O 2 ¥ samecdikmn2 1538154
/  NOTE

MXview One supports a maximum of 200 script automations.
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Editing a Script Automation

1. Navigate to Menu (E) > Saved CLI Scripts.
The Saved CLI Scripts screen will appear.

Go to the Script Automation tab.

Click the Edit (#") icon next to the script automation you want to edit.
The Edit Script Automation screen will appear.

Edit Script Automation

start-bin

A-btn-192.168.123.152

CLI Scripts and Target Devices

B reload-task = 192.168.123.152-EDS-518A -

C ancel m

4. Configure the following settings:
» Name: Enter a name for the script automation.
> Description: Enter a description for the script automation.

» CLI Script and Target Devices: Select the saved CLI script and devices to include in this
automation. You can add a maximum of 50 scripts in a single script automation.
This requires a previously created saved CLI script. Refer to the Adding a CLI Script section.

Click the Add () icon to add additional entries to the automation.

Click the Delete (i) icon to remove an entry.

5. Click Apply.
A confirmation will appear to verify the script automation was updated

Updated successfully

Deleting a Script Automation

Navigate to Menu (E) > Saved CLI Scripts.

2. Go to the Script Automation tab.
The Script Automation screen will appear. A list of configured script automation will show.

3. Click the Delete ( N ) icon next to the script automation you want to delete.
A confirmation window will appear.

Delete Script Automation

Are you sure you want to delete this script

automation?
4. Click Delete.

A confirmation will appear to verify the CLI script was deleted.
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Deleting Multiple Script Automations

Navigate to Menu (E) > Saved CLI Scripts.
2. Go to the Script Automation tab.

The Script Automation screen will appear. A list of configured script automation will show in the CLI
Scripts list (if any).
3. Select the checkbox of the script automations you want to delete in the list.
4. Click the Delete ( o ) icon at the top of the page.
@Engish 2 adminy
Saved CLI Scripts

CLI Scripts Execution Resufts Script Automation Automation Buttons

| Qse
m Name Description
VAR AbIn192168.123.152
/7 W diffdibm A-bm-192.168.123.153
<| O & W ssmeci
| 0O & B semedibmz

5. A confirmation window will appear.

Delete Script Automation

Are you sure you want to delete these script
automations?
6. Click Delete.

A confirmation will appear to verify the script automations were deleted.

Automation Buttons

From the Automation Buttons screen, you can manage automation buttons for configured script
automations.

Each newly added automation script will automatically generate an automation button that is placed in the
default Unnamed group.

Editing an Automation Button Group

1. Navigate to Menu (E) > Saved CLI Scripts.
2. Go to the Automation Buttons tab.
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3. Click the Edit (/') icon in the top-left corner of the screen to enter edit mode.
= MXview ONE @english 2 admin¥

Saved CLI Scripts

CLI Scripts Execution Results Script Automation Automation Buttons

153+154 Unnamed
sameclibtnl sameclibtn2  Starthtn  diff_clibtn

4. Click the Edit (#") icon next to the group name of the group you want to edit.
= MXview ONE @english & admin¥

Saved CLI Scripts

Automation Buttons

5] =
153+1547] Unnamed~]
® © O @O
same_cli_btn1 same_cli_btn2 start-btn diff_cli-btn

g

The Edit Group will appear.

Edit Group

Unnamed

Reorder Buttons

Unnamed
start-btn diff_cli-btn

5. Configure the following settings:

> Group Name: Enter a name for the group.
> Reorder Buttons: Click and drag the buttons to adjust their position.

6. Click Apply.
The changes will appear on the Automation Buttons page.
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7. Click the Save ( a8 ) icon to save your changes and leave edit mode.
= MXview ONE @engish 2 adminy

Saved CLI Scripts

Automation Buttons

.
[ o | 153+154 New ~
® @ e @

same_cli_btn1 same_cli_bin2 startbin diff_cli-btn

8. A confirmation will appear to verify the button group was updated.

If you leave the Automation Buttons page without saving, a confirmation window will appear.

Leave Without Saving

Are you sure you want to leave this page?
Any changes you made will not be saved.

Editing an Automation Button

Navigate to Menu (E) > Saved CLI Scripts.

Go to the Automation Buttons tab.

Click the Edit (#") icon in the top-left corner of the screen to enter edit mode.

= MXview ONE B Emi=k RS e

Saved CLI Scripts

CLI Scripts Execution Results Script Automation Automation Buttons

153+154 Unnamed
same_cli_btn1 same_cli_btn2 start-bin diff_cli-btn

4. Click the Edit (/') icon next to the button you want to edit.

= MXview ONE @engisn 2 admin

Saved CLI Scripts

Automation Button

153+154 7 New

e e @

‘same_cli_btn1 same_cii_btn2 start-bin diff_clibtn

MXview One 1.5.0 User Manual 176



The Edit Button window will appear.

Edit Button

Backgrour
#008787

#000000

Group
@ Use the current group

() Create and add to a new group

Group Name

-

() Move to another group

5. Configure the following settings:

a. Background Color: Click the value to open the color picker. Select the preferred background color
on the color picker or enter the color's hex value.

b. Text Color: Click the value to open the color picker. Select the preferred text color on the color
picker or enter the color's hex value.
c. Group: Select the group to assign this button to.

O Use the current group: Leave the button in its currently assigned group.
O Create and add to a new group: Create and assign the button to a new group.
O Move to another group: Select an existing group to assign the button to.

6. Click Apply.
The changes will appear on the Automation Buttons page.

= MXview ONE @english 2, adminy

Saved CLI Scripts

Automation Buttons

New2 .~ 153+154 » New ~

@®- @ @ O

start-btn same_cli_btn1 same_cli_bin2 diff_cli-btn

7. Click the Save ( a ) icon to save your changes and leave edit mode.
= MXview ONE @english & adminy

Saved CLI Scripts

Automation Buttons

a =
New2 ~ 153+154 7 New ~
®- @ @ @
startbtn same clibtnl sameclibinz  diff_clibin
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8. A confirmation will appear to verify the button was updated.

If you leave the Automation Buttons page without saving, a confirmation window will appear.
Leave Without Saving

Are you sure you want to leave this page?
Any changes you made will not be saved.

Creating an Automation Button Group

Navigate to Menu (E) > Saved CLI Scripts.

Go to the Automation Buttons tab.

Click the Edit (/') icon in the top-left corner of the screen to enter edit mode.

= MXview ONE @englsh 2 admin¥

Saved CLI Scripts

CLI Scripts Execution Results

Script Automation Automation Buttons

153+154 Unnamed
same_eli btn1 same_eli_btn2 startbtn  diff_clibtn

Click the Create and add to a new group (-'-) icon in the top-left corner of the screen.
= MXview ONE

@engish 2 adminv

Saved CLI Scripts

Automation Buttons

BE'

Create and add to a new group

New2 » 153+154 7 New ~

@ @ @ e

start-bin same_cli_btn1 same cli_bin2 diff_cli-bin

The Create and add to a new group window will appear.

Create and add to a new group

Cancel

5. Configure the following settings:
» Group Name: Enter a name for the group.
» Button Name: Select the button(s) to add to this group.
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6. Click Create.
The changes will appear on the Automation Buttons page.

= MXview ONE @engish 3, adminy’

Saved CLI Scripts

Automation Buttons

a8 H
Moxa EU » New2 # New »#
®- @®- @®-
startbin same._cli_btn1 diff_cli-btn
Moxa Asia ~ 153+154

@®-

same_cli_btn2

J

7. Click the Save ( a8 ) icon to save your changes and leave edit mode.
= MXview ONE @engish & adminy

Saved CLI Scripts

CLI Scripts Execution Results Script Automation Automation Buttons

v
New2 New
same_cli_btn1 diff_cli-btn
Moxa EU 153+154

s start-btn same_cli_btn2

8. A confirmation will appear to verify the button was updated.

If you leave the Automation Buttons page without saving, a confirmation window will appear.

Leave Without Saving

Are you sure you want to leave this page?
Any changes you made will not be saved.

Changing the Automation Button Widget Size

/  NOTE

Changes to the widget size will reflect on both the Automation Buttons and Topology pages.

1. Navigate to Menu (E) > Saved CLI Scripts.
2. Go to the Automation Buttons tab.
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3. Click the Edit (/') icon in the top-left corner of the screen to enter edit mode.
= MXview ONE @Engiish & admin¥’

Saved CLI Scripts

CLI Seripts Execution Results Script Automation Automation Buttons

153+154 New New2
same._cli_btn2 diff_clibtn startbtn same_cli_btn

4. Click the Widget Size ( ) icon in the top-left corner of the screen.

= MXview ONE @¢ngish 8 adminy

Saved CLI Scripts

Automation Buttons

dget Size

153+154 # New ~ New2 s
®- ® ©® @O
same_cli_btn2 diff_cli-btn start-bin 'same_cli_btn1

The Widget Size window will appear.

Widget Size

Large -

[] Align all groups in a single column

5. Configure the following settings:

> Widget Size: Select the size of the automation button widgets on the Automation Buttons and
Topology pages.

> Align all groups in a single column: Check to align automation button group widgets in a single
column.

6. Click the Save ( a ) icon to save your changes and leave edit mode
= MXview ONE @engish 2 adminy

Saved CLI Scripts

Automation Buttons

a =
ﬁ 153+154 » New » New2 #

@ @ @ @

same_cli_btn2 diff_cli-bin start-btn 'same_cli_btn1

7. A confirmation will appear to verify the button was updated.
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If you leave the Automation Buttons page without saving, a confirmation window will appear.

Leave Without Saving

Are you sure you want to leave this page?
Any changes you made will not be saved.
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13.

Firmware Management

MXview One features Moxa Firmware Server integration to check for the availability of the latest firmware
for devices. From the Firmware Management section, users can review the release notes, download the
firmware file, and perform firmware updates for multiple devices at once.

Firmware Management Overview

To access the Firmware Management page, in the function tree, navigate to Menu (E) > Firmware

Management.

On this page, users can find the Check Firmware Status function and a table of with the firmware
information of all model series in the topology.

= MXview ONE

Firmware Management

Q Type keyword to search

(reririeta) Check Firmware Status
Moxa Firmware Server Status: & Connected
Last Checked: 2023/12/28 AM 11:37:21

Check Interval: N/A

Models

Topology

Device Discovery
Device Management
Saved CLI Scripts
Firmware Management Ignored Models
Device Configuration Center
Event Management
Notification Management

|| Model Series
Reports

Integration EDS-408A

Administration EDS-G4008

Hep EDS-GS12E-8PoE

- » »

EDS-G516E

@english 2 admin¥

Device Status Latest Version on the Firmware Server Selected Version Selected Firmware Download Status

(DNot updated va13 = None
(©Not updated v3.2 i= None
(@Not updated v6.4 = None
© ot updated v6.4 = None

Check Firmware Status

Check Firmware Status

Moxa Firmware Server Status: & Connected

Last Checked: 2023/12/28 AM 11:37:21
Check Interval: N/A

m Enable Check Interval

The Check Firmware Status section includes the following the information:

¢ Moxa Firmware Server Status: This indicates the status of the MXview One connection to the Moxa

Firmware Server.

e Last Checked: This is the date and time MXview One last checked the firmware information on the

Moxa Firmware Server.

¢ Check Interval: If Check Interval is enabled, this shows the interval at which MXview One will check
for firmware information. If no interval is configured, this will show “N/A".
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There are two ways for MXview One to check for the firmware information on the Moxa Firmware Server:

e Check Now: Click Check Now to immediately check for updated firmware information.

« Enable Check Interval: Specify a time and date interval at which MXview One will check for new
firmware information.

Daily

Enable Check Interval

Cancel

Model Series Table Overview

The models table is divided into two separate tabs: Models and Ignored Models.

Models

The Models tab shows an overview of all the model series and their respective firmware information. All

identical models will be shown by a single representative entry in this table.

Models Ignored Models

(m} Model Series

EDS-408A

EDS-G4008

EDS-G512E-8PoE

EDS-G516E

MDS-G4028

PT-7728PTP

PT-G510

PT-G7728

- » » » » »

AWK-1151C

Device Status

(2 Not updated
(2)Not updated
(©Not updated
@ Not updated
() Not updated
® Not updated
(2 Not updated

Partially updated

=) All updated

Latest Version on the Firmware Server

v3.13

Selected Version

None

None

None

None

None

None

None

None

None

Selected Firmware Download Status
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This screen includes the following information:

Itom |Description |

Model Series The model name. All identical models will be represented by a single entry. For

example, if there are multiple EDS-408A devices, only one EDS-408A entry will

appear in the table.

Device Status The current firmware version status of the model series. The following statuses

can be shown:

e All updated: The firmware version of all models of this type is up to date.

e Partially updated: The firmware version of some of the models of this type
is not up to date.

¢ Not updated: The firmware version of all models of this type is not up to
date.

¢ No information available: There is no firmware version information
available on the firmware server for this model.

Latest Version on the The latest firmware version of this model series on the Moxa firmware server.

Firmware Server

Selected Version Shows the currently selected firmware version and its release notes. Users can
select a different firmware version. Refer to Selecting a Firmware Version.

Selected Firmware After selecting a firmware version to download, this shows the firmware file

Download Status download progress as a percentage.

The following actions are available from this screen:

Icon |Name |Description |
l Click this icon to prevent MXview One from checking for and sending
- Disable new version notifications for new firmware versions for that model series. This
notifications will add the model series to the Ignored Models list. Refer to Ignored

Models for more information.

|1—| Upgrade firmware C_Ilck this icon to initiate a firmware upgrade. Refer to Upgrading
Firmware.

= Click this icon to select a different firmware version. Refer to

I= |Select firmware version ) . )
Selecting a Firmware Version.

e Security patch available This icon indicates a new security patch is available for that model

series.
E Enable new version Click this icon to enable MXview One to check for and send
= notifications notifications for new firmware versions for that model series.

Ignored Models

The Ignored Models lists all models for which MXview One is not checking for new firmware and is not

sending notifications. To add a model series to the Ignored Models list, click the bell ( =" ) icon on the

Models tab next to the model series.

Models gnored Models

Model Series

B EDS-4084
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Selecting a Firmware Version

Users can manually select a firmware version to upgrade to. When upgrading firmware, MXview One will
apply the selected firmware to all similar models.

1. Navigate to Menu (E) > Firmware Management.
2. Go to Models tab.

3. In the device list, click the Select Firmware ( = ) icon of the corresponding model series in the
Selected Version column.
The Select Firmware window will appear.

4. Select a different firmware version from the Version drop-down menu. The release notes for the
selected firmware version will appear in the section below.

Select Firmware
6.4 -

Release Notes

Version

6.4

Change

N/A

Enhancement

1. Added support for SFP auto-negotiation/forced mode CLI commands.

2. Added a mechanism to prevent firmware downgrading to a version earlier than v6.2
Feature

N/A

Fix

1. Login authentication fails when using MS-CHAPv2 with certain RADIUS servers.

2. If the ring ports and coupling port are configured in a sequence (e.g. ports 1, 2, 3) and the
coupling port is the last port in the sequence, the coupling link will not be established.

Note

1. Due to some changes to the components of the product, the device will be incompatible with
certain older firmware versions. To ensure device stability, a mechanism has been added to
prevent firmware downgrading to any version earlier than v6.2.

5. Click Select.

6. MXview One will begin download the selected firmware.

Downloading firmware file

7. The download progress will be shown in the Selected Firmware Download Status.

O Model Series Device Status Latest Version on the Firmware Server Selected Version Selected Firmware Download Status
0O [ A eoscsiee ©nNotupdated v6.4 = ved

A MDSG4028 (©nNot updated v4.0 = None

A PT7728PTP (©Not updated V356 i= None
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Upgrading Firmware

Once you have selected a firmware version and MXview One has finished downloading the firmware file, you
can upgrade the firmware of the selected model series. To select and download a firmware version, refer to

Selecting a Firmware Version.

1. Navigate to Menu (E) > Firmware Management.
2. Go to the Models tab.
3. In the device list, select the model series to upgrade firmware for.
You can select multiple model series.
. . ..
Click the Upgrade Firmware ( ) icon.
Configure the reboot sequence and execution time.
Upgrade Sequence
Smart Sequential -~

Order P Alias Model Series Current Version Selected Version

1 192.168.127.11 192.168.127.11-EDS-G516E EDS-G516E V6.3 build 23032200 v6.4

2 10.123.32.40 10.123.32.40-MDS-G4028 MDS-G4028 v4.0

Cancel Scheduled Upgrade
a. Select the reboot sequence:

O Strict Sequential: Upgrade the devices based on the device sequence in the topology starting
from the device furthest away from the computer running MXview One, proceeding to the
nearest one.

O Smart Sequential: Upgrade the devices based on the device sequence in the topology but
simultaneously upgrade all devices in the same topology layer.

g
#/  NOTE

The computer running MXview One must be added to the topology in order for MXview One to determine
the upgrade sequence. If the computer running MXview One is not added to the topology, you cannot
select an update mode and MXview One will update the device firmware concurrently.

b. Select an execution time:
a
a

Upgrade Now: Click Upgrade Now to upgrade the devices instantly.
Scheduled Upgrade: Click Scheduled Upgrade to create a new scheduled task. MXview One

will upgrade the devices based on the specified time and date in the schedule.
6. To upgrade the devices instantly, click Upgrade Now. The system will execute the action.

Firmware Upgrade Status
A The firmware upgrade may take some time. Please wait for the upgrade process tc
Order P Alias Model Series
1 10.123.32.40 10.123.32.40-MDS-G4028 MDS-G4028
2 192.168.127.11 192.168.127.11-EDS-G516E EDS-G516E

o complete

Selected Version

vb.4

Status

Waiting

In progress

7.
firmware upgrade.

Click Download CSV Report or Download PDF Report to download a summary report of the
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8. If the firmware upgrade was unsuccessful, check the error description in the Status column to identify
the issue. Click Retry Failed Devices to perform the action again.

Firmware Upgrade Result

Order P Alias Model Series Selected Version Status
1 10.123.32.40 10.123.32.40-MDS-G4028 MDS-G4028 v4.0 Failed
2 192.168.127.11 192.168.127.11-EDS-G516E EDS-G516E v6.4 Finished

Close Download CSV Report Download PDF Report Retry Failed Devices

9. If you close this page without downloading the results report, a confirmation will appear.
Clicking Ignore will delete the results report permanently.

Ignore Report

A Are you sure you want to skip
downloading the report?

If you leave this page, the report will no
longer be available for download.
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14. Events and Notifications

MXview One allows you to monitor system events, create custom monitoring events, and configure event
notifications.

Event Monitoring

Viewing System Events

To access the System page, in the function tree, navigate to Menu (E) > Event Management > Event
History and go to the System tab. The System tab shows information about MXview One system events.
Use the filters to customize the information displayed in the table. You can also export the data as a CSV
file.

Event History

System Network and Device Cybersecurity
[
O ID Source Source IP Device Alias Description Time Issued
MXview
~| s 01 144
5 O =4 e 10 One User login: admin 2025-01-1912:11:01
1o B o Miliew User logout: admin 20250117 18:15:47
One gout: T
MXview .
O B 8 O User login: admin 2025-01-17 18:10:53
O B - HAXYIER User login: admin 20250117 17.01:12
One gl '

Navigate to Menu (E) > Event Management > Event History.
2. Go to the System tab.

The System tab will display the following information in a table format:

Column ________ |Descripton ___ ____

Acknowledge Acknowledge status of the event

Show Details The detailed information of this event

ID The unique identifier of the event

Source The source of the event

Source IP The IP address of the device that issued the event
Device Alias The unique name of the device

Description The description of the event

Time Issued The time the event was issued
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3. To filter the information in the table by specific criteria:
a. Click the Filter (<) icon in the top left corner.
The following screen will appear.

Acknowle... =

Start Da.. f] Hour * Minute - Second -

End Date (8] Hour ~ Minute ~ Second -

o -

b. Specify any of the following criteria:

Acknowledge Select the acknowledgement status of the event
Start Date Specify the start date and time for the event data to display
End Date Specify the end date and time for the event data to display

c. Click Apply.

MXview One filters the table to only display events that match the specified criteria.
4. To sort the data in the table by a specific column, click the column heading.
MXview One sorts the table by the column.
5. To export data displayed on the System tab:

a. Click the Export (a) icon.
[ G I
D Export CSV

O Export All Events to CSV &7

b. Select Export CSV for just the events on the first page or Export All Events to CSV for all event
pages.

MXview One exports the displayed event data as a CSV file.
Viewing Network and Device Events

To access the Network and Device page, in the function tree, navigate to Menu (E) > Event

Management > Event History and go to the Network and Device tab.

The Network and Device tab shows information about all the network and device events in your topology.

Use the filters to customize the information displayed in the table. You can also export the data as a CSV
file.
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Event History

System Network and Device Cybersecurity
[ SO
O ID Source Source IP Device Alias
(] E 2727 MXview One 192.168.127.62  192.168.127.62-NPort-6250-G2
O B 2726 MXview One 192.168.127.62  192.168.127.62-NPort-6250-G2
O E 2725 MXview One 192.168.127.62  192.168.127.62-NPort-6250-G2
| B 22 MXview One 192.168.127.62  192.168.127.62-NPort-6250-G2

The page will display the following information in a table format:

Column Description

Description

Device ICMP reachable

Device ICMP unreachable

Device ICMP reachable

Device ICMP unreachable

Acknowledge The acknowledgement status of the event.

Show Details Detailed information about the event.

ID The unique identifier of the event

Source The source of the event.

Source IP The IP address of the device that issued the event.
Device Alias The unique name of the device.

Description The description of the event.

Time Issued The date and time the event was issued.

1. Navigate to Menu (E) > Event Management > Event History.

2. Go to the Network and Device tab.
The Network and Device screen will appear:

3. To filter the information in the table according to specific criteria:

a. Click the Filter (?) icon in the top-left corner.

The filter window will appear.

rity

All Groups ~  IP Address

w
=
1]

~  Acknowle... ¥

I Start Date @ Hour

* Minute

End D

o

™
c3
o
=

+ Minute ~ Second -

b. Specify any of the following criteria:

O Severity: Select the severity level of the event.

[ [ [ [ R |

c. Click Apply.

Group: Select the group the device is assigned to.
IP Address: Specify the IP address of the device.
Source: Select the source of the event.

Acknowledge: Select the acknowledgement status of the event.
Start Date: Specify the start date and time for which to display event data.
End Date: Specify the end date and time for which to display event data.

Time Issued

2024-12-28 14:46:21

2024-12-28 14:46:13

2024-12-28 14:42.41

2024-12-28 14:42:33
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4. To sort the data in a specific column, click the column header.

5. To acknowledge all events:
a. Click the Ack All Events () icon in the top-left corner.
The Ack All Events screen will appear.

Ack All Events

All events will be acked. Are you sure you want to

continue this process?

b. When prompted to confirm, click Apply.
MXview One will acknowledge all events displayed in the table.

6. To delete all events:

a. Click the Clear All Events (.-=) icon in the top-left corner.
The Clear All Events screen will appear.

Clear All Events

All system events will be cleared. Are you sure
you want to continue this process?

b. When prompted to confirm, click Apply.
MXview One will delete all events displayed in the table
7. To export data displayed on the Network and Device tab:

a. Click the Export (E) icon.
[ 7
O Export CSV c

Export All Events to C5V
O b

b. Click Export CSV to only export the events on the first page or Export All Events to CSV to export
all events.
MXview One exports the displayed event data as a CSV file.

Configuring Event Thresholds and Severity Levels

Use the Preferences and Global Device Settings screen to configure default event thresholds and
severity levels.
1. Navigate to Menu (E) > Administration > Preferences.
The Preferences screen will appear.
2. In the Advanced section, expand Events.
The Events settings will appear.
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Advanced

Events o
Information v
< Link Dov
Critical '
Warning v

3. Select one of the following severity levels for Link Up events:
» Information
» Warning
» Critical
4. Select one of the following severity levels for Link Down events:
» Information
» Warning
» Critical
5. Select one of the following severity levels for Port Looping events:
» Information
> Warning
» Critical

6. Click Save.
MXview One will update the event severity settings.

7. Navigate to Menu (E) > Administration > Global Device Settings.
The Global Device Settings screen will appear.

/  NOTE

Once you save the settings in the Global Device Settings section, the settings will synchronize to each
device in the topology.

8. To trigger events when network bandwidth utilization exceeds a threshold:
a. Select Enabled from the first Bandwidth Utilization Over drop-down list.

Bandwdth Utilizabion Creer

Enabled v

0 Waming -

b. Specify the percentage of bandwidth utilization for the threshold.
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C.
9. To trigger events when network bandwidth utilization falls below a threshold:
a.

b. Specify the percentage of bandwidth utilization for the threshold.

C.
10. To trigger events when the packet error rate exceeds a threshold:
a.

Bandwdth Utiizabion Crver

Enabled v

Warming

Select the Severity level for the event.

Select Enabled from the first Bandwidth Utilization Under drop-down list.

Bandwsdth Utilizabion Uinder

Enabled -

Waming

Bandwdth Utilizabion Under

Enabled -

1=

Waming

Select the Severity level for the event.

Select Enabled from the first Packet Error Rate Over drop-down list.

Packet Emor Rate Cher

Enabled v
FPackst E Hate Che
0

Waming

b. Specify the packet error rate for the threshold.

C.

11. To trigger events when the SFP TX value is below a certain threshold:

Packet Emor Hate Cher

Enabled -
Facket Error Rate Uhvel
0

Waming

Select the Severity level for the event.
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a. Select Enabled from the first SFP TX Under drop-down list.

SFP TX Under

Enabled v

SFP TX Under * Severity *

0 Warning .
-100-0 dBm

b. Specify the SFP TX threshold level.

SFP TX Under *

Enabled v

SFP TX Under Severity *

-50| $ Warning -
-100-0 dBm

12. To trigger events when the SFP RX value is below a certain threshold:
a. Select Enabled from the first SFP RX Under drop-down list.

SFP RX Under

Enabled ”

SFP RX Under * Severity *

0 Warning b
-100-0 dBm

b. Specify the SFP RX threshold level.

SFP RX Under *

Enabled b

SFP RX Under Severity *

-50] $ Waming ~
-100-0 dBm

13. To trigger events when the SFP voltage is below a certain threshold:
a. Select Enabled from the first SFP Voltage Under drop-down list.

SFP Voltage Under

Enabled v

SFP Voltage Under * Severity *

0 Warning >
0-10 Vv

b. Specify the SFP Voltage threshold level.
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SFP Voltage Under *

Enabled v
SFP Voltage Under Severity *
5 $  Warning -

0-10 v

14. To trigger events when the SFP voltage is over a certain threshold:
a. Select Enabled from the first SFP Voltage Over drop-down list.

SFP Voltage Over

Enabled v

SFP Voltage Over * Severity *

0 Warning bg
0-10 vV

b. Specify the SFP Voltage threshold level.

SFP Voltage Over *

Enabled v

SFP Voltage Over * Severity *

5 Warning v
0-10 Vv

15. To trigger events when the SFP temperature is over a certain threshold:

a. Select Enabled from the first SFP Temperature Over drop-down list.

SFP Temperature Over

Enabled v

SFP Temperature Over * Severity *

0 Warning b
0-100 e

b. Specify the SFP Temperature threshold level.

SFP Temperature Over *

Enabled v
SFP Temperature Over * Severity *
50 Warning v
0-100 °C
&
Ve NOTE

If the threshold is set as '0', the threshold function will be disabled.

16. Click Save.
MXview One will update the event threshold settings.
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Notification Methods

MXview One supports email notifications for events. The notification method requires specific server
configurations.

Configuring Email Server Settings

Use the System Settings screen to configure an email server to send email notifications for event
notifications.
1. Navigate to Menu (E) > Administration > System Settings.
The System Settings screen will appear.
Find the Email Server Configuration section.
Configure the following:
Server Domain Name/IP
Port number
Encryption
Allow Self-signed Certificate
Username
Password

YV V V V VYV VYV V

Sender Address
4. Click Save.
MXview One can send email messages for configured event notifications.

Notification Management

The Notification Management screen allows you to configure event notifications by issuing a registered
action (e.g., sending an email message to a specified recipient) when configured events are detected on
your network.

Notification Management

Notification Setting Notification Output

EJ "Please go to the Notification Qutput tab and add an action
>

ﬂ first"
'
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Configuring New Event Notifications

MXview One event notifications require at least one registered action (e.g., sending an email message to a
specified recipient), which MXview One performs when a specified event is detected on your network.
1. Navigate to Menu (E) > Notification Management.
The Notification Management screen appears.
2. To register an action:
a. Click the Notification Output tab.
The Notification Output tab displays a list of registered actions (if any).

Notification Management

Notification Setting Notification Qutput

(K} Q Search

O Name Type Information

>
s o= 5 2
o /A B Test Email email@example.com

b. Click the Add () icon in the top-left corner.
The Add Notification Output screen will appear.

Add Notification Output

Name *
Type * -
Information *

Cancel

c. In the Name field, type a name to describe the action.
d. From the Type drop-down list, select one of the following actions:
O E-mail: Sends an email to the specified email address.
O Microsoft Teams: Sends a message through Microsoft Teams.
O Message Box: Displays a message box when the event occurs.
e. Provide additional information required for the action (if any).
f. Click Add.
The registered action appears in the table on the Notification Output tab.
3. To add a new event notification:
a. Click the Notification Setting tab.
The Notification Setting tab displays a list of configured event notifications (if any).
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Notification Management

Notification Setting Notification Output
= Q, Sear
O Notification Name Event Registered Devices Registered Outputs
> _
O & W Test Device ICMP unreachable 8 Test,

b. Click the Add () icon in the top-left corner.
The Create Notification screen appears.

Create Notification

Notification Name *

Event * 4

Registered Devices >

Registered Outputs *

Cancel

In the Notification Name field, type a name to describe the event notification.
From the Event drop-down list, select the event type.
From the Registered Devices drop-down list, select the network device(s) you want to monitor.

oo oa o

From the Registered Outputs drop-down list, select the action that MXview One performs when
the specified event is detected on the previously selected device(s).

g. Click Add.
The event notification appears in the table on the Notification Setting tab.

Adding a Microsoft Teams Action

Use the Notification Output tab on the Notification Management screen to add a Microsoft Teams
notification action.

1. In Microsoft Teams, go to the channel you want to add the incoming webhook to.
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2. Click More options (...) next to the channel name.

o

7 Teams - Q v
Activity
@ Unread
Chat
000 <, Discover
(]}
Teams @ Mentions
v Teams and channels
Calendar

.
% v n More options

Calls
Teams Notification B
(5

3. Select Manage channel.
£ Channel notifications
Show in >

R Hide

é)g Add members

/’ Rename channel

€§3 Manage channel

4. In the Connectors section on the Settings tab, click the Edit button.

Teams Notification Settings Analytics

' Channel details Edit channel name and description

Teams Notification

 Moderation Set channel moderation preferences

General Channel:

@ Anyone can post messages

0 Anyone can post; show alert that posting will notify everyone (recommended
for large teams)

(O Only owners can post messages

v Connectors Manage the connectors that post to this channel
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5. Search for Incoming Webhook and click the Configure button.
The Incoming Webhook will appear.

Incoming Webhook Search Results Sort by Popularity v
R Connectors for your team
MANAGE
] :

3 Incoming Webhook
Configured N

J CI" Send data from a service to S lE
My Accounts your Office 365 group in real

time.

CATEGORY

6. Enter a name for the webhook and upload a custom icon (optional), then click Create.

Connectors for "Teams Notification" channel in X
team
The Incoming Webhook connector enables external services to notify you about
activities that you want to track. To use this connector, you'll need to create certain
settings on the other service, which needs to support a webhook that's compatible
with the 'Office 365 connector format'.
Fields marked with * are mandatory

To set up an Incoming Webhook, provide a name and select Create. *

Test1201

Customize the image to associate with the data from this Incoming Webhook.

Upload Image

&

Default Image

=)

7. Copy the URL shown in the pop-up window to your clipboard and click Done.

8. In MXview One, navigate to Menu (E) > Notification Management.

9. Click the Notification Output tab.

10. Click the Add () icon in the top-left corner.
The Add Notification Output screen will appear.

11. In the Name field, enter a descriptive name for action.
12. From the Type drop-down menu, select Microsoft Teams.
13. In the Webhook field, paste the webhook URL copied from the Microsoft Teams.
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14. Click Test Connection to verify the webhook works properly.

Add Notification Output

Teams

Microsoft Teams v

https://moxa.webhook.office.com/webt
-

If successful, you will receive a message in the linked Microsoft Teams channel.

p Test1201 8:55PM [ New ]

MXviewQOne connection test ...

15. Click Add.
The registered action appears in the table on the Notification Output tab.

Editing or Exporting Registered Actions

Use the Notification Output tab on the Notification Management screen to edit registered actions or

export a CSV file containing registered action information.

1. Navigate to Menu (E) > Notification Management.
The Notification Management screen will appear.
2. Click the Notification Output tab.
The Notification Output tab displays a list of registered actions.
3. To edit a registered action:
a. Click the Edit (#") icon next to the action you want to edit.
The Edit Notification Output screen will appear.

Edit Notification Output

Test

Email i

email@example.com

Cance' m

b. Modify the following settings:
O Name
O Type
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O Information
c. Click Apply.
The Notification Output screen appears and displays the updated action information.

4. To export data displayed on the Notification Output tab:

a. Click the Export (E) icon.

-+ I

Export CSV
D p

b. Select Export CSV.
MXview One exports the displayed action data as a CSV file.

Editing or Exporting Notification Configurations

Use the Notification Setting tab on the Notification Management screen to edit configured notifications
or export a CSV file containing notification configuration information.
1. Navigate to Menu (E) > Notification Management.

The Notification Management screen will appear.
2. Click the Notification Setting tab.

The Notification Setting tab displays a list of configured notifications.
3. To edit a notification:

a. Click the Edit (#") icon next to the notification you want to edit.

The Edit Notification screen will appear.

Edit Notification

Test

Device ICMP unreachable -
All devices -
Test -

Content

CanCEI m

b. Maodify the following settings:
O Notification Name
O Event
O Registered Devices
O Registered Outputs
c. Click Apply.
The Notification Setting screen appears and displays the updated notification information.
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4. To export data displayed on the Notification Setting tab:

a. Click the Export (E) icon.

-+ IR

Export CSV
O

b. Select Export CSV.
MXview One exports the displayed notification data as a CSV file.

Custom Event Management

To access the Custom Event tab, in the function tree, navigate to Menu (E) > Event Management >
Event Settings and go to the Custom Event tab.

The Custom Event screen provides information about all the custom events configured on MXview One.
You can use the Custom Event tab to view whether a custom event is enabled or disabled, modify a
custom event, or export custom event configurations as a CSV file.

Event Settings
Custom Event Cybersecurity Event

All(1)
vl Q
I Critical (0)
— O Event Name Enabled/Disabled Condition Description Recovery Description Duration

Waming (0)
>

Registered Devices

| P sysUpTime Enabled Not Equal 0 0 1
| |
] Information (1)

Configuring Custom Events

The Custom Event tab allows you to define your own events to monitor with flexible detection thresholds,
severity levels, and duration times.

Navigate to Menu (E) > Event Management > Event Settings.
2. Go to the Custom Event tab.

The Custom Event screen will appear.
3. Click the Add () button in the top-left corner of the screen.

The Add Custom Event screen will appear.
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Add Custom Event

Enabled -

Cancel

4. Select the default event status:
» Enabled: MXview One monitors the event
> Disabled: MXview One does not monitor the event
5. Select one of the following severity levels for the event:
» Information
» Warning
» Critical
Click the Device Properties and select the device property to monitor.
Configure the following threshold criteria:
» Condition Operator: Select the criteria operator for matching the condition value
» Condition Value: Specify the value for the criteria operator to match

8. (Optional) In the Description field, type a string (up to 250 characters in length) to describe the
custom monitoring.

9. (Optional) In the Recovery Description field, type a string (up to 250 characters in length) to describe
how to recover from the event.

10. In the Duration field, users can specify how many times an event can happen without any action being
taken. If the number of times the event happens exceeds the Duration, then MXview One will send an
alert.

11. From the Register Devices drop-down list, select the devices to monitor for the custom event.
12. Click Add.
The custom event appears in the Custom Event table.

/  NOTE

If the threshold is set as '0', the threshold function will be disabled.
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Viewing or Exporting Custom Event Settings

1. Navigate to Menu (E) > Event Management > Event Settings.
2. Go to the Custom Event tab.

The Custom Event screen will appear and displays the following information in a table format:

Column Description

Event Name The name of the event

Enabled/Disabled The monitoring status of the event

Condition The threshold criteria configured for the event

Description The description of the event

Recovery Description The recovery description of the event

Duration The number of times of consecutive pollings for the event
Registered Devices The number or registered devices that the event applies to

3. To search for information in the table, type a full or partial string that matches the value in any of the
table columns.

MXview One filters the table to only display events with values that fully or partially match the specified
string.

4. To filter the information in the table by event severity, click one of the color-coded severity levels in the
left-side panel.

All (0)

| Critical (0)

Warning (0)

| Information (0)

MXview One filters the table to only display events that match the selected severity level.
5. To sort the data in the table by a specific column, click the column heading.
MXview One sorts the table by the column.
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6. To export data displayed on the Custom Event tab:

a. Click the Export (E) icon.

[+ I

Export CSV

0

b. Select Export CSV.
MXview One exports the displayed event data as a CSV file.

Enabling/Disabling or Editing Custom Events

To enable or disable a custom event, edit the custom event settings.

Navigate to Menu (E) > Event Management > Event Settings.
2. Go to the Custom Event tab.

The Custom Event screen will appear and display a list of configured custom events.
3. Click the Edit (#") icon next to the event you want to enable/disable.

The Update Custom Event screen will appear.

Update Custom Event
Enabled . -
F:r\t\cal 1
DslLed1

Over. | - j(]

The DslLed1 is over 10.

Recovery

All devices -

g m

4. From the Enable Custom Event drop-down list, select one of the following:
> Enabled
> Disabled
5. Modify any additional event settings you wish to change.
Click Apply.
The Custom Event screen will appear and display the updated event information.

/  NOTE

If the threshold is set as '0', the threshold function will be disabled.
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Syslog Settings
MXview One features a built-in syslog server to receive and log syslog events from devices. Users can also

define filtering rules, allowing MXview One to forward syslog events that match these rules to one or
multiple external syslog servers.

Enabling/Disabling the Built-in Syslog Server
1. Navigate to Menu (E) > Event Management > Syslog Settings.
The Syslog Settings screen appears.

2. Go to the Syslog Server Settings tab.

Syslog Settings

Syslog Server Settings Syslog Viewer Syslog Forwarding
Disabled A
514
5143 Disabled -

3. To enable the syslog server:
a. In the Built-in Syslog Server field, select a syslog mode.
O Enable (UDP only): Enable the syslog server and restrict it to UDP only.
O Enable (TCP only): Enable the syslog server and restrict it to TCP only.
O Enable (UDP & TCP): Enable the syslog server and make it accessible via TCP and UDP.
b. Specify the syslog server's UDP port. The default port number is 514.
c. Specify the syslog server's TCP port. The default port number is 5143.
d. Select an authentication mode:
O Disabled: Do not require authentication.
O TLS only: Use TLS authentication.
O TLS + certificate: Use a combination of TLS and certificates for authentication.
e. Click Save.

/ NOTE

If you selected TLS + certificate as the authentication method, the Download and manage
certificates from the MXview One Control Panel message will show. Click the link to go to MXview
One Control Panel for managing the syslog server certificate.

4. To disable the syslog server:
a. In the Built-in Syslog Server field, select Disabled.
b. Click Save.

Viewing Syslog Events

Use the Syslog Viewer tab on the Syslog Settings screen to view information about syslog events on
your network. Use the filters to customize the information displayed in the table. You can also export the
data as a CSV file.
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= MXview ONE

Syslog Settings

Syslog Server Settings Syslog Viewer

= @& W

=

Severity Time Stamp

@English & admin¥

Syslog Forwarding

Q Search
IP Address Facility Message

= 100 -

1. Navigate to Menu (E) > Event Management > Syslog Settings.
The Syslog Settings screen appears.

2. Go to the Syslog Viewer tab.
The Syslog Viewer screen displays the following information in a table format:

Column Description

Severity The severity of the event

Time Stamp The time the event was issued

IP Address The IP address of the device that issued the event
Facility The group the device is assigned to

Message The description of the event

3. To search the information in the table, type a full or partial string that matches the value in any of the

table columns.

MXview One searches the table to only display results that fully or partially match the specified string.

4. To filter the information in the table by specific criteria:

a. Click the Filter (<) icon in the top-left corner.

The following screen will appear.

IP Address

Facility v

Priority v  Severity -
Start Date @ Hour v Minute ”

End Date B Hour ¥ Minute -

b. Specify any of the following criteria:

Criteria Description
IP Address Specify the IP address of the device that issued the event
Facility Select the group to which the device is assigned

Select the criteria operator for matching the event severity level:
Priority o Higher than or equal to

¢ Equals

e Lower than or equal to
Severity Select the severity level of the event
Start Date Specify the start date and time for the event data to display
End Date Specify the end date and time for the event data to display

c. Click Apply.
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MXview One filters the table to only display events that match the specified criteria.
5. To sort the data in the table by a specific column, click the column heading.
MXview One sorts the table by the column.

6. To export data displayed on the Syslog Viewer screen:

a. Click the Export (E) icon.

= [

Site Export CSV te

Export All Syslog to CSV

b. Select Export CSV for just the first syslog page or Export All Syslog to CSV for all syslog pages.
MXview One exports the displayed syslog data as a CSV file.

7. To clear all syslog data, click the Clear All Events ( .-=) icon.
MXview One clears all syslog data on the Syslog Viewer screen.

Enabling/Disabling Syslog Forwarding

From the Syslog Forwarding tab on the Syslog Settings screen, you can enable or disable the syslog
forwarding function and define the filtering rules. MXview One will act as a syslog forwarder and forward the
syslog events that match the configured rules to one or multiple external syslog servers.

Syslog Settings
Syslog Server Settings Syslog Viewer Syslog Ferwarding
A
Disabled A
ubP L4
Remote IP/Domain Na Port
|| Remote IP/Domain Na Port

>

" Syslog Filters (1/128)

[] Any IP All -

1. Navigate to Menu (E) > Event Management > Syslog Settings.
The Syslog Settings screen appears.

2. Go to the Syslog Forwarding tab.
3. To enable syslog forwarding:
a. Configure the following settings:
O Syslog Forwarding: Select Enabled.
O Protocol: Select the communication protocol (UDP or TCP).
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O Authentication: If you selected TCP as the Protocol, select an authentication method
(Disabled, TLS only, TLS + certificate).

/7  NOTE

If you selected TLS + certificate as the authentication method, the Download and manage
certificates from the MXview One Control Panel message will show. Click the link to go to MXview
One Control Panel for managing the syslog forwarding certificate.

O Remote IP/Domain Name 1/2: Specify the IP address or domain name of the 1st and 2nd
syslog server.

O Port 1/2: Specify the port number of the 1st and 2nd syslog server.

b. In the Syslog Filters section, configure the syslog filtering rules. The default rule is Source

IP=Any IP, Severity=All, meaning MXview One will forward all syslog events from all sources and
all severities.

To add a filtering rule, click the Add () icon and configure the following settings:

O Source IP: Specify the IP addresses of the device(s) you want to forward syslog events for.
You can enter multiple IP addresses, separated by a comma.

Syslog Filters (1/128)
o You can enter multiple source IP addresses, separated by a comma

Source IP

[] 192.168.127.1,192.168.127.2 All -

O Severity: Select the event severity level(s) that will be forwarded.

Al -
Debug(7)

H Info(6)
Notice(5)

Warning(4)

/  NOTE

MXview One supports a maximum of 128 syslog forwarding filtering rules.

c. To delete a filtering rule, click the Delete (i) icon next to the rule you want to delete.
d. Click Save.
MXview One will forward any syslog events that match the configured rules.
4. To disable syslog forwarding:
a. In the Syslog Forwarding field, select Disabled.
b. Click Save.
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15. Inventory Management

The Inventory Management section allows users to manage device inventory, check warranty
information, and manage rogue devices.

Assets and Warranty

Asset List Overview

To access the Asset List page, in the function tree, navigate to Menu (E) > Inventory Management >
Assets and Warranty and go to the Asset List tab.

The Asset List section provides a summary of key information about your network devices.

Assets and Warranty
Asset List Warranty Management Warranty Notifications
B = Q
Alias Model [ MAC Address Firmware Version Serial Number Warranty End Date Gurgsl i::":::wa“m [ ]
192.168.123.70-AWK-32524 AWK-3252A 19216812370  O00:90:ES00.0412  v2.0Build 2023 02171145 WA
192.168.123.71-Unknown Device Unknown Device  192.168.123.71 N/A
192.168.123.72-AWK-1151C AWK1151C 19216812372  0090ES051745  v20Build2022.1007.1814  ABCDE1234587 N/A
> 192.168.123.151-EDS-G516E EDS-G516E 192168123151  00:00:ES44SZAE V62 build 20080519 06820 N/A
192.168.123.152-EDS-518A EDS5184 192168123152 0090EB00:00:55 V3.9 build 21110513 N/A
192.168.123.157-IEX-402:SHDSL IEX-402SHDSL 192168123157  00:90ESD1:0210  V1.0build 12112811 N/A
192.168.127.2-1CMP Device ICMP Device 192168.127.2 0021:01:5C:3091 A
192.168.127.15-MDS-G4028 MDS-G4028 19216812715  O090ESTA0863  v5.0Build2024 0610.2008  TAICB1123037 WA

This page displays the following information in a table format:

Column |Description
Alias The unique name of the device.
Model The model number of the device.
IP The IP address of the device.
MAC Address The MAC address of the device.
Firmware Version The firmware version of the device.
Serial Number The serial number of the device.
Warranty End Date The date the device warranty expires.
Channel Extended Warranty |The expiration date of the extended device warranty provided by your channel
End Date representative.
g
V4 NOTE

The Channel Extended Warranty End Date value is provided by the channel partner and must be
entered by the user. Refer to Editing the Channel Extended Warranty End Date.
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Searching the Asset List

. Navigate to Menu (E) > Inventory Management > Assets and Warranty.
2. Go to the Asset List tab.

3. In the Search ( o\) field, type the full or partial information.
All items matching the entered string will be shown in the table.

Exporting the Asset List

. Navigate to Menu (E) > Inventory Management > Assets and Warranty.
2. Go to the Asset List tab.

3. Click the Export (B) icon in the top-left corner of the table.
MXview One exports the asset list as a CSV file.

Editing the Asset List Layout

. Navigate to Menu (E) > Inventory Management > Assets and Warranty.
2. Go to the Asset List tab.

3. Click the Edit Columns ( —=V) icon in the top-left corner of the table.

The Edit Columns window will appear.

Edit Columns

Adjustable Columns

Alias ®
i Model ®
P ®
# MAC Address ®
Firmware Version ®©
#  Serial Number ®
Warranty End Date ®
i Channel Extended Warranty End Date ®

Close m

4. To show or hide a column:

a. Click the Visible (0) and Hidden (Q) icons to toggle column visibility.

5. To change the column order:

a. Click and drag the Drag (55) icon of the column you want to move.

Alias ©®©

b. Drag the column to the desired position and release the mouse.
6. To revert all changes to column visibility and order, click Reset.
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7. Click Save.

Warranty Management Overview

To access the Warranty Management page, in the function tree, navigate to Menu (E) > Inventory
Management > Assets and Warranty and go to the Warranty Management tab.

The Warranty Management section shows warranty information for your devices.

Assets and Warranty

Asset List Warranty Managemen

arranty Notifications

Check Warranty Status Manually Check Warranty

Moxa Warranty Server Status: Available
Last Update: 2024-07-22 PM 02:41:54

O Alias P

[0 192.168.123.70-AWK-3252A 192.168.123.70

[0 192.168.123.71-Unknown Device 192.168.123.71

Serial Number -

Q,

Channel Extended

MAC Address Serial Number Warranty Duration Warranty Start Date Warranty End Date Warranty End Date

© Warranty Status
00:90:£8:00:04:12 F A N/A

7 A N/A

This page displays the following information in a table format:

Column |Description
Alias The unique name of the device.
IP The IP address of the device.

MAC Address

The MAC address of the device.

Serial Number

The serial number of the device.

Warranty Duration

The warranty duration of the device.

Warranty Start Date

The date the device warranty starts.

Warranty End Date

The date the device warranty expires.

Channel Extended Warranty
End Date

The expiration date of the extended device warranty provided by your channel
representative.

Warranty Status

The current warranty status of the device.

Valid: The warranty is active and valid. The remaining duration (in days)
between the current date and the Warranty End Date/Channel Extended
Warranty End Date is greater than the threshold value configured for the
Send Reminder field on the Warranty Notifications tab. Refer to Enabling
Warranty Expiration Notifications.

Expires soon: The warranty is active and valid. The remaining duration (in
days) between the current date and the Warranty End Date/Channel
Extended Warranty End Date is equal to or less than the threshold value
configured for the Send Reminder field on the Warranty Notifications tab.
Refer to Enabling Warranty Expiration Notifications.

Expired: The device warranty has exceeded the warranty period.

/  NOTE

The Channel Extended Warranty End Date value is provided by the channel partner and must be

entered by the user. Refer to

Editing the Channel Extended Warranty End Date.

Checking the Warranty Status of All Devices

1. Navigate to Menu (E) > Inventory Management > Assets and Warranty.
2. Go to the Warranty Management tab.
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3. The Check Warranty Status section includes the following information:

Check Warranty Status

Moxa Warranty Server Status: Available
Last Update: 2024-06-05 PM 02:05:59

» Moxa Warranty Server Status: This indicates the status of the connection to the Moxa warranty
server. If this connection is unavailable, the warranty table cannot be updated until the connection
to the warranty server is restored.

» Last Update: Shows the date and time the warranty table was last checked and updated.

4. Click Retrieve Data.
MXview One will check for updates and refresh the table.

Checking the Warranty Status of a Specific Device

1. Navigate to Menu (E) > Inventory Management > Assets and Warranty.
2. Go to the Warranty Management tab.
3. The Manually Check Warranty section includes the following information:

Manually Check Warranty

Serial Number *  Serial Number

> Search by: Select the criteria to search for warranty information, either based on serial humber or
MAC address.

> Serial Number: If Serial Number is selected in the Search by field, specify the serial number of
the device to check warranty information for.

» MAC Address: If MAC Address is selected in the Search by field, specify the MAC address of the
device to check warranty information for.

4. Click Check.
MXview One will check and show the warranty information for the specified criteria.
Searching the Warranty Management List
1. Navigate to Menu (E) > Inventory Management > Assets and Warranty.

2. Go to the Warranty Management tab.

3. In the Search ( O\) field, type the full or partial information.
All items matching the entered string will be shown in the table.
Exporting the Warranty Management List

1. Navigate to Menu (E) > Inventory Management > Assets and Warranty.
2. Go to the Warranty Management tab.

3. Click the Export (E) icon in the top-left corner of the table.
MXview One exports the warranty management table as a CSV file.
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Editing the Warranty Management List Layout

Navigate to Menu (E) > Inventory Management > Assets and Warranty.
2. Go to the Warranty Management tab.

3. Click the Edit Columns ( —=~/) icon in the top-left corner of the table.

The Edit Columns window will appear.

Edit Columns

Adjustable Columns A
Alias ©®
P ®
MAC Address ©
Serial Number (o]
Warranty Duration (O]
Warranty Start Date ®
Warranty End Date ®
Channel Extended Warranty End Date @

£ Warrantv Status ® <

4, To show or hide columns:
a. Click the Visible (@) and Hidden (Q) icons to toggle column visibility.

5. To change the column order:

a. Click and drag the Drag (55) icon of the column you want to move.

Alias ©®

b. Drag the column to the desired position and release the mouse.
To revert all changes to column visibility and order, click Reset.
7. Click Save.

Editing the Channel Extended Warranty End Date

Navigate to Menu (E) > Inventory Management > Assets and Warranty.
Go to the Warranty Management tab.
Check the box of the device(s) you want to edit the Channel Extended Warranty End Date for.

>N

Click the Edit (#') icon in the Channel Extended Warranty End Date column of the device you want
to edit.
If you selected multiple devices, click the Edit (#) icon in the top-left corner of the page.

.

]
B Alies P MAC Address Serial Number  Warranty Duration ~ Warranty StartDate  Warranty End Date Channel Extended

Warranty Stat
Warranty End Date ©  varany staws

192.168.123.70-AWK-3252A 192.168.123.70 N/A N/A
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The Channel Extended Warranty End Date window will appear.

Channel Extended Warranty End Date

mm/dd/yyyy

Cancel Reset

5. To update the channel extended warranty end date:

a. Click the Calendar () icon to select the new warranty end date.

b. Click Apply.

MXview One will update the channel extended warranty end date value and warranty status
according to the new end date.

O Alies P MAC Address SerialNumber  Warranty Duration  Warranty StartDate  Warranty End Date Channel Extended @y 11y Status
i r rial Number y Durati rranty rranty R ranty Status

O 192168.123.70-AWK-3252A 192.168.123.70 Q@) valid
6. To reset the channel extended warranty end date:
a. Click Reset.
MXview One will update the channel extended warranty end date value to its default value of N/A.

O Alas P MAC Address Serial Number Warranty Duration  Warranty Start Date Warranty End Date Channel Exdended] © warranty Status.
Y v Y Warranty End Date .

[ 192168.123.70-AWK-3252A 192.168.123.70 /' A N/A

Warranty Notifications Overview

To access the Warranty Notifications page, in the function tree, navigate to Menu (E) > Inventory
Management > Assets and Warranty and go to the Warranty Notifications tab.

From the Warranty Notifications tab, you can enable and configure warning notifications to inform you
when a device’s warranty is about to expire.

Enabling Warranty Expiration Notifications

1. Navigate to Menu (E) > Inventory Management > Assets and Warranty.
2. Go to the Warranty Notifications tab.
3. Configure the following settings:

a. Enabled: Enable or disable warranty expiration notifications.

b. Send Reminder: Specify how many days before the Warranty End Date/Channel Extended
Warranty End Date you want to receive a notification.

c. Email to: Enter the email address of the warranty notification recipient(s).

/7  NOTE

You can add multiple recipient email addresses, separated by a comma.

4. Click Save.

MXview One will send an email notification to the specified recipients when the number of days from the
current date to the device Warranty End Date/Channel Extended Warranty End Date is equal to the
value set in the Send Reminder field.
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Rogue Device Detection

From the Rogue Device Detection section, users can create a baseline of the currently monitored devices.
When MXview One detects an unknown device connection that is not part of this baseline, the system will
identify and show information about this rogue device. This feature can help users manage the connection
status of devices within their network, preventing unknown devices from gaining access to the network.

Rogue Device Settings Overview

To access the Rogue Device Settings page, in the function tree, navigate to Menu (E) > Inventory
Management > Rogue Device Detection and go to the Rogue Device Settings tab.

From the Rogue Device Settings tab, you can create a device baseline and enable the rogue device
detection function.

Rogue Device Detection

Rogue Device Settings

Device Baseline Rogue Device Detection

Created on: N/A

m No device baseline exist. Create a baseline first.

Creating a Device Baseline

1. Navigate to Menu (E) > Inventory Management > Rogue Device Detection.
2. Go to the Rogue Device Settings tab.
3. The Device Baseline section includes the following information:

Device Baseline

Created on: N/A

» Created on: Shows the date and time when the most recent baseline was created. If no baseline
has been created before, this will show N/A.
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4. Click Create.
The Device Baseline window will appear.

Device Baseline

This operation will create a new baseline and will
overwrite the existing one.

Cancel Create

5. Click Create.
MXview One will create a baseline of the currently monitored devices and enable the Rogue Device

Detection function.

Rogue Device Detection

Rogue Device Settings Device Baseline Current Rogue Devices Rogue Device History

Device Baseline Rogue Device Detection

Created on: 2024-07-23 AM 03:50:53 EnaR
Enabled -

Enabling/Disabling Rogue Device Detection

/ NOTE

To enable or disable Rogue Device Detection, a device baseline must be created first. Refer to Creating a
Device Baseline.

1. Navigate to Menu (E) > Inventory Management > Rogue Device Detection.
2. Go to the Rogue Device Settings tab.
3. In the Rogue Device Detection section, configure the following settings:

Rogue Device Detection

Enabled v

> Enabled: Enable or disable the Rogue Device Detection function.
4. Click Save.

/  NOTE

After creating a device baseline and enabling the Rogue Device Detection function, you can add devices
to the baseline via the Device Discovery function or by Adding a Rogue Device to the Baseline.
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Device Baseline Overview

To access the Device Baseline page, in the function tree, navigate to Menu (E) > Inventory
Management > Rogue Device Detection and go to the Device Baseline tab.

From the Device Baseline tab, you can view information about the devices included in the most recent
baseline. From this screen, you can also add or remove devices from the baseline and export the device

baseline.
Rogue Device Settings Device Baseline Current Rogue Devices Rogue Device History
&3] Q_ Sear
O MAC Address IP Address NIC Vendor
i 00:90:E8:44:52:AE 192.168.123.151 Moxa Technologies CORP. Lid
i 00:90:E8:00:00:55 192.168.123.152 Moxa Technologies CORP. Ltd

This page displays the following information in a table format:

Column Description

MAC Address The MAC address of the device.

IP Address The IP address of the device.

NIC Vendor The vendor of the device’s network interface card.

Searching the Device Baseline
Navigate to Menu (E) > Inventory Management > Rogue Device Detection.

2. Go to the Device Baseline tab.

3. In the Search ( O\) field, type the full or partial information.
All items matching the entered string will be shown in the table.

Adding a Device to the Baseline

Navigate to Menu (E) > Inventory Management > Rogue Device Detection.
2. Go to the Device Baseline tab.

3. Click the Add () icon in the top-left corner of the screen.

The Add Device to Baseline screen will appear.

Specify the MAC address of the device you want to add to the baseline.
5. Click Add.

Deleting Devices From the Baseline

/  NOTE

If a device that was removed from the baseline attempts to reconnect, MXview One will identify the device

as a rogue device and add it to the Current Rogue Devices list. Refer to Current Rogue Devices
Overview.

1. Navigate to Menu (E) > Inventory Management > Rogue Device Detection.
2. Go to the Device Baseline tab.
To delete a single device:
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a. Click the Delete (.) icon next to the device you want to delete from the baseline.
The Delete Device From Baseline screen will appear.

Delete Device From Baseline

This device will be removed from the baseline
and added as a rogue device.

3. To delete multiple devices:
a. Check the box of the devices you want to delete from the baseline.
b. Click the Delete (.) icon in the top-left corner of the screen.
The Delete Device From Baseline screen will appear.

Delete Device From Baseline

These devices will be removed from the baseline

and added as rogue devices.

4. Click Delete.

Exporting the Device Baseline

1. Navigate to Menu (E) > Inventory Management > Rogue Device Detection.

2. Go to the Device Baseline tab.

3. Click the Export (E) icon in the top-left corner of the table.

MXview One exports the device baseline as a CSV file.
Current Rogue Devices Overview

To access the Current Rogue Devices page, in the function tree, navigate to Menu (E) > Inventory
Management > Rogue Device Detection and go to the Current Rogue Devices tab.

From the Current Rogue Devices tab, you can view information about rogue devices detected on your
network.

Rogue Device Detection

Rogue Device Settings Device Baseline Current Rogue Devices Rogue Device History

= Q_ Search
O MAC Address IP Address First Seen Last Seen Connected Switch/Port NIC Vendor
D 00:90:€8:05:17:45 192.168.123.72

2024-07-23 AM 03:50:59 2024-07-23 AM 10:12:45 192.168.123.70 Moxa Technologies CORP. Ltd
B O 00:0C:29:29:C6:3C 192.168.123.209 2024-07-23 AM 03:51:36 2024-07-23 AM 10:12:43 192.168.123.152/Port1 Vmware Inc

This page displays the following information in a table format:
(ol [1])31)]

|Description
MAC Address The MAC address of the rogue device.
IP Address The IP address of the rogue device.
First Seen The date and time MXview One first detected the rogue device.
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Last Seen The date and time MXview One last detected the rogue device.
Connected Switch/Port The switch device and port the rogue device is connected to.
NIC Vendor The vendor of the rogue device’s network interface card.
g
#/  NOTE

It is possible to see the same IP listed with different MAC addresses in the rogue device list. This could

indicate one of the following situations:

e A single device with multiple MAC addresses: In addition to a CPU MAC address, certain Moxa products
(e.g. EDS-(G)4000 Series, MDS-G4028 Series, etc.) and some third-party devices have an individual

MAC address for each port.
o Different devices using the same IP address: Different devices using an identical IP address indicate a

possible IP conflict. To avoid issues, identify and resolve any IP conflicts.

Searching the Current Rogue Devices List

Navigate to Menu (E) > Inventory Management > Rogue Device Detection.
2. Go to the Current Rogue Devices tab.

3. In the Search ( o\) field, type the full or partial information.
All items matching the entered string will be shown in the table.

Adding a Rogue Device to the Baseline

Navigate to Menu (E) > Inventory Management > Rogue Device Detection.
2. Go to the Current Rogue Devices tab.

3. Click the Add () icon next to the rogue device you want to add to the baseline.
To add multiple rogue devices to the baseline, check the box of the devices you want to add and click

the Add () icon in the top-left corner of the screen.

(-] MAC Address IP Address First Seen Last Seen Connected Switch/Port NIC Vendor

00:0C:29:36:3E:B8 2024-06-26 PM 04:28:43 2024-06-26 PM 04:28:43 192.168.127.14/Port7 Vmware Inc

00:0C:29:43:60:88 192.168.127.186 2024-06-26 PM 04:28:43 2024-06-26 PM 04:28:43 192.168.127.14/Port7 Vmware Inc

The Add Device to Baseline window will appear.

Add Device to Baseline

Are you sure you want to add this device to the

baseline?

4. Click Add.

Exporting the Current Rogue Devices List

Navigate to Menu (E) > Inventory Management > Rogue Device Detection.

2. Go to the Current Rogue Devices tab.

3. Click the Export (E) icon in the top-left corner of the table.
MXview One exports the current rogue devices list as a CSV file.
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Rogue Device History Overview

To access the Rogue Device History page, in the function tree, navigate to Menu (E) > Inventory

Management > Rogue Device Detection and go to the Rogue Device History tab.

From the Rogue Device History tab, you can view information about rogue devices that were originally in

the Current Rogue Devices list but are currently no longer detected by MXview One.
Rogue Device Detection

Rogue Device Settings Device Baseline Current Rogue Devices Rogue Device History

[ |

Q,se
Sequence No. MAC Address IP Address First Seen Last Seen NIC Vendor
18 00:90:E8:0E:BC:05 192.168.127.118 2024-07-23 AM 03:57:36 2024-07-23 AM 10:33:35 Moxa Technologies CORP: Ltd
| 17 AC:E7:05:0A:02:2B 192.168.127.117 2024-07-23 AM 03:57:36 2024-07-23 AM 10:33:11 Siemens Industrial Automation Products Ltd., Chengdu
This page displays the following information in a table format:
Column Description
Sequence No. The index of the history record.
MAC Address The MAC address of the rogue device.
IP Address The IP address of the rogue device.
First Seen The date and time MXview One first detected the rogue device.
Last Seen The date and time MXview One last detected the rogue device.
NIC Vendor The vendor of the rogue device’s network interface card.

Searching the Rogue Device History
Navigate to Menu (E) > Inventory Management > Rogue Device Detection.

2. Go to the Rogue Device History tab.

3. In the Search ( O\) field, type the full or partial information.
All items matching the entered string will be shown in the table.
Exporting the Rogue Device History

Navigate to Menu (E) > Inventory Management > Rogue Device Detection.
2. Go to the Rogue Device History tab.

3. Click the Export (E) icon in the top-left corner of the table.
MXview One exports the rogue device history as a CSV file.

Clearing the Rogue Device History

Navigate to Menu (E) > Inventory Management > Rogue Device Detection.
2. Go to the Rogue Device History tab.

3. Click the Delete ( '5) icon in the top-left corner of the screen.

The Clear Rogue Device History window will appear.
e 5

Clear Rogue Device History

All rogue device history will be cleared. Are you

sure you want to continue?
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4. Click Delete.
MXview One will clear the rogue device history.
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16.

Backups, Restores, and Compares

The MXview One web console provides several features to assist database backups and device configuration
migrations. MXview One allows you to back up or restore configurations for multiple devices, and also
compare changes between different versions of archived configuration files. You can also create scheduled
jobs to automatically export/import device configurations or back up the MXview One database.

Backing Up the MXview One Database

Use the DB Backup & Restore screen on the Control Panel to back up the MXview One database.

1.

uos W

Navigate to DB Backup & Restore on the MXview One Control Panel.
The Database Backup & Restore screen appears.

MXview One Control Panel

Server Control

Backup Restore

Caonfiguration

DB Backup & Restore

Name *

Plug-in Manager

Certificate

Choose the Backup tab to start the process of backing up the database.
In the Name field, specify the backup file name.
Click Save.

The message that the file of the backup database has been stored in the specified directory will be
displayed.

The database has been backed up to

C:\Users\ \AppData\Roaming\moxa\mxview
one\db_backup\20230709_120518

The Database backup completed will appear on the Historical backups list.

MXview One Control Panel

Server Control
Configuration

I DB Backup & Restore

Name * Backup test

Historical backups

Plug-in Manager

Certificate

Version Name Date Time
| Backup test 20221215 13:23:37
o Backup test2 20221215 13:42:02
[ XXX-20221223 20221223 14:09:09
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Backing Up Device Configurations

Use the Device Configuration Center screen to export configuration backup files from one or more
devices.

1.

Navigate to Menu (E) > Device Configuration Center.
The Device Configuration Center screen appears.

Click the Backup tab.

Available devices will appear in the Device List.

Configuration Center

Backup Restore Records

Device List
= @ Q Sea

IP Address Alias Name Group
10.81.10.10 EDS-510E Root
10.81.10.11 EDS-510E Root
10.81.10.12 EDS-510E Root
10.81.10.13 EDS-510E Root

10.81.10.14 EDR-810 Root

O0O0o0oo0oo
[ 1~ U - Y- Y- 1

10.81.10.15 EDS-510E Root

(Optional) Filter the devices in the Device List:

a. Click the Filter (<) icon.

b. Specify any of the following criteria:
O Group: The group in the MXview One tree structure that the device is assigned to
O IP Address: The IP address of the device

c. Click Apply.
MXview One filters the Device List according to the specified criteria.

To export the device list from all available devices:

a. Click the Export (@) icon.

[+

Export CSV

O

MXview One exports the 'All available devices' list as a CSV file.
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5. To back up configurations from specific devices:

a.

b.

C.

Select the check box next to the device(s) you want to back up.

Click the Backup (B) icon in either of the following locations:
O For a single device, click the Backup (B) next to the selected device.

O For multiple devices, click the Backup (B) icon in the upper left corner of the screen.

The Backup Configuration screen appears.

Back Up Configuration

MXview One will archive these configuration files
192.168.127.152
192.168.127.153
192.168.127.154
192.168.127.155
192.168.127.156

Click Save.

MXview One archives configuration files from selected device(s) to the MXview One server and
displays them in the Records tab. Also, MXview One will export configurations from the selected
device(s) as a ZIP file.

For more information, please see the following topics:
Comparing Archived Configuration Files

/7 NOTE

If MXview One compares two configuration files and they are the same, it will only leave the latest one. If
the two configuration files are different, MXview One will keep both in the Records tab.
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Restoring Device Configurations

Use the Configuration Center screen to restore configurations to one or more devices by restoring an
archived configuration from the MXview One server or importing a local configuration backup file (in INI
format).
1. Navigate to Menu (E) > Device Configuration Center.

The Device Configuration Center screen will appear.
2. Click the Restore tab.

Available devices will appear in the Device List.

Configuration Center

Backup Restore Records

Device List
=@ Q_ Searct

IP Address Alias Name Group
10.81.10.10 EDS-510E Root
10.81.10.11 EDS-510E Root
10.81.10.12 EDS-510E Root
10.81.10.13 EDS-510E Root

10.81.10.14 EDR-810 Root

OOOOOO

10.81.10.15 EDS-510E Root

3. (Optional) Filter the devices in the Device List:
a. Click the Filter (<) icon.
b. Specify any of the following criteria:
O Group: The group that the device is assigned to
O IP Address: The IP address of the device
c. Click Apply.
MXview One filters the Device List according to the specified criteria.
4. (Optional) Export configurations from all available devices:

a. Click the Export (E) icon.

a o

Export CSV

O

b. Select Export CSV.
MXview One exports the 'All available devices' list as a CSV file.

5. To restore an archived configuration file to a device:

a. Click the Restore ({9) icon next to the IP Address of a device in the Device List.

The Restore Configuration screen will appear.

Restore Configuration

Restore Device - 10.81.10.11

Restore Configuration ¥
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b. From the Restore Configuration drop-down list, select the archived device configuration to

restore.

Restore Configuration

Restore Device - 10.81.10.11

g et e

Local File

10.82.10.3_20210805_2223.ini

10.82.10.3_20210805_2304.ini

10.82.10.3_20210806_1109.ini

10.81.10.11_20200722_1722.ini

c. Click Apply.

Restore Configuration

Restore Device - 10.81.10.11

Restore Configuration

10.81.10.11_20200722_1722.ini -

Createing Time: 2021-09-22 10:10:00
Last Checking Time: 2020-11-26 10:47:00

MXview One imports the configuration file to the selected device.
6. To import a local configuration file to a device:

a. Click the Restore (@) icon next to the IP Address of a device in the Device List.

The Restore Configuration screen appears.

Restore Configuration

Restore Device - 10.81.10.11

Restore Configuration >

Cancel Apply

b. From the Restore Configuration drop-down list, select Local File.
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c. Click the Configuration File field to a select the configuration file.
Restore Configuration

Restore Device- 10.81.10.11

Restore Configuration

Local File -
Configuration File O

d. Select the configuration file to import and click Open.
e. Click Apply.

Restore Configuration
Restore Device - 10.81.10.11

Local File A

Configuration File

10.81.10.11.inj O

MXview One imports the configuration file to the selected device.

Comparing Archived Configuration Files

Use the Device Configuration Center to compare changes in the history of saved configuration files.

1. Navigate to Menu (E) > Device Configuration Center.
The Device Configuration Center screen appears.
2. Click the Records tab.

A list of archived backup configuration files appears.

Configuration Center

Backup Restore Records

Configuration File

=@

Configuration File Createing Time Last Checking Time
a i !:l 10.82.10.3_20210805_2223.ini 2021-09-22 10:10:00 2021-08-05 22:23:00
a i !ﬂ 10.82.10.3_20210805_2304.ini 2021-09-22 10:10:00 2021-08-05 23:04:00
B § M) 1082103.20210806_1109.ini 2021-09-2210:10:00  2021-08-06 11:09:00
B i !:l 10.81.10.11_20200722_1722.ini 2021-09-22 10:10:00 2020-11-26 10:47:00
IS | l;l 10.81.10.11_20210409_1812.ini 2021-09-2210:10:00  2021-04-09 18:12:00
B 8§ M) 1081.10.12.20201211_1508.ini 2021-09-2210:10:00  2020-12-11 15:08:00
B 8 M) 1081.10.12.20210409_1812ini 2021-09-2210:10:00  2021-08-05 23:04:00
a i !J 10.85.10.20_20201215_1342.ini 2021-09-22 10:10:00 2020-12-15 13:42:00
a i !J 10.85.10.30_20201215_1358.ini 2021-09-22 10:10:00 2021-04-09 18:13:00
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3. (Optional) Filter the list of configuration files:
a. Click the Filter (<) icon.
b. Specify any of the following criteria:
Group: The group that the device is assigned to
Start Date: The earliest file creation date
Start Time: The earliest file creation time on the Start Date
End Date: The latest file creation or update date

[ O R R R |

End Time: The latest file creation or update time on the End Date
c. Click Apply.
4. (Optional) Export configurations from all available devices:

a. Click the Export (E) icon.

[+ I

O Export CSV
b. Select Export CSV.
MXview One exports all the devices information as a CSV file.

5. Click the Compare (“) icon next to the configuration file you want to compare.
The Compare Configurations screen will appear.

Compare Configurations

Compare Basement: 192.168.127.13_20220503_1818.ini

Device List *

192.168.127.13

Compare Target

192.168.127.13_20220503_1819.ini -

7. Select the target configuration file to compare from the Compare Target drop-down list.

6. Select the device from the Device List drop-down list.
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8. Click Compare.
MXview One will display a comparison of the selected configuration files.
Compare Configurations
Compare Basement: 192.168.127.13_20240125_0922.ini
Device List *
192.168.127.13
Compare Target
192.168.127.13_20240125_0932.ini v
# System Identification # # System Identification #
# [SwitchName]: Switch Name # [SwitchName]: Switch Name
# —> max. length = 35 words # —> max. length = 35 words
SwitchName Managed Redundant Switch 02810 SwitchName Managed Redundant Switch 02810
# [Location]: Switch Location # [Location]: Switch Location
# —> max. length = 80 words # —> max. length = 80 words
- Location Switch Location Location Lab
# [SysDescr]: Switch Description # [SysDescr]: Switch Description
# —> max. length = 30 words # —> max. length = 30 words
SysDescr EDS-408A SysDescr EDS-408A
P S N P SN
The inserted, deleted, and modified lines in the configuration will be highlighted.
/7  NOTE
The green lines are the configurations of Compare Target. The red lines are the configurations of Compare
basement.

Creating Maintenance Scheduler for
Database/Configuration Backups

Use the Maintenance Scheduler to automatically export/import device configurations or back up the
MXview One database on a predefined schedule.
1. Navigate to Menu (E) > Administration > Maintenance Scheduler.
The Maintenance Scheduler screen appears.
2. (Optional) Search a previously saved scheduled job, type a job name in the search box.
The Maintenance Scheduler table displays a list of matching scheduled jobs.
3. Click the Add (E8) button.
The Add job screen appears.
Specify the Job Name.
5. Select one of the following options from the Action drop-down box:
» Export Configuration
> Import Configuration
> Database Backup
Type a Description for the job.
Select the Registered Devices that apply.
8. Select a job frequency from the Repeat Execution drop-down box:
» Once
> Daily
> Weekly
» Monthly
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9. Specify the Start Date to begin executing the scheduled job.
10. Specify the Execution Time on the Start Date to run the scheduled job.
11. Click Add.

MXview One will display the scheduled job on the Maintenance Scheduler table and will execute the
job according to the defined schedule.
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17. Custom Integrations

MXview One supports several features that enable integration with third-party applications or external
systems.

OPC UA Server Overview

MXview One supports integrated OPC UA Server functionality to integrate with OPC clients such as SCADA
systems. From this section, users can configure OPC tags and server settings.

To access the OPC UA Server screen, navigate to Menu (E) > Integration > OPC UA Server.
= MXview ONE @english & adminy
] OPC UA Server

Dashboard OPCTags Server Settings

Topology
Device D
evice Discovery o
Device Management ~ ~
Configuration and Control m] B Device Property Tag Name Registered Devices
e [} Van | Enabled Availability Availability 1

Saved CLI Scripts

Firmware Management
Device Configuration Center <

Event Management ~

Enabled cpuLoading cpuLoading

Notification Management

Inventory Management
Integration -
OPC UA Server
AP| Key Management
Embedded Web Widget

Administration ~

Viewing the OPC Tags Table

1. Navigate to Menu (E) > Integration > OPC UA Server.
The OPC UA Server screen appears.

Go to the OPC Tags tab.
The OPC tags table includes the following information:

Column Description

Status Shows the status of the OPC tag.
Device Property Shows the SNMP device property of the tag name.
Tag Name Shows the tag name.

Shows the devices registered to the tag. Click the hyperlink humber in
this column to show an overview of all registered devices.

Registered Devices

Registered Devices Deicciali
192.168.123.152-EDS-518A 192.168.123.157-1EX-402-SHDSL

Close
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Adding an OPC Tag

Navigate to Menu (E) > Integration > OPC UA Server.

The OPC UA Server screen appears.
Go to the OPC Tags tab.

Click the Add (E3) icon.
The Add OPC Tag screen will appear.

Add OPC Tag

Enabled -

Device Property *

Tag Name *

Registered Devices * -

Close

Configure the following settings:

> Status: Select to enable or disable the OPC tag.
> Device Property: Select the SNMP property to generate the OPC tag.

» Tag Name: Enter a name for the OPC tag.

> Registered Devices: Select the devices to register to this tag.

Click Add.

If the total number of registered devices exceeds 4000, an error message will show.

Add OPC Tag

0 Maximum number of registered devices (4000)
reached.

Status *

Enabled -

Device Property *

cpulLoading300s

Tag Name *

CPU_Loading_300s

16/64
Registered Devices *

All devices -

Close Add

A confirmation will appear to verify tag was created.
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/  NOTE

MXview One supports a maximum of 2000 OPC tags.

Editing an OPC Tag

1. Navigate to Menu (E) > Integration > OPC UA Server.
The OPC UA Server screen appears.

2. Go to the OPC Tags tab.

3. Click on the Edit ( /7 ) icon next to the tag you want to edit
The Edit OPC Tag screen will appear.

Edit OPC Tag

Enabled o

Availability

192.168.127.25-PT-G7728,192.16.. ~

Close

4. Configure the following settings:
> Status: Select to enable or disable the OPC tag.
» Tag Name: Enter a name for the OPC tag.

> Registered Devices: Select the devices to associate this tag with.

5. Click Apply.
A confirmation will appear to verify the tag was updated.

Tag updated successiully

Deleting an OPC Tag

1. Navigate to Menu (E) > Integration > OPC UA Server.
The OPC UA Server screen appears.

2. Go to the OPC Tags tab.

3. Click the Delete ( o ) icon next to the tag you want to delete.
A confirmation window will appear.

Delete OPC tag

Are you sure you want to delete this OPC tag?
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4. Click Delete.
A confirmation will appear to verify the tag was deleted.

Tags deleted suce

Deleting Multiple OPC Tags

1. Navigate to Menu (E) > Integration > OPC UA Server.
The OPC UA Server screen appears.

Go to the OPC Tags tab
Select the checkbox of the OPC tags you want to delete in the list.

4. Click the Delete (. ) icon at the top of the page.

= MXview ONE engish 2 adminy
OPC UA Server
tin
| Q sea
Status Device Property Tag Name Registered Devices
s 0 Enabled Awailability Availability Al
s 0 Enabled cpulcading cpuLoading k2

5. A confirmation window will appear.

Delete OPC tag

Are you sure you want to delete these OPC tags?

Cancel
6. Click Delete.

A confirmation will appear to verify the tags were deleted.

Tags deleted suc

Configuring OPC UA Server Settings

1. Navigate to Menu (E) > Integration > OPC UA Server.
The OPC UA Server screen appears.

Go to the Server Settings tab.
Enable the OPC UA server.
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4. Configure the following settings:

= MXview ONE

OPC UA Server
OPC Tags Server Settings

Endpoint URL: opc.tcp://127.0.0.1:4840/MXviewOne/OPCUA

Enabled -
127.0.01

4840

Authentication Settings

—y Anonymous

—  Security Mode

Disabled -

Supported Security Policies

Basic128Rsals
Basic256
Basic2565ha256
Aez1285haZ56Rsa0aep
Aes256Sha256RsaPss

[=]

» IP/Domain Name: Specify the OPC UA server's IP or domain name.
> Port: Enter the server port.
> Authentication Settings: Select an authentication method.

O Anonymous: OPC clients can connect to the OPC UA server anonymously without
authentication.

O Account and Password: Specify an account and password for OPC clients to connect to the
OPC UA server (MXview One).

O Certificate: Authenticate OPC clients using a certificate provided by MXview One Control Panel.
> Allow No Security: Enable or disable allowing no security.
O Disabled: The connection requires encryption.
O Enabled: The connection can be established without encryption.
5. Click Save.

Managing RESTful API Keys

MXview One supports RESTful APIs for custom integrations with third-party products. Use the API Key
Management screen to add new applications and generate API keys.

1. Navigate to Menu (E) > Integration > API Key Management.
The API Key Management screen will appear.
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API Key Management

Q Search
[] ApplicationName  Create Time Access Count APl Key

eyJhbGciOiJIUzITNilsInR5cCI6 ki CJ9.eyJ 16InRy 1 16MTY
O test 2021-10-28 10:20:10 183 ZNTM4NzYxMCwianRpljoiNWEyN2E4ZGY2Y2NiYjZhOGY1ZjkwN2JIOTIIMGVKYTUyYWYyZWQ

4MiJ9.i9ZVczIAoES001IrD7bmwSv1LJIXhp17JAr8YDz5Q0uA

2. (Optional) Search the list of applications, type a string in the search box.

MXview One filters the list of applications to display only the applications that contain full or partial
matching strings.

3. To add a new API key for an application:
a. Click the Add () icon in the top left corner of the screen.
The Add New Token screen will appear.

Add New Token

Application Name *

Cancel

b. Specify an Application Name.
c. Click Add.

MXview One will add the new application to the API Key Management screen and display the
generated API key.

4. To regenerate an API key for an existing application:
a. Select the check box next to the Application Name.

The Regenerate the API Key (@) icon will appear in the top left corner of the screen.

API Key Management

" C Q Search
Application Name ~ Create Time Access Count APl Key

eyJhbGeiOiJIUZINlsINRSCCIBIKpXVCJ.eyJ1c2VybmFtZSI6inRyeW1 4dmildylsimihdCISMTY
test 202110-2810:20:10 183 ZNTMANZYxMCwianRplioiNWEYN2EAZGY2Y2NiYjZhOGY1ZjkwN2JIOTIIMGVKY TUYYWYyZWQ

4MiJ9.i9ZVczIAOES001IrD7bmwSv1LJXhp17JAr8YDZ5Q0UA

b. Click the Regenerate the API Key (G) icon.

MXview One will regenerate the API key for the selected application.

/  NOTE

Regenerating the API key will prevent any APIs that use the old API key from working properly.

5. To delete an application:
a. Select the check box next to the Application Name.
b. Click the Delete (i) icon in the top left corner of the screen.
MXview One will delete the application.
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/  NOTE

Deleting the application will prevent any APIs that use the old API key from working properly.

6. To view API reference documentation, navigate to Menu (E) > Help > API Documentation.

The MXview One API screen will appear and display the reference document for supported MXview
One APIs. Click API user guide below the MXview One API title, where you can find the guidelines for
using the RESTful API functions.

MXview One AP| <@

A document of API for accessing data from MXview One

AP user guide

Servers

http://127.0.0.1/ v

Resource v

/resources/icons/url/{url} Getdeviceicon

/resources/icons/{url} Get the icon of a site

GET /resources/panel_images/url/{url} Getthe panelimage of a device

Embedding Web Widgets

MXview One allows you to embed the Topology Map and Recent Events widgets from the MXview One
Topology screen in third-party applications.

1. Navigate to Menu (E) > Integration > Embedded Web Widget.
The Embedded Web Widget screen will appear.

2. From the Select API Key drop-down list, select the Application Name for the API key you want to
use.

Select APl key

Demo v
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3. From the Select Layout drop-down list, select the widget(s) you want to embed:
> Topology and Recent Events: Embeds both the Topology Map and Recent Events widgets in the
target application
> Topology: Embeds only the Topology Map in the target application
» Recent event: Embeds only the Recent Events widget in the target application
4. Copy and paste the widget link for the target application:
> To embed the widget in a web application, click the Copy link (0) icon in the Link section.

Embed
Link
hitp/127 0.0 1!#ledget9

Paste this into any HTML page

<iframe id="mxview-topology"
src="http://127.0.0.1/#/widget?
token=eyJhbGciOiJIUzI1NilsInR5cCI6IkpXWC
J9.eyJ1c2VwbmFZSI8ImFkbWiuliwiaWFOljox
NTQyMTczODYzLCJqdGkiOilzMzFIZjQ2ZDAQ
3NJIOZDec2MMIMDM4Z]VhODRjNzAzMzBhY
ml0YzgzIn0.FoxRT2wxtsm_75QXFOnacD-
0PBBIzUSINS wUsrPFnk&layout=2&top=1&b
ottom=2" frameborder="0" scrolling="0"
style="border-radius: 2px; box-shadow:
rgba(0, 0, 0, 0.12) Opx Opx 2px Opx, rgba(0, 0,
0, 0.24) Opx 2px 2px Opx; width: 600px;
height: 600px;"=</iframe= I

» To embed the link in a static HTML page, click the Copy link (D) icon in the Paste this into any
HTML page section.

Embed
Link

http /1127 0.0 1/#widget?
token=eyJhbGciOiJIUzI1NilsInR5cCl6lkpXWVC
J9.eyJ1c2WybmFtZSIGImFkbWIuliwiaWFOljox
NTQyMTczODYzLCJqdGkiQilzMzFIZjQ2ZDQ
INJIOZDe2MVIMDM4ZIVhODRINzAzMzBhY
ml0YzgzIn0. FoxRT2wxtsm_75QXFCOnacD-
0PB6IzUSINS wUsrPFnk&layout=2&top=1&b
ottom=2 0

Paste this into any HTML page

<iframe id="mxview-topology"
src="http://127.0.0.1/#/widget?

D, 0. 24) t]px 2px 2px Opx;
he ght: 600px;"=</iirame:
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18. Wireless Add-on Module

MXview One supports several optional modules that extend the functionality of the main module. These
modules require a separate license to use.

Introduction

The MXview One Wireless Add-on Module provides a set of tools to help you monitor and troubleshoot your
wireless network through MXview One and supports up to a total of 200 wireless APs and clients. The add-
on gives you clear, real-time information about the status of your wireless network including the client
roaming status and key wireless performance indicators such as SNR and noise level. The wireless module
also instantly notifies you of any problems with your wireless devices and helps you narrow down the root
cause of the problem, allowing for quick and easy troubleshooting.

System Requirements

The computer that the MXview One Wireless Add-on Module is installed on must satisfy the following system
requirements based on the maximum capacity of 200 wireless APs and clients:

; System Requirements

CPU 2 GHz or faster dual core CPU
RAM 8 GB or higher
Hard Disk Space 20 to 30 GB for 1 month of performance and event history recording

Windows 10 (64-bit)

Windows 11 (64-bit)

Windows Server 2016 (64-bit)
Windows Server 2019 (64-bit)
Chrome: Version 76 or later
Browser Requirements Firefox: Version 69 or later
Microsoft Edge: Version 79 or later

0s

Supported Devices

The MXview One Wireless Add-on Module supports the following wireless devices:

e AWK-1131A Series (firmware v1.22 or higher)
e AWK-1137C Series (firmware v1.6 or higher)
e AWK-1151C Series (firmware v2.0 or higher)
e AWK-1161A Series (firmware v1.0 or higher)
e AWK-1161C Series (firmware v1.0 or higher)
e AWK-1165A Series (firmware v1.0 or higher)
e AWK-1165C Series (firmware v1.0 or higher)
e AWK-3131A Series (firmware v1.16 or higher)
e AWK-3252A Series (firmware v2.0 or higher)
e AWK-4131A Series (firmware v1.16 or higher)
e AWK-4252A Series (firmware v2.0 or higher)
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Getting Started With the Wireless Add-on
Module

In order to use the MXview One Wireless Add-on module, you will need to activate it first. You can choose to
activate a new license, or enable the Wireless Add-on 90-Day free trial through the license management

page.
= MXview ONE @ English & admin ~

License Management

MXview One
h Node License Wireless Add-on License Power Add-on License Security Add-on License
Mode: Authorized Mode: None Mode: None Made: None
O) Currently Uses: 50
1 Total Number of Licenses: 2000

Maoxa License Sield

Add Naw License License Type

Licenses ~

License Type: Node License

Licenzed Mode: 2000

Activation Code: Wi ARINIHPKIVELLIOhY i Zifh/WEYC]72y+ BDOANFCRzESW X2 C 2re TEAVRmP0+ ZpOEG2 NPT 20r3/
ZDinB LRSI WWAFz ZoiyWLiSehmuAlzsck7aky/ FuwsEY+hRZA0Y DaXI2 1 Mm TR6uyy TdIMSwwZ OprHe 31nizCEf YvigNESosoaMIErm bmWeWmCs=

License Start: 2024-04-12 21:49:57

Deactivate

Wireless Add-on Power Add-on Security Add-on Re-activate License

Start to axpenance the Miview One Start to axpenance the Miview One Start to axperiance the Miview One Usa both the Deactivation Cade and &

WWiweless Add-on Pawer Add-on Security Add-on User Code to re-aetivate your license.
Re-activate.

The system will automatically restart after you activate the module. A message will appear telling you to
wait 10 seconds while the module activates. Once done, click OK to refresh your browser and enable the
Wireless Add-on features.

Please Wait

The operation will finish in 10 seconds.

OK

e  For detailed information on how to activate the MXview One Wireless Add-on Module, refer to License
Management.

e To add wireless devices to your MXview One network, refer to Using Device Discovery.

/  NOTE

Please activate the Node-based License first and then the Wireless Add-on License.
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Wireless Module Features

The MXview One Wireless Add-on Module offers a set of features specifically designed to help you monitor
and troubleshoot your wireless network more easily.

Main Dashboard

If the wireless module is activated, the MXview One Dashboard will include a Wireless tab and show AP
Traffic Load and the Wireless Device Summary information.

To access the Dashboard, navigate to Menu (E) > Dashboard and go to the Wireless tab.

The AP Traffic Load graph shows the aggregated traffic of all the AP devices monitored by MXview One. You
can select a specific time to check the wireless network status at that time. MXview One provides three time
sections: Last 24 hours, Last week, and Last 2 weeks.

The Wireless Device Summary shows the number of deployed wireless devices. Clicking one of the cards will

direct you to the Wireless Device Summary screen where you can find more detailed information about the
wireless devices.

To refresh the data displayed in all the widgets, click the Settings ( { ) icon in the top-right corner of the
screen and select Refresh All.

Dynamic Wireless Client Roaming

The MXview One Wireless Add-on Module features dynamic wireless roaming display, which updates
roaming connections of wireless clients in real-time. Instead of using LLDP data to draw links between

devices, MXview One uses both the client list data from the wireless AP and AP data from the wireless client
to detect wireless roaming changes.

To enable the dynamic wireless client roaming function, toggle the Dynamic client position option. In this
mode, wireless clients will automatically move below the AP they connect to when roaming. The link
between the client and AP on the topology will also change dynamically if the client connects to another AP.

Refer to the table below for a description of each display option.

Option Descripton

. Toggle this option on or off to show or hide wireless clients on the
Show clients
topology
Enable this option to have wireless clients move to a position close to
Dynamic client position the AP they are associated with
Disabling this option will return the clients to their original position

A Topology v e Group v g Edit v (® Visualization v az SFP v = Wireless v
Q,
AP
Wireless display options X J]

_. Show clients
» Dynamic client position o

192.168.127.168

Device IP
M Device Role client
=
Bottom Label J,]

Port Number !
192.168.127.165

MXview One 1.5.0 User Manual 243



The following diagrams are an example of the dynamic roaming display showing dynamic client-AP link
changes.

In the first scenario there are two wireless APs that each have one client connected to it.

Client
192.168.127.766 168.127.152
s pd p12
E\
.
N
.
.
2
.
N
“hpa p5
‘\
. AP
.
.
i
.
192.168.127.169
AP
. “‘
2.168.127768
05
Mge
.
¥
N
.
S
.
p1 s
.
v g7
o AP
. Client d
I .
L RS
.
.
192.168.127.153
. 192.168.127.167

192.168.127.165

When the client roams to another AP, MXview One will automatically redraw the link to the new AP on the
wireless topology diagram.

Client
192.168.127.766 168.127.152
Spg P12
P\
.
.
.
N
.
.
‘\
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.
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A
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192168.127.169
.
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’
.
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P
.
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-
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’
.
.
.
’
P
p7e”
p1 bl
’
P
. AP
.
Client » d
,
.
I
19216827158 . 192.168.127.167

192.168.127.165
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AP /Client Device Dashboard

Use the AP/Client Device Dashboard screens to see detailed information and performance statistics of

the client or AP.

To access the AP/Client Device Dashboard, click on any wireless AP or client device’s icon on the topology
diagram and click Device Dashboard in the toolbar.

' Refresh GO Add Link

BY Device Dashboard

B Delete

AP Device Dashboard

AP Dashboard-192.168.126.94--AWK-3131A

Q Bl Client Count Security Mode TX Power Uptime
1T/ 2 WPA2 5dBm 11d 9hr 26min
MOXA A~ - .
06:90:E8:88:41:11
Last 30 minutes ~ &
|| 192.168.126.101
0090:EBOFAZTF
Traffic Load

600 Byte/s -~

400 Byte/s

200 Byte/s e —_—

OKBfs —
18:00 18:05 18:10 1815 18:20 18:25
12/24/23
UTC +08:00
Time: [ rx: Orx:
CPU Utilization
15%
10%
Close
The AP Device Dashboard shows the following information:
Descriptio
Managed The total number of wireless clients connected to this AP that are managed
Client Count 9 by MXview One
Connected |The total number of wireless clients that are connected to this AP

Security Mode The Security Mode of the AP: Open, WEP, WPA, or WPA2
TX Power The current transmission power of the AP
Uptime The total time the wireless AP has been online since the last restart

Traffic Load

The current and historical traffic throughput of the wireless interface

CPU Utilization .
versions)

The current and historical CPU utilization of the AP (only supported by certain firmware

Memory Utilization

The current and historical memory utilization of the AP (only supported by certain
firmware versions)
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Client Device Dashboard

Client Dashboard-192.168.127.166--AWK-1137C

BSSID Security Mode Link Speed Connected

06:90:E8:7C:C3:01 Open 58 Mbps 0d 2hr 50min

Last 1 hours C

SNR
60dBm - P e PP Ey - — AN
AP P et T T TN A S T e I et T A I A e P e S P
50dBm
40dBm
30dBm B N N N . W B o N R o e Y B Y W e
12:55 13:00 13:05 1310 1315 13:20 13:25 13:30 13:35 13:40 13:45 13:50
12/25/20
UTC +08:00
Time: -- []SNR-A: - [1SNR-B: -
Signal Strength
70dBm
e “ *
60dBm |~ |J

Close

The Client Device Dashboard shows the following information:

Parameter Description

BSSID The BSSID of the wireless AP the client is connected to

Security Mode The Security Mode of the client: Open, WEP, WPA, or WPA2

Link Speed The real-time bandwidth of the connection to the AP

Connected The total time the wireless client has been connected to the AP
The current and historical Signal-to-Noise ratio of the client

SNR If the wireless device has multiple antennas, the SNR of each antenna will be
separately shown as SNR-A and SNR-B

Signal Strength The current and historical signal strength of the client

Noise Floor The current and historical noise floor of the client

Traffic Load The current and historical traffic throughput of the wireless interface

CPU Utilization The current ar_1d historical CPU utilization of the client (only supported by certain
firmware versions)

Memory Utilization The current ar.1d historical memory utilization of the client (only supported by certain
firmware versions)
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You can view the device diagnostics and usage parameters in real-time or recall the history for up to the
last 3 days from the drop-down menu in the top-right. You can zoom in on the timeline to examine a
narrower time period. Double-click the timeline to return to the original view.

From now c
. From now
Traffic Load
Last 30 minutes
3.32KBfs
313 KBfs Last 1 hour
2.93 KB/s

Last 3 hours

1016 10017 10:18 1019 10:20 10:21 10:22 10:23 il

Last 24 hours 26
5/25/22

UTC +08:00
Last 3 days
Time: - O rx: - OTx: 1

Wireless Device Summary

The Wireless Device Summary screen provides detailed information about all the AP and client devices
including the device’s IP and MAC address, operation mode, and current signal strength.

To access the Wireless Device Summary screen, expand the Wireless (?) menu in the toolbar and click
Wireless Device Summary.

Click Back in the top-left corner to return to the topology view.
& Back

Wireless Device Summary

All (5)
c Qse
AP(2)
Operation Mode  IP Address. MAC Address BSSID Channel  Noise Floor = Signal Strength (dBm)
—— Client (3)
> A AP -192.168.127.168 (Site Name: Site BRANDONYANG-PC / MAC Address: 00:90:E8:52:39:50 / Channel: 1)
== Client 192.168.127.165 00:90:E8:52:39:75 06:90:E8:52:39:50 1 -88 23
A AP - 192.168.127.169 (Site Name: Site BRANDONYANG-PC / MAC Address: 00:90:E8:7C:C3:01 / Channel: 1)
== Client 192.168.127.166 00:90:E8:63:A7:6C 06:90:E8:7C:C3:01 1 a1 22
A Unmanaged AP (Site Name: Site BRANDONYANG-PC)
== Client 192.168.127.167 00:90:E8:52:07:85 N/A 1 N/A N/A
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Wireless Roaming Playback

Through the Wireless Roaming Playback screen, you can recall the roaming history of a specific client. By
default, MXview One will keep the roaming playback data for 30 days.

To access the Wireless Roaming Playback screen, expand the Wireless (?) menu in the toolbar and click
Wireless Roaming Playback.

Click Back in the top-left corner to return to the topology view.

All > client-wireless > Root

< Back

Q_Filter

ap AP
MOXA 2 i

192164126.92
J 192.168.126.101 Ciknt |2022.05-1015:13:10

RSSI: 53

BEER

192.168.126.101

i, oate Start Time Duration
OTimeRange: 5102022 B FF o216 O  6hr ¥ m

From To
20220510 20220510
o ° » 150720

15:35:11

0310 0315 0320 0325 0330 033

On the left-hand side is a list of wireless clients, in the center is the topology map, and located at the

bottom is the playback progress bar. Select any client from the list and click Play (°) to start playing the
wireless roaming history for the selected time range. You can adjust the playback speed by clicking the

Decrease Speed (“ ) or Increase Speed (™ ) button to increase or decrease the playback speed
respectively.
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To view the history for a specific time and date, click ( = ) to choose the starting date, set the time in the

Start Time field, select the duration of the playback history from the Duration drop-down menu, and click

Apply.
_ Date Start Time Duration
O TimeRange: 1/92/2021 [}  08:58 CRERL v m
DEC 2020 « £ >
DEC
1 2 3 4 5
6 7 8 g 10 11 12
13 14 15 16 17 18 19
20 21 22 23 24 @ 26
27 28 29 30 N
“Date SErTTImET
ange: 19/25/2020 [o) 02PM

The progress bar also displays the RSSI value at the time. In addition, the red dots indicate the time when
the wireless client roamed to a different AP. You can zoom in on the timeline to examine a narrower time
period. Click Apply to return to the original view.

2020-12-25 12:03:25
RSSI: 66

1x From
oY » B

=

To
20201225
15:42:00
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19. Power Add-on Module

MXview One supports several optional modules that extend the functionality of the main module. These
modules require a separate license to use.

Introduction

The MXview Power Add-on Module provides a set of features to help you monitor and troubleshoot your
power substation network that follows the IEC 61850 standard and supports switches that have the
PRP/HSR function with deep visualization. To monitor the IED (Intelligent Electronic Device), which is an
important device that can receive data and issue commands on the network, MXview Power supports the
MMS protocol to view and provide the status of the IED. Furthermore, there is a critical packet called
GOOSE in power substation networks, and MXview Power can also help customers troubleshoot GOOSE
events such as GOOSE Timeout and GOOSE Tampered. The power module instantly notifies you of any
problems with your power devices and helps you narrow down the root cause of the problem, allowing for
quick and easy troubleshooting.

System Requirements

The computer that the MXview Power Add-on Module is installed on must satisfy the same system
requirements as those required for MXview One. See System Requirements in Chapter 1 for more
information.

Supported Devices With PRP/HSR Features

PRP/HSR features can be visualized with the devices that support PRP/HSR functions or have a PRP/HSR
module.

e PT-G503 Series (firmware v5.1 or higher)

e PT-G510 Series (firmware v6.4 or higher)

e PT-G7728/G7828 Series and LM-7000H-2GPHR module (firmware v6.2 or higher)

e DA-820C Series and DN-PRP-HSR-1210 or DA-PRP-HSR-I210 (OS Win 10 or higher)
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Getting Started With the Power Add-on Module

In order to use the MXview Power Add-on module, you will need to activate it first. You can choose to
activate a new license or enable the Power Add-on 90-day free version through the License Management

page.

= MXview ONE @ English & admin ~

License Management

MXview One
h Node License Wireless Add-on License Power Add-on License Security Add-on License
Mtode: Authorized Mode: None Maode: None Mode: None
e Currently Used: 50
n Total Number of Licenses: 2000

Mawa License Sl

s

Licanses -
License Type: Node License
Licensed Node: 2000
Activation Code: xWiJjARINIWPKIVELIOAY i 2ifh/WEYC|7 2y+ BEDoAXFezESWX2C2reTSAVRmPI+ ZpOER2/nP7 2Br 3/
Z0mBJIASTWWAFzZeiyWLiSehmueAlzsckTak Y/ FuwsE Y+hREADYDax| 21 Mm TPEuyy TdIMSwwZ OprHog 31nizQEf Yvegh Efabo4bJErm smWeWmCs=
Deactivate

License Start: 2024-06-12 21:49:57

Wireless Add-on Power Add-on Security Add-on Re-activate License

Start to experiance the Miview One Start to experiance the Miview One Start to experiance the Mxview One Use both the Deactivation Code and &

\Wireless Add-on Power Add-an Security Acd-on User Code 1o re-activate your license.
Re-activale,

Start Trial Start Trial Re-activate

The system will automatically restart after you activate the module. A message will appear telling you to
wait 10 seconds while the module activates. Once done, click OK to refresh your browser and enable the
Power Add-on features.

Activating...

The operation will finish in 10 seconds.

e For detailed information on how to activate the MXview Power Add-on Module, refer to Chapter 4:
License Management.

e To add power devices to your MXview One network, refer to Using Device Discovery.

/7  NOTE

Please activate the Node-based License and then the Power Add-on License.
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Power Module Features

The MXview Power Add-on Module offers a set of features specifically designed to help you monitor and
troubleshoot your power substation network more easily.

= MXview ONE @eglisn 2 adminy
Al > Site DESKTOP-LBCNQNO > Root
ATopoy v @Gopv  SEav @ Viwlionv  etSPv § Powerv

[}
Q

sssss

1=

FRIEE

Topology

After you enable the MXview Power add-on module, you will see the panel has changed on the left hand-
side.

GOOSE panel

1. Before you import the SCD file, the GOOSE panel will be displayed in light gray. At this point, it has

limited functionality.
|

2. Once you have imported the SCD file via Power > Import SCD, you can find the IED as a GOOSE

publisher identity via the GOOSE panel.
a. Click GOOSE panel.

Q

GOOSE
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b. Scroll down or type the GOOSE-related information, such as IED name or GoCB name.

= MXview ONE

All > Site DESKTOP-LBCNQMO > Root

K Maintenance '\ Tools j‘ Change G

Choose a GODSE publisher
REF&620
|
Control_DatasSet
03007 f 01-0C-CDo01:00:07
gcbgebtest
00001 f 01-0C-CC-01:00:02
REF615

gchGOOSE -
?::EII:IEIE F01-0C-CD-01:00:0:5 m

Display Options
1. Once you have activated the MXview Power add-on module, you can see the display options include
extra functions such as PRP LAN A, PRP LAN B, and HSR Ring.

2. If the box is checked, you can see the color of the link for the PRP/HSR on the topology. If you uncheck
the box, then the link will not display the color for the PRP/HSR function.

splay options p-¢
>
ga Device IP
Device Role
Bottom Label
Port Number

B PRP LAN A
B PRP LAN B
B HSR Ring

/  NOTE

PRP LAN A is represented by a green line, PRP LAN B by a blue line, and HSR Ring by a purple line.

/  NOTE

MXview One cannot guarantee that it can draw the link of the topology for non LLDP devices, such as an
IED device. However, you can draw the link of the topology manually by clicking Add Link.
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Ungrouping an IED Group

After executing the Auto Topology function, MXview One will automatically group the IEDs within the same
HSR ring into an IED Group and represent the HSR link with a purple line. If you want to display the IEDs
within the Root group or display GOOSE Message information in the topology, you can use the Ungrouping

function.
= MXview ONE
Root >

_& Topology Vv Q Group Vv /' Edit v @ visualization v a2 SFP v ’ Power v

Q
192 158‘2'3; .
19216812822

IE |

192168.127.28

G
Lo IED Groupt

Ring 1 Master

—

192.168.127.27

Ring 1 Master

J l'l - I £ ] II 8

19216812714 192168127.1 192.168.127.11

1. Navigate to Menu (E) > Topology

The Topology screen will appear and display the Topology Map by default.
2. Click on the IED group in the topology that you want to ungroup.
3. Click Ungrouping.

= MXview ONE

Root >
e Ungrouping B Delete
152168127 308
192168.128.22
e
S 17 Gdodsle 1 Porc 1721 Gy |
= - =
19216842728 192168.027.228
-
192168 127.27
Ring 1 Master
12 ' 1]
) % .|72|OBVZ?‘H
19216812712 192168127 1 19216812711
B
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4. After ungrouping an IED group, the individual IEDs will be shown on the right-hand side of the topology.

= MXview ONE @engish 2 adm
Roat >
o Topology @ Growp v # Edit v @ Visualization v -l SFP v ¥ Power v = [i]
- e
e ]
G sz
L) [
a 4 B
> u '8
R L y
@
3 ]
= [ |
—— -

5. Align the network connections for each IED.
a. Drag and move the IEDs to their appropriate position in the topology.

b. Select the devices to draw a connection between and click Add Link.
The Add Link screen will appear.

Root >
'\ Device Configuration v E Alignment v a Run Script v GO Add Link ,‘ Change Group I PRP/HSR Tags E Delete
OSE 1921681273
1216812822
1021881272
i REFE1S SR
= -_— e
19216812728 e ARV 2188127228
19218812727
] Ring 1 Master
N ¢
> o % 0 B
) - F 0
192.188.127.14 192168127 1 192168.127.11
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c. Specify the device port number. You can set the port number to non-numerical mode (e.g., A, B) on
the IED side.

Add Link

From

IP Address: 192.168.127.2
Model: ABB
Alias: 192.168.127.2-ABB

1

A

To

IP Address: 192.168.127.25
Model: PT-G7728
Alias: 192.168.127.25-PT-G7728

1

21

d. Click Add. MXview One will draw the connection on the topology.

= MXview ONE

Root >

A Topology v Q Group v i Edit v @® Visualization v aZ SFP v ’ Power v

: 152168127208
6216812822
%2168.1272
HsA
I
= =
w-_n o @
19216812728 P 21681272 W2188127228
19216812725 192168.127.26
a
Ring 1 Mazter

192.168.127.27

j a Wi
& & F

192168.127.14 1921881271 192:164.127.11

e. Repeat this process for any other remaining IED connections.
6. (Optional) Refresh the IED information.
a. Select one or multiple IEDs.
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b. Click Refresh. MXview One will retrieve the latest information from the IED.

= MXview ONE UL g
Root >
v\ v e v ED) web console Run Script v # Change Group. C Refresh | D addlink I PRP/HSR Tags @ Delete s B [}
Q Device Properties Current Status
e MMS Properties
model
= _— Ll
iz ———
5122
B e
vendo
o ABB
e
a
. Basic Device Properties
> % Lo B
— Alias
a
ll - ' g ll 192.168.127.2-ABB
e g ez
[]
Model Name
ABB
MAC Address
00:21:C1:5C:3D:91
a
B
— ]

.,, [ Other Device Properties

7. (Optional) Restore the original IED group.

a. Go to Topology > Auto Topology.
The Auto Topology screen will appear.

Root >

X Topology v 9 Group vV 2 Edit v @ Visualization v @ SFP v ’ Power v

Q,  Device Discovery

ﬂ Auto Topology

= Auto Layout

b. Select New Topology or Update Topology.
Auto Topology
@ New Topology
Existing links are going to be deleted

(O Update Topology

Existing links will be kept while new links are added

Advanced Topology Analysis o
[ Strict Link Verification Mode @

*Additional time is required.

Cancel m
c. Click Apply.

MXview One will restore the topology and IED group to their original state.

/  NOTE

To display GOOSE Message information on the topology, you must first ungroup the IED group, manually
draw the links between the IEDs, and import the SCD file.
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Creating an IED Group

Using the Grouping function, you can assign multiple IEDs on the topology to a single IED group.

1. Navigate to Menu (E) > Topology
The Topology screen will appear and display the Topology Map by default.
Select the IEDs in the topology that you want to group together.
Click Grouping.

= MXview ONE

Root >

0 Grouping C Refresh ‘k Device Configuration v E Alignment v m Run Script v /' Change Group I PRP/HSR Tags ﬁ Delete

Q
g im
-

4. MXview One will combine the selected IEDs together and show them as a single group on the topology.
To ungroup an IED group, refer to Ungrouping an IED Group.
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Import SCD

The SCD (Substation Configuration Description) file includes the information of the critical packet - GOOSE
message in the network. To visualize the GOOSE message flow in MXview Power, the user has to import the

SCD file.

1. Navigate to Menu (E) > Topology
The Topology screen will appear and display the Topology Map by default.
2. To import the SCD file to the Topology Map:
a. Click Power > Import SCD.
The Import SCD screen will appear.

Import SCD

GOOSE Publisher ~

Control_DataSet
Subscriber Publisher 0x01 / 07:0¢:04:01:00:01

Timeout

GOOSE
001 / 01:0c:ed:01:00:02

Visualize GOOSE Messages

To visualize GOOSE messages between IEDs, you must import an SCD
file first.

Select File * 0O

w

Cancel

b. Upload the SCD file by clicking the File (D) icon. The file size must be less than 100 MB.

3. Click Import.
MXview Power will import the uploaded SCD file into the Topology Map.
If the SCD file is correct, the user will see the message below.

SCD File Import Successful

GOOSE messages and flow design successfully built into the network
topology.

Close
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If the SCD file content cannot find the devices in the Topology, then MXview Power will display the
missing devices and provide the steps for the user to resolve the problem.

Failed to Import SCD File

A Can't find the following device(s):

192.168.127.4

Try these steps to resolve issues.

1. Add the missing device(s)
Click "Edit" = "Add Device".

2. Import the SCD file again
Click "Power" = "Import SCD".

Close

GOOSE Message

MXview Power can display the GOOSE Message information on the Topology or in the IED Device Property
panel by importing the SCD file. Moxa’s PT switch, which was specifically designed for use in power
substation systems, can detect GOOSE events. MXview Power can collect the GOOSE events and alert users
when there is something wrong. Users can follow the step-by-step guidelines to solve the GOOSE events.

GOOSE Flow

There are two roles for IED device(s): Subscriber and Publisher. The topology displays the flow of the
GOOSE packet, which starts from the Publisher and ends at the Subscriber. The route you see on the
GOOSE flow is not the completed GOOSE packet publishing direction. The purpose of displaying the GOOSE
flow is to troubleshoot the path of the GOOSE packet for certain cases such as a GOOSE event (e.g. GOOSE
Timeout, GOOSE Tampered), a device malfunction, or a link going down. The GOOSE flow will show the path
the packet took to enable faster troubleshooting and minimize substation network recovery times.

= MXview ONE @English 2 adminy.

All > Site DESKTOP-LECNGNO > Root
A wamenance v R Took v/ ChngeGrop G Refsh G0 Addlink W PRPHSRTags [ Delere - e

Q Device Properies: Current Statis:

coose IE—‘ MMs Properties

REFS15.

108.10.53.15-A88

GOOSE Publisher v

9ebG00SE
0:0002/01:00C0010005
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GOOSE Timeout

When a GOOSE Timeout event happens, MXview Power can display the event and indicate the possibly
affected devices on the Topology by placing a yellow triangle next to them. When users click on the IED
device, it will display the specific GOOSE message and will also include a Timeout status notification.

= MXview ONE @eglisn 2 adminy
All > Site DESKTOP-LECNGNO > Root
R waintenance v W\ Tools v/ CrangeGrowp  C Refresh  GD AddLink BB PRPHSRTags [ Delete - @
.
st |= s Proprtes
ol
= ReFsts
s119
seo
a

Basic Device Properties.

aise
108.10.53.15-A85

‘GOOSE Timeout was caused by
Port 210 108.10.53.7

GOOSE Pubisher -

och00sE
0002/ groccooTonos T

Click the How to resolve link and MXview Power will provide you with step-by-step instructions to solve
the problem.

Resolve GOOSE Timeout Issue

A\ GOOSE Timeout was caused by:

Port 21 of 108.10.53.7

Try these steps to resolve GOOSE Timeout issues.

1. Check the IED(s) settings

Make sure the GOOSE publish/subscribe messages of the |ED are set correctly.

2. Make sure the port is not in link down status

Check to make sure the port of each device in the GOOSE flow (gcbGOOSE/0x0002/01:0C:CD:01:00:05) is not in link down status.
3. Make sure the port does not have any TX/RX ermors

Click on a link, choose "Link Traffic” to see the "Packet Error Rate” section. Make sure the port does not have any errors.

4. Check if the fiber ports exceed certain thresholds

Click "SFP" = "SFP List". Make sure the ports do not exceed certain thresholds.

Still not working?

Remove the SFP module and install it again.

If you have further questions, contact your channel partner g first.
Contact Moxa Technical Support ¢ if you still need additional support.

Close

Once the problem is solved, MXview Power will provide the recovery status in the Recent Event panel and
the yellow triangle will disappear.
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GOOSE Tampered

When a GOOSE Tampered event happens, MXview Power can display the event and provide the possibly
affected devices on the Topology by placing a red triangle next to them. When users click on the IED device,
it will display the specific GOOSE message and will also include a Tampered status notification.

All > Site DESKTOP-LBCNONO > Root

R wanenance v A Took v/ ChgeGop G Refesh G0 AddLink W PREMSRTigs [ Delete

a Device Properies: Cuarent Stans

|=

a &

Bl Basic Device Properties

e
GOOSE Port Tampered was caused by: 108.10.53.15-A88
Port30f 108.10.535

,
= -

WiCAdiess

o

)| GoosE puslisher v

ocb00sE
0002/ or0ccooronos MES

Click the How to resolve link and MXview Power will provide you with step-by-step instructions to solve
the problem.

Resolve GOOSE Port Tampered Issue

A\ GOOSE Port Tampered was caused by:

Port 30f 108.10.53.5

Try these steps to resolve the GOOSE Port Tampered issue

1. Check the IED(s) settings
Make sure the GOOSE publish/subscribe messages of the IED are set correctly.

2. Check the port status
Flease check port 3 status of 108.10.53.5.

Still not working?

If you have further questions, contact your channel partner G5 first.
Contact Moxa Technical Support ¢ if you still need additional support.

Close

In order to enhance security, MXview Power allows users to click the Reset button to clear the events log
for the devices. Once the event logs are cleared, MXview Power will provide the recovery status in the
Recent Event panel and the red triangle will disappear.

GOOSE Port Tampered was caused by:
t ﬁ Port 3 0of 108.10.53.5
¥
- How to resolve?
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20. Security Add-on Module

MXview One supports several optional modules that extend the functionality of the main module. These
modules require a separate license to use.

Introduction

The MXview Security Add-on Module provides a set of features to help you easily monitor and manage the
overall cybersecurity condition of your network. The add-on enables you to manage and deploy firewall
policy rules and security packages to multiple devices simultaneously. Through the security dashboard
featuring statistical charts, users can get important information at a glance and take necessary actions.

Additionally, the Security module instantly notifies you of any security-related issues on your network,
enabling quick and easy troubleshooting.

System Requirements

The computer that the MXview Security Add-on Module is installed on must satisfy the same system
requirements as those required for MXview One. See System Requirements in Chapter 1 for more
information.

Supported Devices

The MXview Security Add-on Module supports the following devices:

e EDR-8010 Series

e EDR-G9004 Series

e EDR-G9010 Series

e EDF-G1002-BP Series
e TN-4900 Series
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Getting Started With the Security Add-on
Module

In order to use the MXview Security Add-on module, you will need to activate it first. You can choose to
activate a new license or enable the Security Add-on 90-day free version through the License Management
page.

= MXview ONE @ English & admin ~

License Management

MXview One
t Node License Wireless Add-on License Power Add-on License Security Add-on License
Mode: Authorized Mode: None Mode: None Made: None
O Currently Uses: 50
. Total Mumber of Licenses: 2000
Maoxa License Sield

Add Naw License License Type

Licenses ~

License Type: Node License
Licenzed Mode: 2000

Activation Code: sWLIJARTN IO BEYup i Zifh/WEYC]72y+ BDOANFCRzESW X2 C 2re TEAVRmP0+ ZpOEG2 NPT 20r3/
ZDINB IS ZWNAF 2 2oy WLiSehmoAlzsck Tak Y/ FuwsEY+hREADY DaXI21Mm TR6uyw TdIMSwwZOprHxg 31 nizCQEf YvisgN BSab oM JErm AmWeWmCs=
License Start: 2024-06-12 21:49:57 Deactivate
Wireless Add-on Power Add-on Security Add-on Re-activate License
Start to axpenance the Miview One Start to axpenance the Miview One Start to axpeniance the Miview One Usa both the Deactivation Code and 3
Wiweless Add-on Power Add-on Security Add-on User Code 10 re-activate your license.

Re-activate,

The system will automatically restart after you activate the module. A message will appear telling you to
wait while the module activates. Once done, click OK to refresh your browser and enable the Security Add-
on features.

e For detailed information on how to activate the MXview Security Add-on Module, refer to Chapter 4:
License Management.

e To add secure devices to your MXview One network, refer to Using Device Discovery.

/7  NOTE

Please activate the Node-based License and then the Security Add-on License.

Checking Registered Devices

MXview One can automatically check for and register devices that support MXview Security features.

You can see the registration status on the Topology or Device Management page.

1. To check the device registration status from the Topology screen:

a. Navigate to Menu (E) > Topology.
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b. Click the List View ( =) icon.

Devices in the topology will be shown in a list.

= MXview ONE @ English & admin ~
Root
A Edit v A ]

= @ Q

[0 Device Alias Security Add-On Model Device IP MAC Address Firmware Version Location

O 192.188.127.11-EDSGS16E N/& EDS-GS16E 192.168.127.11 0090:E8.50E1E6

O 192.168.127.35-EDR9010 Registered EDR-9010 192.168.127.35 0090:68.91:86:82 Switch Location

O 192.168.127.82-EDR8010 Unregistered EDR-8010 192.168.127.82 00:90:E8.91:86:82 Switch Location

2. To check the device registration status from the Device Management screen:
a. Navigate to Menu (E) > Device Management> Configuration and Control.
= MXview ONE @ English 2 admin ~

@ Select Operation

R, Device Configuration Ju Device Control v @& Cybersecurity Control ~ B execvtecu v

= o Q

[] Device Alias Security Add-On Model Device IP MAC Address Firmware Version Location
| O  152.168.127.11-EDS-G516E N/A EDS-G516E 19216812711 00:90:EB:54:ET:E6
| [0 192.168.127.35-EDR-9010 Registered EDR-9010 192.168.127.35 00:90:E8:91:86:82 Switch Location
| O 192.168.127.82-EDR-B010 Unregistered EDR-8010 192.168.127.82 00:90:E8:91:86:82 Switch Location

ltems perpage: 50w  1-100f 10 < < > 3l

3. Check the registration status of the device in the Security Add-on column:

> Registered: The device can be managed in the Security Add-on module and has been successfully
registered.

» Unregistered: The device can be managed in the Security Add-on module, but it has not been
successfully registered yet. Some functions such as firewall policies cannot be deployed on
unregistered devices.

» N/A: The device cannot be managed in the Security Add-on module.

/7  NOTE

If the status is Unregistered, confirm the device account and password in Device Configuration >
Device Accounts are correct or reboot the device.

Security Module Features

The MXview Security Add-on Module offers a set of features specifically designed to help you monitor and
troubleshoot your network more easily.

Main Dashboard

If the Security module is activated, the MXview One Dashboard will include a Cybersecurity tab with widgets
showing cybersecurity event statistics.

To access the Dashboard, navigate to Menu (E) > Dashboard > Cybersecurity.
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Dashboard

General Wireless Cybersecurity

Last Update: 2024-09-19 151720 &

Top 5 Layer 3-7 Policy Events by Source IP

192.168.1.7
192.168.1.6
192.168.1.8
192.168.1.9
102.168.1.2

Top 5 IPS Policy Events by Source IP

192.168.1.7
192.168.1.6
192.168.1.8
192.162.1.9
192.168.1.2

800 1000

Show Event Log =

800 1000

Show Event Log =

G Refresh all

X Set as Default Tab

Top 5 Layer 3-7 Policy Events by Source IP

192.168.1.7
192.168.1.6
192.168.1.8
192.168.1.9
102.168.1.2
'] 200 400 600 800 1000

Show Event Log =

Top 5 IPS Policy Events by Destination IP

192.168.1.7
192.168.1.6
192.168.1.8
192.168.1.9
192.168.1.2
o 200 400 600 800 1000

Show Event Log <»

The following widgets will appear in the Cybersecurity tab, depending on the types of security events that

have occurred on the network. Click the Refresh All (C) icon in the top-right to update the data of all the

widgets.

Top 5 Layer 3-7 Policy Events by Source IP

Top 5 Layer 3-7 Policy Events by Destination IP
Top 5 IPS Policy Events by Source IP

Top 5 IPS Policy Events by Destination IP

Top 5 Protocol Filter Policy Events by Source IP
Top 5 Protocol Filter Policy Events by Destination IP
Top 5 ADP Policy Events by Source IP

Top 5 ADP Policy Events by Destination IP

To check detailed information, click the bar of the corresponding IP address in the widget, or click Show

Event Log at the bottom of each widget to jump to the cybersecurity event log.

Policy Profile Management

This section allows users to manage policy profiles, inspection objects, and interface objects that can be

applied to multiple devices.

This section contains the following tabs:

¢ Policy Profile: Manage policy profiles for devices.

¢ Inspection Object: Manage inspection objects for policy profiles.

« Interface Object: Manage interface objects for policy profiles.

Policy Profiles

To access the Policy Profile page, in the function tree, navigate to Menu (E) > Firewall Policy

Management > Policy Profile Management and go to the Policy Profile tab.
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Policy Profile Management

Policy Profile Inspection Object Interface Object
c Dof 2 selected v Q
O Profile Name Description Device In Use Schedule In Use
[0 2 Pprofilen Profile 1 Description 1 see Yes
O /’ Profile 2 Profile 2 Description 1 ees Yes

Policy profiles aggregate various firewall policies and can be deployed to devices based on network security
requirements.

You can configure the following types of policies:

e Layer 3-7 Policy: Provides secure traffic control, allowing users to control network traffic based on
security needs.

e Session Control: Protects network hosts or services from exceeding performance limitations.

e DoS Policy: Provides different DoS protection functions for detecting or defining abnormal packet
formats or traffic flows.

e IPS Policy: Performs intrusion detection and prevention to protect networks from security threats.

NOTE

"Device in Use" indicates the number of devices the policy profile is being used by. Policy profiles applied
to devices cannot be deleted. Click the "..." icon in the column to see details about the referenced
device(s).

NOTE

"Schedule in Use" indicates there is an upcoming scheduled deployment to apply this policy profile to the
referenced device(s). To avoid any disruptions or deployment failures, policy profiles with planned
deployments cannot be deleted.

Creating a Layer 3-7 Policy Profile

1. Navigate to Menu (E) > Firewall Policy Management > Policy Profile Management.
2. Go to the Policy Profile tab.

3. Click the Add () icon in the top-left corner to create a new policy profile.

Policy Profile Management

Palicy Profle nemsection Gbject R
& Dof2adected v .
= ETRRAS Description Device In Use Schedule In Use
O F ewfiked Profile 1 Description . ”
O # eofkez Profile 2 Descriptan - -
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The Create Policy Profile will appear.

@ English & admin ~

< Create Policy Profile

Profile 1
Profile 1 Description
20i50
Layer 37 Configure Layer 37 Firewall Policy v

Session Control Configure Session Control Policy ~

.
IPS ure IPS Palicy ~
=3
4. Enter a name and description for the profile.
5. Expand the Layer 3-7 profile options.
Layer 37 Configure Layer 3-7 Firewall Policy ~
Global Firewall Settings
Disabled ~ Enabled
Default Policy Settings
Deny All «  Enabled . Waming «  Logal Storage
B 1= oof2selected v Q
(m] Index  Status Name. Event Incoming Interface  Outgoing Interface  Filter Mode. Source Address SourcaPort  Destination Address  Destination Portor Protocol  Action  Description
o /1 Encbled  Policy_1 Disabled/Warning  LAN Any IPand Port Filering ~ range. test testi Any Allow  Policy_1_Desc
O 72 Enabled  Policy2 Enabled/Warming  Bridge Bridge 1P and PortFiltering~ tast1 Any subnet Remote-Desktop Alow  Policy_2_Dase
1025  Enabled default-ule Any Any IP and Port Filtering Any Any Any Any

6. Configure global firewall settings:
> Enforcement: Enable or disable Layer 3-7 policy profiles.
> Event Log: Enable or disable logging Layer 3-7 policy events.
7. Configure the default policy settings:
» Action: Choose to allow or deny packets that do not match any configured policy rules.
» Log: Enable or disable logging Layer 3-7 policy events.
» Severity: Select the severity level for the event. The default is Warning.
> Log Destination: Choose where to store the event logs. The default is Local Storage.
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8. Click the Add () icon to add a Layer 3-7 policy.
The Create Layer 3-7 Policy screen will appear.

Create Layer 3-7 Policy

Enabled -

Dizabled ~  Waming -

Any - Any

IP and Port Filtering -

Any - [+

Any - a
Any - a
Any - a

CANCEL CREATE

9. Configure the following settings:

Index: Specify the index for the policy profile.
Status: Enable or disable the policy profile.

Name: Enter a name for the policy profile.
Description: Enter a description for the policy profile.
Log: Enable or disable event logs.

Severity: Select the log severity level.

YV V V V V V V

Log Destination: If logging is enabled, choose where the logs will be stored. Multiple options can
be selected.

v

Incoming/Outgoing Interface: Select the incoming and outgoing interfaces.
> Action: Select the action when traffic matches the policy rule.

> Filter Mode: Select a filtering mode. Depending on the selected mode, configure the following
settings:
IP and Port Filtering:

O Source/Destination IP Address: Select Any or a preconfigured filter object. Refer to
Creating an Inspection Object.

O Source Port/Destination Port or Protocol: Select Any or a preconfigured interface object.
Refer to Creating an Interface Object.

IP and Source MAC Binding:
O Source MAC Address: Specify the source MAC address.
O Source IP Address: Select a preconfigured filter object. Refer to Creating an Inspection
Object.
Source MAC Filtering:
O Source MAC Address: Specify the source MAC address.
10. Click Create to create the Layer 3-7 policy.
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11. Click Apply.

Creating a Session Control Policy Profile

1. Navigate to Menu (E) > Firewall Policy Management > Policy Profile Management.

2. Go to the Policy Profile tab.
3. Click the Add () icon in the top-left corner to create a new policy profile.

Policy Profile Management

Falicy Profile Inspection Object Interface Dbject
C 0of2sslected v Q
(u] Prafile Name Description Device In Use Schedule In Use
O # Profie Profile 1 Descriptian 1aan Yas
O # Pufilkz Frofile 2 Description 1een Yes

The Create Policy Profile will appear.

@ English & admin ~

< Create Policy Profile
ptie1

Profile 1 Description

Layer 37 Configure Layer 37 Firewall Policy

Session Contral

m Gareel

4. Enter a name and description for the profile.
5. Expand the Session Control profile options.

Sassion Cantral Configura Session Contral Policy
IE  Oofzssectd v a
D Indox Stats  Hamo Destination [P Gostination Port. Tolal TCP Connections  Concurront TCP Requests  Action
O # 1 Euotled  Sessiond  Gamputerd sy 10 10 orep
0O #: Enabled  Session.2  range bB_Port 20 20 wgator
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6. Click the Add () icon to add a Session Control policy.
The Create Session Control Policy screen will appear.
Create Session Control Policy

1

Enabled -

Warning ~  Local Storage -

Drop -

TCP Destination *

P Address * -

TCP Connection Limitation * @@

CAMNCEL CREATE

7. Configure the following settings:

» Index: Specify the index for the policy profile.
Status: Enable or disable the policy profile.
Name: Enter a name for the policy profile.
Severity: Select the log severity level.

YV V YV VY

Log Destination: If logging is enabled, choose where the logs will be stored. Multiple options can
be selected.

\4

Action: Select the action when traffic matches the policy rule.

> IP Address: Select Any or a preconfigured inspection object. Refer to Creating an Inspection
Obiject.
» Port: Select Any or a preconfigured interface object. Refer to Creating an Interface Object.

> Total TCP Connections: Specify the maximum allowed TCP connections.

» Concurrent TCP Requests: Specify the maximum allowed concurrent connections.
8. Click Create to create the Session Control policy.
9. Click Apply.

Creating a DoS Policy Profile

1. Navigate to Menu (E) > Firewall Policy Management > Policy Profile Management.
2. Go to the Policy Profile tab.
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3. Click the Add () icon in the top-left corner to create a new policy profile.

Palicy Profile Management

Palicy Profile Inspection Object Interface Dbject
& 0of2selected ~ Q
[m} Prafile Name: Description Device In Use: Schedule In Use
0O # Pl Profile 1 Descriptian 1een Ve
O # euofkz Profile 2 Description Toee Yas

The Create Policy Profile will appear.

= MXview ONE @ English 2 admin ~

< Create Policy Profile

Profile 1

Enter a name and description for the profile.
5. Expand the DoS profile options.

Dos Canfigure DoS Policy a

Port-Scan Protection Flood Protection
itnaut Y8 @ Null Sean 1CMP-Flaad  Limit
1000
men Soan e
MMAP-Kmas Sean SYNFlood

1000
SMUFNScan .

#1l Scan ARPElood Lt
1000
NMARID Sean —
& SYN/RST Scan O vorslood
DaS Log Settings
Enabled . warning - Local Storage

6. Configure the following settings:
> DoS Settings: Check the box of the DoS types you want to enable. If necessary, specify the packet
limit.
» Log: Enable or disable event logs.
» Severity: Select the log severity level.

> Destination: If logging is enabled, choose where the logs will be stored. Multiple options can be
selected.

7. Click Apply.

Creating an IPS Policy Profile

1. Navigate to Menu (E) > Firewall Policy Management > Policy Profile Management.
2. Go to the Policy Profile tab.
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3. Click the Add () icon in the top-left corner to create a new policy profile.

Palicy Profile Management

Palicy Profle Inspection Object Interface Dbject
C 0of2aslected v Q
] Prafile Name: Description Davice In Use. ‘Schedule In Use
0O # Pl Profile 1 Descriptian 1een Ve
O # pufiez Profile 2 Description Jan Yas

The Create Policy Profile will appear.

= MXview ONE ® Engish 2 adnin -

< Create Policy Profile

Profile Narne ©

Profile 1
DoS Configure DoS Policy ~
4. Enter a name and description for the profile.
5. Expand the IPS profile options.

Pakckise Version =
20.0015

@ sefore confiquing any policies, please make sure the Intrusion Prevetion System (IPS) function (s enabled on the Firewall » Advanced Pratection » Canfiguration sereen In the device's web interface

T @ ol2sslected v Q
1] Name Status Category Severly  Action

0 @ wessnsao TSR0l Enavied Flooding & Scan Han reser

0 @ sesower oMP B Enabied Protocol Aack Pralection. Megm Moniar

Denial of service
MISCRFC 793

YN Flood warks by sending saveral SYN packets with fake source IP addresses to the vistim server. The server then allocates memary
o panding TGP o The source 0 an acs e — 5 wad sart a RST
{reset) message to the serves, freeing the memery set aside by the initial SYN pcket. The serv 5. SYN-ACK 10 the bisgus 1P
address. The SYN-ACK message wil tine aut ard tha server will send it again, keeping memory sl 0 the connection for & longer

period of time. if here are encagh half apen TCP connections, the server will iun out of memoey and cannot allow addranal TGP
Gannestians, In 50me cases, the server will srash bacause there is na free memary. Soma servars implernant a lmit ta the numbar of
Falf apen cennections therehy keeging the server fram crashing,

6. Select a previously uploaded IPS software package version. Refer to Security Package Management for
more information.

IPS ~

o Before configuring any policies, please make sure the Intrusion Prevention System (IPS) function is enabled on the Firewsall > Advanced Protection > Cenfiguration screen in the device's web interface.

7. In the IPS rule table, check the box of the rule(s) you want to configure. You can select multiple rules at
once.
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8. Click the Rule Settings (’3) icon.

The Rule Settings screen will appear.

Rule Settings

Enabled -

Reset -

CANCEL

9. Configure the following settings:

>
>

Status: Enable or disable the selected rule(s).
Action: Select the action when traffic matches the policy rule.

10. Click Apply.
11. On the Policy Profile screen, click Apply.

Editing a Policy Profile

Navigate to Menu (E) > Firewall Policy Management > Policy Profile Management.

2. Go to the Policy Profile tab.

3. Click the Edit ( f) icon of the profile you want to edit.

4. Modify the profile settings. Refer to the corresponding section for settings information:

>
>
>
>

Creating a Layer 3-7 Policy Profile

Creating a Session Control Policy Profile

Creating a DoS Policy Profile

Creating an IPS Policy Profile

5. Click Apply.

Deleting a Policy Profile

Navigate to Menu (E) > Firewall Policy Management > Policy Profile Management.

Go to the Policy Profile tab.
Check the box of the policy profile(s) you want to delete.

4. Click the Delete ( ¥ ) icon.

5. When prompted to confirm, click Delete.

Inspection Objects

To access the Inspection Object page, in the function tree, navigate to Menu (E) > Firewall Policy

Management > Policy Profile Management and go to the Inspection Object tab.

Policy Profile Management

Profile Inspaction Objact Imtarface Object

(&) D of 2 selected Q

Mame Type Detail References

i User-gdefingd Service UDF 5555 o

’ IP Range IP Address and Subnet 192 168.1.1-192.168.1.10 1=
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Inspection objects contain the IP address and subnet, network services, industrial application services, and
user-defined services that are applied to policy rules using the object.

Creating an Inspection Object

1. Navigate to Menu (E) > Firewall Policy Management > Policy Profile Management.
2. Go to the Inspection Object tab.

3. Click the Add () icon in the top-left corner to create a new inspection object.

The Create Object window will appear.

Create Object

CAMCEL REATE

4. Configure the following settings:
» Name: Enter a name for the object.

> Object Type: Select the object type. Depending on the selected object, configure the following
settings:

O IP Address and Subnet: Depending on the selected IP Type, enter the IP address, IP range,
or subnet.

O Network Service: Check the box of the service(s) you want to add to the object.

O Industrial Application Service: Check the box of the industrial application service(s) you
want to add to the object.

O User-defined Service: Select the IP protocol. Depending on the selected protocol, specify the
port, port range, ICMP Type and Code, or protocol decimal

5. Click Create.

Editing an Inspection Object

1. Navigate to Menu (E) > Firewall Policy Management > Policy Profile Management.
2. Go to the Inspection Object tab.

3. Click the Edit ( ’ ) icon of the object you want to edit.

4. Modify the object settings.
5. Click Apply.

Deleting an Inspection Object

Navigate to Menu (E) > Firewall Policy Management > Policy Profile Management.
Go to the Inspection Object tab.
Check the box of the object(s) you want to delete.

4. Click the Delete ( W ) icon.

ul

When prompted to confirm, click Delete.

Interface Objects

To access the Interface Object page, in the function tree, navigate to Menu (E) > Firewall Policy
Management > Policy Profile Management and go to the Interface Object tab.
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Policy Profile Management

Policy Profile nspection Object Interface Object

@ DofZselected v a,
O Imterface Mamie Made VLAM ID / Bridge Typa Referances

O /& wiam WLAN 1 o

O # #idgat Erdge Zana T

Interface objects contain the VLAN interface and bridge interface that are applied to policy rules using the
object.
Creating an Interface Object

1. Navigate to Menu (E) > Firewall Policy Management > Policy Profile Management.
2. Go to the Interface Object tab.

3. Click the Add () icon in the top-left corner to create a new interface object.

The Create Interface window will appear.

Create Interface

(@ VLAN () Bridge

CANCEL APPL

4. Configure the following settings:
» Name: Enter a name for the object.

» Mode: Select the interface mode. If set to VLAN, specify the VLAN ID. If set to Bridge, select the
Bridge mode.

5. Click Apply.

Editing an Interface Object

1. Navigate to Menu (E) > Firewall Policy Management > Policy Profile Management.
2. Go to the Interface Object tab.

3. Click the Edit ( 4 ) icon of the object you want to edit.

4. Modify the object settings.
5. Click Apply.

Deleting an Interface Object

Navigate to Menu (E) > Firewall Policy Management > Policy Profile Management.
Go to the Interface Object tab.
Check the box of the object(s) you want to delete.

4. Click the Delete ( § ) icon.

5. When prompted to confirm, click Delete.
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Policy Profile Deployment

To access the Policy Profile Deployment page, in the function tree, navigate to Menu (E) > Firewall
Policy Management > Policy Profile Deployment.

Policy Profile Deployment
& 0deviea(s) selected Q
[ Device Hame Online: Statug ! Profile Name Scheduling Last Update Time Product Madel Pevige P MAC Serial Rumber Location
[0 router - Synced ¢ Profile_1 Wiiesitly Sun. 18:30 eee Schedule 2024-05-04 141807 EDR-GADIOWPNZMGSFP 19216612735 ODOSOEAS) 6682 THZKB1155165 ROUTERJoc.1

O RouTER 2 - Synced / Frofile_2 Manually 2004-09-03 181542 EDR-BOTGVPN-IMBSFP 19216813782 DDSOESROI0AY TEZKET156166 ROUTER oo 2

From this screen, users can deploy policy profiles to multiple managed devices at a time and check the
synchronization status.
Deploying Policy Profiles to Managed Devices

Navigate to Menu (E) > Firewall Policy Management > Policy Profile Deployment.
2. Check the box of the device(s) you want to apply a policy profile to.
3. Click the Sync Profile ( O) icon in the top-left corner.

The Sync Profile to Device(s) window will appear.

Sync Profile To Device(s)

2 item(s) selected

EDtest-policyProfile -

4. Select a previously configured policy profile. Refer to Policy Profile Management for instructions on how
to create policy profiles.

5. Click Apply.

/7  NOTE

You can also deploy policy profiles via Topology > Cybersecurity Controls > Policy Profile
Deployment or via Device Management > Configuration and Control > Cybersecurity Controls >
Policy Profile Deployment.

Scheduling a Policy Profile Deployment for Managed Devices

Deploying a policy profile to a device may disrupt services or operations. To minimize the potential impact of
policy profile deployments, users can schedule the deployment for specific times where they are least likely
to affect operations. Schedules can be configured to execute only once, or on a daily or weekly recurring
basis.

1. Navigate to Menu (E) > Firewall Policy Management > Policy Profile Deployment.
2. Check the box of the device(s) you want to configure a scheduled deployment for.
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3. Click the Schedule Settings (5) icon in the top-left corner.

The Schedule Settings window will appear.
Schedule Settings

2 item(s) selected

CANCEL

4. Configure the following settings:
» Select File: Select a policy profile to apply to the selected device(s).

» Scheduling Mode: Select a scheduling mode. Depending on the selected mode, configure the
following settings:

O One Time: Select the date and time. One-time schedules can be configured for up to 30 days
in the future.

O Daily: Select the time and the schedule period. Daily schedules can be configured for up to 90
days in the future.

O Weekly: Select the day of the week, the time, and schedule period. Weekly schedules can be
configured for up to 90 days in the future.

5. Click Apply.

Deleting a Scheduled Profile Policy Deployment
1. Navigate to Menu (E) > Firewall Policy Management > Policy Profile Deployment.
2. Check the box of the device(s) with the scheduled deployment you want to delete.
3. Click the Delete Schedule ( & ) icon.

4. When prompted to confirm, click Delete.

Security Package Management

This section describes how to manage the security package either manually from a local PC or automatically
by updating to the Moxa Update Server.

This section contains the following tabs:

¢ Security Package Files: Manage security package files for supported devices.
e Log: Shows security package-related event logs.
e Update Settings: Configure scheduled security package update checks.

Security Package Files

From the Security Package Files tab, you can update and manage security package files.

Checking the Security Package Status

The Update Security Package section provides information about the Moxa Update Server connection
status, the time and date of the last update check, and the result of the last check.

To access this section, navigate to Menu (E) > Firewall Policy Management > Security Package
Management.
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Security Package Management

Update Security Package @

Maoxa Update Server Status @ Connected  Check Now
Last Connection Check © 2024-09-04 17.03:00
Last Security Package Update Result @ No new version detected (2024-09-04 14:55:47, manually)

Check Security Package

The widget shows the following information:

Field Description
Moxa Update Server Shows the current status of the connection to the Moxa update server.
Status

Last Connection Check |Shows the date and time of the last connection check.

Last Security Package |Shows the result of the most recent security package update check.
Update Result

To manually check for security package updates, click the Check Security Package button. A list of
models and any available security package updates will be shown. The models shown in the list are

configured in the Update Settings tab. To set up a scheduled update check, refer to Scheduling a Security
Package Update Check.

Security Package Check

o] 0of 3 selected v Q search
[J Version
EDF-G1002 »
Security package is up 1o date.
[] EDR-8010 ~
O @ wvioozs
[] EDR-G9004 b
O @ vicoss
EDR-G9010 ~
Security package is up 1o date.
TN-1900 ~
O @ viooazs

Close

Uploading a Security Package

Navigate to Menu (E) > Firewall Policy Management > Security Package Management.
2. Go to the Security Package Files tab.

3. Click the Add () icon in the top-left corner to upload a security package.

The Upload Package window will appear.
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4. Drag and drop or browse to the package file on the local computer and enter a description for the file.

Upload Package

BB Drag and drop a file here, or browse

CANCEL PLOA

5. Click Upload.

7

NOTE
"Profile in Use" indicates the number of policy profiles using the corresponding security package. Package
files used by policy profiles cannot be deleted. Click the "..." icon in the column to see details about the

referenced policy profile(s).

NOTE

"Schedule in Use" indicates there is an upcoming scheduled deployment to apply this security package to
the referenced device(s). To avoid any disruptions or deployment failures, security packages with planned
deployments cannot be deleted.

Viewing Detailed Security Package Information

1. Navigate to Menu (E) > Firewall Policy Management > Security Package Management.
2. Go to the Security Package Files tab.

3. In the package file list, click the Info (®) icon of the package file you want to view details for.

4. Click the Info (®) icon again to close the details section.

Downloading a Security Package

1. Navigate to Menu (E) > Firewall Policy Management > Security Package Management.
2. Go to the Security Package Files tab.

3. In the package file list, click the Download (D ) icon of the package file you want to download.

Deleting a Security Package

Navigate to Menu (E) > Firewall Policy Management > Security Package Management.
Go to the Security Package Files tab.
Check the box of the package(s) you want to delete.

4. Click the Delete ( ¥ ) icon.

5. When prompted to confirm, click Delete.

Event Logs

From the Event Logs tab, you can view security package files event logs.
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Viewing Security Package Logs

Navigate to Menu (E) > Firewall Policy Management > Security Package Management.

Go to the Event Logs tab.
You can perform the following actions:

a. Click the Download All Logs ( @ ) icon to export the current search results as a CSV file.

b. Click the Refresh (G ) icon to update the event log table.

The event log table shows the following information:

Field Description

Time The time the log entry was created.
Severity The severity level assigned to the event.
Event The category of the event.

Message Additional details about the event.

Scheduled Update Check

From the Scheduled Update Check tab, you can configure a scheduled time and period to automatically

check the Moxa server for security package updates.

Scheduling a Security Package Update Check

Navigate to Menu (E) > Firewall Policy Management > Security Package Management.

2. Go to the Update Settings tab.

Security Package Management

Update Security Package @
Moxa Update Server Status - @ Connected Check Now
Last Connection Check 1 2025-01-1917:40:53

Last Security Package Update Result  : 2/2 file downloaded (2025-01-17 00:09:21, manually)

Check for Package Updates

Security Packages File Event Logs Scheduled Update Check

Scheduled Update Check @

Automatically check Tor securnty

I@) Enabled

Scheduling Mode

< (®) Daily () Weekly
Time * (]
Period * ]

EDF-G1002 EDR-8010EDR-G2004E... ~

Set Scheduled Update Check to Enabled.
Choose a scheduling mode:

MXview One 1.5.0 User Manual

281



> Daily: Set the time of the day to perform the check.
» Weekly: Set the day of the week and time of the day to perform the check.

5. Configure the update period. The system will only perform update checks on the specified time and date
during this period.

6. Select the product model(s). The system will only check for security package updates applicable to the
select product models.

7. Click Apply.

Security Package Deployment

This section allows users to deploy security packages to managed devices.

Upgrading the Security Package of Managed Devices

Users can manually upgrade the security package of managed devices and check basic security package
version information.

The table shows the following security package information:

e Package Version: Shows the version of the security package currently installed on the device.

e Up-to-date: Indicates if the currently installed version is up to date. If not, the latest available version
will be shown.

Security Package Deployment

I M B C 2deeels selece

Device Name Online  Product Model Device 1P ‘Serial Number MAC Package Version Firmware Version Up-to-date. Scheduling Last Update Time Location

Firewll/UPN Router 00000 L] EDR-8010-VPN-2GSFP. 19216812782 TBZKBI155166 00:90£8:3010:00 ¥1000023 V31399 25088, 121.453

Firewall/VPN Router 55165 . EDR-G9010-VPN-2MGSFP 192.166127.35  TBZKB1155165 00:90:£89186:82 ¥1000023 V31399 Device Location

Navigate to Menu (E) > Firewall Policy Management > Security Package Deployment.
2. Check the box of the device(s) you want to upgrade the security package for.

3. Click the Upgrade ( I) icon to upgrade the security package for the selected device(s).
The Upgrade Package window will appear.

Upgrade Package

1 item(s) selected

Check the security packages on the Security Package Management
o page.

Cancel

4. Select a previously uploaded security package to upgrade to. Refer to Uploading a Security Package for
instructions on how to upload security packages.

5. Click Upgrade.

Scheduling a Security Package Deployment for Managed
Devices

Deploying a security package to a device may disrupt services or operations. To minimize the potential
impact of security package deployments, users can schedule the deployment for specific times where they
are least likely to affect operations. Schedules can be configured to execute only once, or on a daily or
weekly recurring basis.
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Users can choose to deploy a specific version or the most-recent version of the security package available in
the management database.

Navigate to Menu (E) > Firewall Policy Management > Security Package Deployment.
2. Check the box of the device(s) you want to configure a scheduled deployment for.

3. Click the Schedule Settings (f}) icon in the top-left corner.
The Schedule Settings window will appear.
Schedule Settings

1 item(s) selected

Up-to-date -

One Time

Daily

Cancel
Weekly

4. Configure the following settings:
> Select File: Select a security package version to apply to the selected device(s).

» Scheduling Mode: Select a scheduling mode. Depending on the selected mode, configure the
following settings:

O One Time: Select the date and time. One-time schedules can be configured for up to 30 days
in the future.

O Daily: Select the time and the schedule period. Daily schedules can be configured for up to 90
days in the future.

O Weekly: Select the day of the week, the time, and schedule period. Weekly schedules can be
configured for up to 90 days in the future.

5. Click Apply.

Deleting a Scheduled Security Package Deployment

Navigate to Menu (E) > Firewall Policy Management > Security Package Deployment.
2. Check the box of the device(s) with the scheduled deployment you want to delete.

3. Click the Delete Schedule ( E) icon.

4. When prompted to confirm, click Delete.

Cybersecurity Event Log

If the MXview Security add-on license is activated, an additional Cybersecurity tab will be available on the
Event History page, showing security events occurring on devices. The events include logs detected by the
Trusted Access, Malformed Packets, DoS Policy, L2 Policy, L3-L7 Policy, Protocol Filter Policy, ADP, IPS, and
Session Control functions. Refer to Viewing Event History.

Event History

System Network and Device

DoS Policy +
=pc Q sea

Additional
Message

Time Severity  Device Name Etherype  Subcategory  IPProtocol  Incoming Interface  Source MAG Source IP Source Port i TCPFlags  ICMPType  IGMPCode  Action
202501171921:5 Waming  Firewall/VPN Router 24623 2043 SYNFlood TGP LaN 5C:92SEDV4CIF 192168127200 65313 - 19216612793 443 SYN - - DROP
2250117192145 Waming  Firewall/VPN Router 24623 2048 SYNFlood  TCP LAN 5CO2SEDTACOF 192168127200 65196 - 19216812793 443 SN - - DROP

2025:01-171921:45 Waming  Eirewall/VEN Router 24623 2048 SYN-Flood Tce Lan 5C92SEDTACOF 192168127200 65195 - 19216812793 443 SN - - DROP

The table shows the following information:
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Field Description

Time

The time the event entry was created.

Severity

The severity level assigned to the event.

Device Name

The host name of the device that generated the event.

IPS Severity

The severity level assigned to the IPS event.

IPS Category

The category of the IPS event.

Ether Type The Ethernet type of the connection.

IP Protocol The IP protocol of the connection.

Incoming Interface The name of the incoming interface where the event was registered.
Source MAC The source MAC address of the connection.

Source IP The source IP address of the connection.

Source Port

The source port of the connection.

Outgoing Interface

The name of the outgoing interface where the event was registered.

Destination IP

The destination IP address of the connection.

Destination Port

The destination port of the connection.

TCP Flags The TCP flags of the TCP protocol.

ICMP Type The ICMP type of the ICMP protocol.

ICMP Code The ICMP Code of the ICMP protocol.

Action The action performed based on the policy settings.

Additional Message

The additional message provided with the event.

Viewing Cybersecurity Events

1. Navigate to Menu (E) > Event Management > Event History > Cybersecurity.

2. Select the event type from the drop-down menu.

Event History

System Network and Device Cybersecurity

Trusted Access ~

Trusted Access

Malformed Packets

Severity

Do5 Policy

Layer 2 Policy

Device

TR EtherType

Pro

Layer 3-7 Policy

Protocol Filter Policy

ADP

LrJ

IPS

Session Control

3. To filter event logs:
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a. Click the Filter ( = ) icon to open the filter menu. Select a start/end date and time or severity from

the respective drop-menu.

Filters = X
Start Date aal
Start Time Q
End Date aal
End Time e

Clear

—
b. Click the Options ( = ) icon to configure advanced filters. Check the box of the specific event(s)
you want to filter and click Apply. The event log will refresh immediately to reflect the selected

criteria.

4. To export logs:

a. Click the Download All Logs ( III ) icon to export the current results as a CSV file

5. To refresh the event log data:

a. Click the Refresh ( c ) icon to renew the search results.

Cybersecurity Event Settings

If the MXview Security add-on license is activated, an additional Cybersecurity Event tab will be added to
the Event Settings screen. From this tab, users can configure events for specific cybersecurity events.
Refer to Events and Notifications.

Event Settings
Custom Event Cybersecurity Event
c 0of 2 selected v Q,
[] Staws Naotification Name D It Device Count  Event Filter Rule
[ Enabled Protocal Filter Filter Omron FINS 1 Protocol Filter Policy  Application Protocol ==

Adding a Cybersecurity Event

1. Navigate to Menu (E) > Event Management > Event Settings > Cybersecurity Event.
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2. Click the Add () icon in the top-left corner.
The Add Cybersecurity Event window will appear.
Add Cybersecurity Event
@ notification Information @) choose Devices © choose Event and Filter

Status *

(®) Enabled () pisabled

Event Name * o

Description

o

Cancel

3. Enter a name and description for the event.
Click Next.
Select the device(s) that will send notifications for the specified event(s).

Add Cybersecurity Event

o Notification Information e Choose Devices e Choose Event and Filter

v— Q search

v—  Dof2selected v

Device Name + Status  Location Product Model SEE MAC Address | Tmware
Number Version

Firewall/VPN Router 25.058,

00000 [ 2145 EDR-8010-VPN-2GSFP TBZKB1155166 00:90:E8:50:10:A4 V31399

LTRSS ° Device Location EDR-GI010-VPN-2MGSFP TBZKB1155165 00:90:E891:86:82 V3.13.99

55165

Items perpage 10w -20f2

Back
Click Next.
7. Select the event type and configure the filter rules.
a. Select the notification event type from the drop-down menu.
Add Cybersecurity Event
@ 1otification Information @ choose Devices @) choose Eventang Filter

Trusted Access -

Event Filter Rule

[ severity
Severity Rule ~  Severity Mode -
[] sourceIP [ Destination IP
Source IP [ ] Destination IP ()

- - |
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b. Specify the notification filter rules to determine when the device will send a notification for the
event. Filter rule options may differ depending on the selected event type.

Add Cybersecurity Event

@ Notification Information @ choose Devices © choose Event and Filter

Trusted Access -

Event Filter Rule

[ severity

[] sourcelP [] Destination IP

Souree 17 o Destination IP o

- B3

8. Click Apply.

Adding a Cybersecurity Event Notification

If the MXview Security is enabled, an additional Cybersecurity Event category will be added to the
Notification Management function. This allows users to set up notifications to alert users when specific
cybersecurity events occur on the network.

Refer to Configuring New Event Notifications for information and instructions on how to configure event
notifications.
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